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S E C T I O N  1  

This document contains a printable version of the SmartPlant Import and Merger Utilities online 
help. 
 

The Import Utility enables you to import data from most common database formats into a selected 
table or module in the SmartPlant Instrumentation database.  The Import Utility also provides you 
access to database platforms other than your own (Oracle, SQL Server, or Sybase Adaptive 
Server Anywhere). 
To import data, you need to have some knowledge of the SmartPlant Instrumentation database 
structure and concepts such as naming conventions.  You should also know how to connect to 
the source and target databases (for example, correct ODBC profile, or native connection to the 
database). 
The Import Utility is essential because inserting data into SmartPlant Instrumentation is not a 
trivial matter.  Since the SmartPlant Instrumentation table structure is relational, there is a 
constant maintenance of integrity constraints.  You have to keep the relation between the tables 
and create unique values in the primary key.  Therefore, you have to insert data into SmartPlant 
Instrumentation only through the SmartPlant Instrumentation interface or by using the Import 
Utility. 
If you are importing a value for which the number of characters exceeds the maximum allowed, 
the Import Utility truncates the extra characters in the target field in the SmartPlant 
Instrumentation database.  If, as a result of truncating the value, the string is identical to an 
existing value in the database, the Import Utility rejects the import if the value is required to be 
unique and the import mode in the import link properties is set not to overwrite the existing value. 

  If you intend to import a large number of records (more than 400 records) in one 
import session, you must create a new section in the Intools.ini file called [Rules] and add the 
following parameter: disable = y. 

 When importing a satellite project back to the host project, changes made to reference data 
(redlining, drawing item positions, certain supporting tables and so-forth) on Enhanced Report 
Utility drawings are not imported back to the host project. 
 

SmartPlant Import and Merger Utilities 
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Database Platform Support 
The Import Utility provides you with inherent support of the following database platforms and 
database file formats: 
 Oracle (only if you have selected Oracle as your current database platform during Setup) 
 SQL Server (only if you have selected SQL Server as your current database platform during 

Setup) 
 Sybase Adaptive Server Anywhere (only if you have selected Sybase Adaptive Server 

Anywhere as your current database platform during Setup) 
 Microsoft Access 
 DBF (SmartPlant Instrumentation comes shipped with .dbf files.  These files appear in the 

path <SmartPlant Instrumentation home folder>\Import.  You can use these files as examples 
when learning how to import source data from .dbf files.) 

 ASCII delimited files 
 Excel worksheets 
 Text files 

 
 To install drivers and profiles of ODBC platforms other than those listed above, you need to 

install the appropriate software (for example, Microsoft Excel 7 or later, Microsoft Access). 
 SmartPlant Instrumentation supports Microsoft dBase Driver for .dbf files,  and Microsoft Text 

Driver for .txt and .csv files.  You can select the driver you require using the ODBC Data 
Source Administrator in your Windows Administrative Tools. 

You can import data from a database platform (for example, Oracle, SQL Server or Sybase 
Adaptive Server Anywhere) other than your current SmartPlant Instrumentation database 
platform.  To do this, you have to comply with the appropriate system requirements of the external 
database platform.  For example, if your current SmartPlant Instrumentation database platform is 
Sybase Adaptive Server Anywhere and you want to import data from an Oracle database, you 
must have Oracle client installed and running on your computer. 
You can also import from database platforms other than those specified above.  To do this, you 
need to provide drivers and modify the appropriate configuration files. 

See Also 
Create an Import Link for an Oracle Source (on page 18) 
Create an Import Link for an ODBC Source (on page 17) 
Create an Import Link for a File Source (on page 19) 
Define a Data Import Source in Excel Spreadsheets (on page 20) 
Prerequisite for Using Microsoft Access as an Import Source (on page 20) 
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Configure ODBC Data Source for Text Files 
For text files, the Import Utility uses Microsoft Text drivers (.txt and .csv files).  Therefore it is 
important to properly build the correct profiles.  The following steps are necessary to work with 
FirstVue, Masoneilan, and Flowserve interfaces as well as with Import Utility default parameters. 

 In 64-bit environments, certain ODBC profiles and drivers cannot be seen by the 
SmartPlant software. Additionally, they cannot be added from the Windows Control Panel. To add or 
view these profiles and drivers you need to use the 32-bit version of the Data Sources which is 
found under %Systemdrive%\Windows\SysWoW64\odbcad32.exe. 
1. In your Windows operating system open Administrative Tools > Data Sources. 
2. On the ODBC Data Source Administrator dialog box, click Add. 

  Click Add on either the User DSN or System DSN tab, whichever is appropriate. 
3. On the Create New Data Source dialog box, from the Name list select the Microsoft Text 

Driver (*.txt; *.csv). 
4. Click Finish. 
5. On the ODBC Text Setup dialog box, type in the Data Source Name and Description for 

your database. 
6. Clear the Use Current Directory check box. 

 If the Use Current Directory check box is selected, you will not be able to define 
the format. 

7. Click OK. 
 This concludes the required steps needed for .csv and .txt files. However, if you want to 

use comma delimited data, do not click OK and continue the procedure as follows: 
1. Clear the Use Current Directory check box. 
2. Click the Select Directory button. 
3. Select an appropriate folder that contains text files. 
4. Click Options. 
5. In the Files pane click Define Text Format. 
6. In the Define Text Format dialog box choose the Format of your database. 

  
 You can use the Custom Delimited format and enter a Delimiter, if you are not using 

commas or tabs. 
 The default Rows to Scan is 25.  This number can be changed to suit your database 

structure. 
7. Click OK. 
8. Select the Use Current Directory check box. 

  If the Use Current Directory check box is not selected, the driver will not be 
able to find the correct files. 

9. Click OK. 
For further details, see the user's guide for your database platform.  
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Configure ODBC Data Source for DBF Files 
The Import Utility supports only Microsoft dBase drivers for .dbf files.  Therefore it is important to 
properly build the correct profiles.  The following steps are necessary to work with the Import 
Utility default parameters. 

 In 64-bit environments, certain ODBC profiles and drivers cannot be seen by the 
SmartPlant software. Additionally, they cannot be added from the Windows Control Panel. To add or 
view these profiles and drivers you need to use the 32-bit version of the Data Sources which is 
found under %Systemdrive%\Windows\SysWoW64\odbcad32.exe 
1. In your Windows operating system open Administrative Tools > Data Sources. 
2. On the ODBC Data Source Administrator dialog box, click Add. 

  Click Add on either the User DSN or System DSN tab, whichever is appropriate. 
3. On the Create New Data Source dialog box, from the Name list select the Microsoft dBase 

Driver (*.dbf). 
4. Click Finish. 
5. On the ODBC dBASE Setup dialog box, type in the Data Source Name and Description for 

your database. 
6. In the Database group box, select an appropriate Microsoft dBase version. 
7. Check the Use Current Directory check box. 

  If the Use Current Directory check box is not selected, the driver will not be 
able to find the correct files. 

8. Click OK. 
For further details, see the user's guide for your database platform.  
 

Flow of Activities for Importing Data into SmartPlant 
Instrumentation 

This topic describes the flow of activities for importing data into SmartPlant Instrumentation. 

Define an Import Source 
You must define a file or database with the data you want to import.  For details about supported 
data sources, see Database Platform Support (on page 6). 

Create a Link Group 
If you intend to use several data sources, you will have to define an import link for each 
source.  Therefore, creating defining import links, create a link group.  For details, see Managing 
Import Link Groups Common Tasks (on page 10). 

Create an Import Link 
Create a link between the data source that you defined and the target table or module of 
SmartPlant Instrumentation.  For details, see Defining Import Links Common Tasks (on page 16). 

Define Import Link Properties 
After creating an import link, you must specify how you want to import the source data associated 
with the link.  For example, you might only want to insert new records into SmartPlant 
Instrumentation without updating existing data, or you want to import data into more than one 
<plant> or project.  For details, see Defining Import Link Properties Common Tasks (on page 24). 
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Map Source and Target Fields 
At this stage, you map the fields in your data source with target table columns in SmartPlant 
Instrumentation.  For details, see Map Source and Target Fields Common Tasks (on page 61). 

Use Comparison Options 
After you have run an import session on a set of data at least once, you can run subsequent 
sessions by comparing the new rows to be imported with previously imported rows.  For details, 
see Comparison Options Common Tasks (on page 73). 

Import Data into SmartPlant Instrumentation 
If needed, test the import process before importing data.  Testing the import process can be 
useful when testing a single link before carrying out a large batch operation.  A test can also give 
you an indication on the rejected rows and allow you to fix the problem prior to a batch 
operation.  After testing, run the import process.  For details, see Importing Data Common Tasks 
(on page 82). 
 

Starting the Import Utility 
The Import Utility is automatically installed when selected during SmartPlant Instrumentation 
setup.  However, if the Import Utility was not installed in your computer, you can install it by 
running the SmartPlant Instrumentation setup and selecting to install the Import Utility. 

 
 You must have Domain Administrator access rights to be able to perform import activities. 
 If you are importing SmartPlant P&ID data, SmartPlant P&ID must be closed before starting 

the import session, to ensure that any modifications made to the drawings are properly 
imported to SmartPlant Instrumentation. 

You can start the Import Utility in one of two ways: 
 By selecting Import Utility from the Intergraph SmartPlant Instrumentation program group 

in the Windows Start menu. 
 By running an import session using a command-line (see Run an Import Session from the 

Command Line (on page 84)). 
 

Link Groups 
A link group allows you to categorize import links according to your requirements and easily find 
the appropriate link when needed.  You create and manage link groups in the Link 
Explorer.  The software comes shipped with the All link group, which you cannot edit or delete. 
Every link must belong to a link group, so if you do not create an group, links that you create 
automatically appear in the All link group.  Other link groups that you create are considered 
user-defined.  You can create as many user-defined link groups as you require, edit or delete 
them when needed, move links from one group to another, duplicate links, or associate the same 
link with more than one group.  Changing properties of such a link in one group results in 
changing the properties of all instances of this link in all the groups it is associated with.  You can 
only delete a link group together with the links this group contains.  Deleting a link group results in 
deletion of all the group links from the All group as well. 
You can import data either from a specific link or from all links in the group in batch mode.  For 
batch mode, the Import Utility runs the group links one after another with the link that appears right 
under the group name in the Link Explorer having the highest priority. 
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Managing Import Link Groups Common Tasks 
These tasks deal with creating and managing import link groups, and organizing links into groups 
in the Link Explorer window. 

Create a Link Group 
Use this procedure to create an empty link group.  For details, see Create a Link Group (on 
page 11). 

Rename a Link Group 
Use this procedure to rename an existing link group, provided that the name you define is 
unique.  you cannot rename the All group.  For details, see Rename a Link Group (on page 11). 

Rename a Link in the Link Explorer 
Use this procedure to rename an existing link in the Link Explorer, provided that the name you 
define is unique.  For details, see Rename a Link in the Link Explorer (on page 13). 

Rename a Link in the Import Link Window 
Use this procedure to rename an existing link after opening this link in the Import Link window, 
provided that the name you define is unique.  For details, see Rename a Link in the Import Link 
Window (on page 13). 

Prioritize Links in a Link Group 
Use this procedure to define or modify the sequence in which the links appear in a group.  This 
sequence determines the link priority.  When executing an import session for the entire group, the 
links are run in the order in which they appear in the group.  By default, links in groups are 
arranged automatically in alphabetical order.  For details, see Prioritize Links in a Link Group (on 
page 13). 

Duplicate a Link in the Link Explorer 
Use this procedure to duplicate an existing link within the same link group by selecting a source 
link in the Link Explorer.  You can only duplicate one link at a time.  For details, see Duplicate a 
Link in the Link Explorer (on page 12). 

Duplicate a Link in the Import Link Window 
Use this procedure to duplicate an existing link within the same link group after opening this link in 
the Import Link window.  For details, see Duplicate a Link in the Import Link Window (on 
page 12). 

Move Links to Another Group 
Use this procedure to move one or more link from one group to another.  You cannot move links 
from the All group.  For details, see Move Links to Another Group (on page 14). 
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Associate the Same Links with Several Groups 
Use this procedure to associate the same link or links with more than one group.  Changing 
properties of a link in one group results in changing the properties of all instances of this link in all 
the groups it is associated with, including the All group.  In the same way, deleting such a link 
from a particular group results in deletion of all instances of this links from all the groups it is 
associated with, including the All group.  For details, see Associate the Same Links with Several 
Groups (on page 14). 

Dissociate Links From a Group 
Use this procedure to dissociate one or more links from a group.  If a link is not associated with 
any group, you can still locate it and run it from the All group, if required.  For details, see 
Dissociate Links From a Group (on page 14). 

Delete Links 
Use this procedure to delete one or more links that you no longer require.  For details, see Delete 
Links (on page 14). 

Delete a Link Group 
Use this procedure to delete an entire link group with all the links that it contains.  For more 
information, see Delete a Link Group (on page 15). 
 
 

Create a Link Group 
1. In the Link Explorer, do one of the following: 

 On the toolbar, click  ( New Group). 
 Right-click anywhere in the Link list pane, and then, on the shortcut menu, click New 

Group. 
2. Under Link list, type a unique name for the link group. 

 In the link group name string, you can use spaces and special characters if required. 

See Also 
Link Groups (on page 9) 
Import Links (on page 15) 
 

Rename a Link Group 
1. In the Link Explorer, click the group you want to rename. 

2. On the toolbar, click  ( Rename). 
3. Type the new unique name for the group. 

 Since groups in the Link list are arranged in alphabetical order, renaming a group may 
result in its moving to a different position in the Link Explorer. 

See Also 
Link Groups (on page 9) 
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Duplicate a Link in the Link Explorer 
 Links in groups are arranged in alphabetical order.  Duplicating a link may result in 

changing the priority of running links in batch mode.  For batch mode, the Import Utility runs the 
group links one after another with the link that appears right under the group name in the Link 
Explorer having the highest priority.  After duplicating a link, you might need to rearrange the 
order of your links manually.  For details, see Prioritize Links in a Link Group (on page 13). 
1. In the Link Explorer, click the group containing the link you want to duplicate. 
2. Select the link you want to duplicate and do one of the following: 

 On the toolbar, click  ( Edit Links). 
 Right-click on the link, and from the shortcut menu click Edit Link. 

3. On the Link Definitions dialog box, do the following: 
a. In the Link box, enter a unique name for the link you want to create by duplicating the 

existing link. 
b. If needed, modify the source settings. 
c. Select Save as new link. 
d. Click Apply and then Close. 

 We recommend that you do not modify the import method when duplicating a 
link.  This is because the source link properties are also duplicated and might be not 
applicable for a new link if you change the import method.  For example, suppose your source 
import link properties include multi-tag spec options and the link is assigned to the Module 
(multiple tables) import method.  If you change the import method to Single table, select a 
specification table, and save the link under a new name, the multi-tag spec option properties 
are applied to the new link as well.  You cannot manually dissociate these properties from the 
duplicated link because the multi-tag spec options are disabled on the Link Properties dialog 
box when the link is assigned to the Single table method. 

4. On the toolbar, click  to display the duplicated link in the link group. 

See Also 
Link Groups (on page 9) 
Import Links (on page 15) 
 

Duplicate a Link in the Import Link Window 
  Links in groups are arranged in alphabetical order.  Duplicating a link may result in 

changing the priority of running links in batch mode.  For batch mode, the Import Utility runs the 
group links one after another with the link that appears right under the group name in the Link 
Explorer having the highest priority.  After duplicating a link, you might need to rearrange the 
order of your links manually.  For details, see Prioritize Links in a Link Group (on page 13). 

1. With the link open in the Import Link window, on the toolbar, click  ( Save As). 
2. On the Save Link As dialog box, under Link name, enter the new unique name for the link. 
3. Under Save options, select Save as new link. 
4. Click OK. 

  The duplicated link automatically appears in the Link Explorer in the group to which the 
source link belongs. 

See Also 
Import Links (on page 15) 
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Rename a Link in the Link Explorer 
  Links in groups are arranged in alphabetical order.  Renaming a link may result in its 

moving to a different position in the group.  Therefore, if you intend to import data in batch 
mode,  note that the link running order may change.  For batch mode, the Import Utility runs the 
group links one after another with the link that appears right under the group name in the Link 
Explorer having the highest priority. 
1. In the Link Explorer, click the group in which you want rename a link. 
2. Click the link that you want to rename. 

3. On the toolbar, click  ( Rename). 
4. Type the new unique name for the link. 
 
 

Rename a Link in the Import Link Window 
  Links in groups are arranged in alphabetical order.  Renaming a link may result in its 

moving to a different position in the group.  Therefore, if you intend to import data in batch 
mode,  note that the link running order may change.  For batch mode, the Import Utility runs the 
group links one after another with the link that appears right under the group name in the Link 
Explorer having the highest priority. 

1. With the link open in the Import Link window, on the toolbar, click  ( Save As). 
2. On the Save Link As dialog box, under Link name, enter the new unique name for the link. 
3. Under Save options, select Rename current link. 
4. Click OK. 

See Also 
Import Links (on page 15) 
 

Prioritize Links in a Link Group 
1. In the Link Explorer, in the Link list pane, expand a link list in a user-defined group. 
2. To set a particular link as having the highest priority, do one of the following: 

 In the Link list pane, drag the appropriate link to the group level. 
 In the right pane, drag the link to the top of the list so that the link that appears at the top 

moves down and becomes the second link from the top. 
  In the right pane, if the link you want to move up appears right under the first link at the 

top, move the topmost link down to swap the positions of the two links. 
3. Arrange the other links in the required sequence in the group by dragging the link to the 

appropriate positions. 
  If you have a link that appears right above the link that has the lowest priority and you 

want to swap the positions of these links, move the higher link down. 
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Move Links to Another Group 
  Links in groups are arranged in alphabetical order.  If the target group already 

contains links, moving a link into this group may result in changing the priority of running links in 
batch mode.  For batch mode, the Import Utility runs the group links one after another with the link 
that appears right under the group name in the Link Explorer having the highest priority.  After 
moving links, you might need to rearrange the order of your links manually.  For details, see 
Prioritize Links in a Link Group (on page 13). 
1. In the Link Explorer, click a user-defined group containing the links you want to move. 
2. In the right pane, while pressing and holding down the Shift key, select the links you want to 

move. 
3. Drag the selected links to the target group in the Link list pane. 
 

Associate the Same Links with Several Groups 
  Links in groups are arranged in alphabetical order.  If the target group already 

contains links, associating another link with the group may result in changing the priority of running 
links in batch mode.  For batch mode, the Import Utility runs the group links one after another with 
the link that appears right under the group name in the Link Explorer having the highest 
priority.  After associating additional links, you might need to rearrange the order of your links 
manually.  For details, see Prioritize Links in a Link Group (on page 13). 
1. In the Link Explorer, click a group containing the links you want to associate with another 

group as well. 
2. In the right pane, select one or more links (use the Ctrl key to select multiple links). 
3. Drag the selected links to the target group in the Link list pane. 

See Also 
Import Links (on page 15) 
 

Dissociate Links From a Group 
1. In the Link Explorer, click the group where you want to dissociate links. 
2. Select one or more links in the right pane (press Ctrl or Shift for multiple selections). 

3. On the toolbar, click  (Dissociate) to dissociate the selected links from the group. 
 

Delete Links 
  Link deletion is irreversible.  When deleting a link, the software permanently removes 

this link from all link groups it is associated with, including the shipped group All.  For this reason, 
you should exercise an extreme caution when deleting links. 
1. In the Link Explorer, click the group containing the links you want to delete. 
2. In the right pane, select links that you want to select (press Ctrl or Shift for multiple 

selections). 

3. On the toolbar, click  (Delete). 
4. When prompted, click Yes to confirm the deletion. 

  You can delete links by deleting the entire link group.  For details, see Delete a Link Group 
(on page 15). 
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Delete a Link Group 
  Link group deletion is irreversible.  When deleting a link group, the software deletes 

the links from all other groups they are associated with, including the shipped group All.  For this 
reason, you should exercise an extreme caution when deleting link groups. 

  Deleting a link group results in deletion of all the group links from the All group as well. 
1. In the Link Explorer, click the group you want to delete. 

2. On the toolbar, click  (Delete). 
3. When prompted, click Yes to confirm the deletion. 

  You can delete individual links without deleting the whole group.  For details, see Delete 
Links (on page 14). 
 
 

Import Links 
Before the actual import can take place, you must have a link between the source data and the 
target table or module of SmartPlant Instrumentation.  If you do not have a previously saved link 
or you do not want to use an existing link, you need to create a new one. 
The first step in building a new link is to define the source data using your database tools or a file 
source.  When defining an import link, you need to establish a connection to the source database 
or file that contains predefined source data.  Your import source must contain at least one field, 
even if you want to specify an import value manually.  You either map existing source fields or 
specify import values manually in the Import Link window. 
The second step in creating an import link is to specify the import method.  The import method 
can be either Single table or Module (multiple tables).  The Single table method is useful 
when you need to or to import specific items or update properties of items that already exist in 
SmartPlant Instrumentation.  This method is especially useful when importing wiring data.  First, 
you import your panels into the PANEL table.  Then, you import terminal strips into the 
PANEL_STRIP table and make appropriate associations with the previously imported 
panels.  Then, you import terminals into the PANEL_STRIP_TERM table, and so forth.  You can 
also use the Single table method in conjunction with data import into reference tables.  The 
Module (multiple tables) method is useful for massive data import.  For example, you need to 
use this method to import multiple tag numbers, loop numbers, supporting table values, and 
automatically associate appropriate supporting table values to the imported instrument and 
loops.  This method, however, is not useful for wiring data import due to the complexity of wiring 
connections and parent item – child item relations in SmartPlant Instrumentation. 
When creating an import link, you must define a unique link name.  If you create several links, you 
might need to categorize them into link groups.  For details, see Link Groups (on page 9).  You 
create, rename, delete import links, and associate them with link groups in the Link Explorer 
window.  Also, you can move import links between databases or domains.  For details, see 
Moving Links Between Databases or Domains (on page 16).  It is possible to run import links in 
batch mode, in order of priorities. 
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After creating an import link, you need to set various properties for the link on the Link Properties 
dialog box.  The properties that appear on this dialog box depend on your import method and 
target table or module selection.  For details, see Defining Import Link Properties Common Tasks 
(on page 24). 

 
 If you intend to import a large number of records (more than 400 records) in one import 

session, you must create a new section in the Intools.ini file called [Rules] and add the 
following parameter: disable = y. 

 
 

Moving Links Between Databases or Domains 
Import links are used per domain.  You can move the links you have created to other databases or 
other domains.  This process consists of two stages.  First, you transfer the link information to an 
ASCII file by exporting the links and then you create a group of links from that ASCII file in the 
target domain by importing the links.  You can export and import only a group of links and not an 
individual link.  Hence, if you want to move a single link, you need create a group to which you 
associate the link. 

 
 Make sure that instrument naming convention is the same in the source and target 

domains.  Otherwise, you will not be able to carry out the import process automatically.  In 
this case, you will first need to modify the links of the naming convention of the required part of 
the name. 

 The source and the target domain or database for the links must be of the same version of 
SmartPlant Instrumentation. 

 
 

Defining Import Links Common Tasks 
The following tasks are used when you define import links. 

Create an Import Link for an ODBC Source 
This procedure describes the setup for the ODBC platform.  For more information, see Create an 
Import Link for an ODBC Source (on page 17). 

Create an Import Link for an Oracle Source 
Use this procedure to build a new link using a source database platform other than ODBC.  To do 
this you must have access rights to the database server as well as the appropriate database 
drivers.  You must also have the appropriate settings in the configuration files (for example, ini 
files) and in the Windows registry.  For more information, see Create an Import Link for an Oracle 
Source (on page 18). 

Create an Import Link for a File Source 
Use this procedure to create an import link for a data source that is a predefined file containing 
tables with table columns and values.  For more information, see Create an Import Link for a File 
Source (on page 19). 

Define a Data Import Source in Excel Spreadsheets 
Use this procedure to define tables, table columns and column values in an Excel 
spreadsheet.  You can then use this Excel spreadsheets as a source for data import.  For more 
information, see Define a Data Import Source in Excel Spreadsheets (on page 20). 
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Prerequisite for Using Microsoft Access as an Import Source 
Before you create an import link for a Microsoft Access data source file, you need to perform the 
following procedure in Microsoft Access file containing the source data.  For more information, 
see Prerequisite for Using Microsoft Access as an Import Source (on page 20). 

Using the Link Explorer Window 
You use the Link Explorer window to move and copy links.  For more information, see Using the 
Link Explorer Window (on page 21). 

Change Link Source Paths 
Use this procedure to change the path or name of the source file of an existing link when you need 
to update the source path.  You can change the source path of a single link or you can set one 
default folder for all your links in that group.  For more information, see Change Link Source Paths 
(on page 22). 

Export Links 
Use this procedure when moving a link or exporting a group of links to another database or 
domain.  When you export a group of links you transfer the information about a group of links to 
an ASCII file which has the .imp extension.  You can then use the exported links in other domains 
or databases.  The link information is saved to an ASCII file which you can use for import.  For 
more information, see Export a Group of Links (on page 22). 

Import Links 
Use this procedure to import the link or group of links you exported.  You can use a file with the 
.imp extension to create a group of links based on the information you have saved in this file.  For 
more information, see Import Links (on page 23). 
 
 

Create an Import Link for an ODBC Source 

Prerequisites 
 If you need to connect to a domain residing in another Sybase Adaptive Server Anywhere 

database, make sure you created an ODBC profile for connection to the source 
database.  You can use the Internal Setup Utility options to create ODBC profiles for Sybase 
Adaptive Server Anywhere.  The ODBC profiles that you create become available for 
selection in the Import Utility. 

 If you need to connect to a domain residing in another SQL Server database, make sure you 
created an ODBC profile for connection to the source database.  You cannot use existing 
profiles that are available for selection in the Import Utility.  When creating a new ODBC 
profile for SQL Server, make sure the new profile name is unique in the Windows registry of 
the machine where you run the Import Utility. 

 SmartPlant Instrumentation supports Microsoft dBase Driver for .dbf files, and Microsoft 
Text Driver for .txt and .csv files. You can select the driver you require using the ODBC Data 
Source Administrator in your Windows Administrative Tools. 
1. Do one of the following: 

 Click Actions > New Group. 

 Click . 
 In the link list, select an existing link group. 

2. Do one of the following: 
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 Click . 
 Click Actions > New Link. 

3. On the Link Definitions dialog box, under Import method, click Single table or Module 
(multiple tables) and select the appropriate target table or module from the list. 

 You can import data only into a target table which has a table definition (for 
example, a table which has a correct definition of a primary key, foreign keys, and reference 
tables).  If you import data into a target module, all the tables in the target module must have 
a table definition. 

4. Under Source, from the Database type list, select ODBC as the source database platform. 
5. From the ODBC profile list, select the required database profile or a file that contains source 

table definitions. 
 Your selection affects the way you connect to the SQL data source and the dialog box 

options change accordingly. 
6. Do one of the following: 

 If you selected a database profile, specify the user name and password for connecting to 
the source database and click Connect; then, from the Table list, select a table from 
which you want to import data. 

 If you selected a data source file, beside File name and path, click Browse and specify 
the data source file. 
 If you are creating a new link on the basis of an existing link, select Save as new link. 

7. Click Apply and then Close. 

8. Click  to display the link you defined in the Link Explorer. 
  
 

Create an Import Link for an Oracle Source 
1. Do one of the following: 

 Click Actions > New Group. 

 Click . 
 In the link list, select an existing link group. 

2. Do one of the following: 

 Click . 
 Click Actions > New Link. 

3. On the Link Definitions dialog box, under Import method, select Single table or Module 
(multiple tables) and select the appropriate target table or module from the list. 

 You can import data only into a target table which has a table definition (for 
example, a table which has a correct definition of a primary key, foreign keys, and reference 
tables).  If you import data into a target module, all the tables in the target module must have 
a table definition. 

4. Under Source, from the Database type list, select a source Oracle version. 
5. Under Server name, type the server name where the source Oracle database resides. 
6. Under User name and Password, provide logon information for connection to the source 

Oracle database. 
7. Click Connect to establish a connection to the selected Oracle database. 
8. From the Table list, select a table from which you want to import data. 

 If you are creating a new link on the basis of an existing link, select Save as new link. 
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9. Click Apply and then Close. 

10. Click  to display the link you defined in the Link Explorer. 

See Also 
Target Table Definition (on page 43) 
 

Create an Import Link for a File Source 
1. Do one of the following: 

 On the Actions menu, click New Group (or click ) to create a new link group. 
 In the link list, select an existing link group. 

2. Do one of the following: 

 Click . 
 Click Actions > lick New Link. 

3. On the Link Definitions dialog box, under Import method, click Single table or Module 
(multiple tables) and select the appropriate target table or module from the list. 

 You can import data only into a target table which has a table definition (for 
example, a table which has a correct definition of a primary key, foreign keys, and reference 
tables).  If you import data into a target module, all the tables in the target module must have 
a table definition.  If you select a target table which does not have a table definition or has an 
incorrect table definition, an appropriate message will be displayed.  In this case you will have 
to select another target table or modify the table definition.  To learn more about setting the 
table definition, see Target Table Definition (on page 43). 

4. Under Source, from the Database type list, select ODBC as the source database platform. 
5. From the ODBC profile list, select the appropriate data source file type. 
6. Beside File name and path, click Browse. 
7. On the Select File dialog box, select the source file and then, do one of the following: 

 In the data source file does not have table definitions, click Open to display the file name 
and path on the Link Definitions dialog box. 

 If the file that you selected has table definitions, for example, an Excel spreadsheet, on 
the Enter Table Name dialog box, type the name of the source table in upper case, as it 
appears in the data source file, and then click OK to display the file name and path on the 
Link Definitions dialog box. 
 If you are creating a new link on the basis of an existing link, select Save as new link. 

8. Click Apply and then Close. 

9. Click  to display the link you defined in the Link Explorer. 

See Also 
Target Table Definition (on page 43) 
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Define a Data Import Source in Excel Spreadsheets 
1. With your Excel worksheet open, in the top cell row, define table column names without 

spaces, for example, instrument_tag_number, service, and so forth. 
 You must not use underscore ('_') in column names. 

2. In the cells under the table column names, define the column values, for example, 101-FT - 
100/A, Flow, and so forth. 
 
 

 
 The table or column names that you define do not have to match the table column names 

in SmartPlant Instrumentation. 
 Make sure that the values you enter in the cells comply with the data format used in 

SmartPlant Instrumentation.  For example, when defining instrument tag numbers, you 
must use the naming convention defined in SmartPlant Instrumentation. 

3. Select the cells that you want to include into a table. 
4. Click Insert > Name > Define. 
5. In the Name in workbook box, type the table name in upper case, for example, 

SOURCE_INSTRUMENTS. 
6. Click Add. 
7. Click OK to return to your Excel spreadsheet and repeat this procedure for all other tables that 

you require. 
8. Save the spreadsheet. 

See Also 
Set Properties for an Excel Data Source (on page 31) 
 

Prerequisite for Using Microsoft Access as an Import Source 
1. In Microsoft Access, open a data source file and click Tools > Options. 
2. On the View tab, select the System objects check box and click OK. 
3. Click Tools > Security > User and Group Permissions. 
4. Under Object Name, select MSysObjects. 
5. Select the Read Data check box and click OK. 
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Using the Link Explorer Window 
You can perform the following actions in the Link Explorer window. 

To do 
this... 

With the 
mouse... 

From the 
keyboard... 

Notes 

Move a link Select a link in 
the left pane and 
drag the link to 
the new location

Press Ctrl+ X to 
cut the selected 
link; press Ctrl+ V 
to paste in the new 
location 

The link always 
appears below 
the position you 
drag it to; drag 
to the group to 
make it the first 
link in the group

Copy a link Select a link in 
the left pane and 
hold down Ctrl 
while dragging 
the link to the 
new location 

Press Ctrl+ C to 
copy the selected 
link; press Ctrl+ V 
to paste in the new 
location 

The link always 
appears below 
the position you 
drag it to; drag 
to the group to 
make it the first 
link in the group

Move a 
group of 
links 

Select a group in 
the left pane and 
it to the new 
location 

Press Ctrl+ X to 
cut the selected 
group; press Ctrl+ 
V to paste in the 
new location 

If one or more 
of the links 
already exists 
in the target, it 
is not deleted in 
the source 

Copy a 
group of 
links 

Select a group in 
the left pane and 
hold down Ctrl 
while dragging it 
to the new 
location 

Press Ctrl+ C to 
copy the selected 
group; press Ctrl+ 
V to paste in the 
new location 

 

Move 
multiple 
links 

In the right pane, 
hold down Shift 
or Ctrl while 
selecting the 
required links 
and drag to the 
new location in 
the left pane 

 The links 
always appear 
below the 
position you 
drag it to; drag 
to the group to 
make it the first 
link in the group

Copy 
multiple 
links 

In the right pane, 
hold down Shift 
or Ctrl while 
selecting the 
required links 
and drag to the 
new location in 
the left pane 
while holding 
down Ctrl 

 The links 
always appear 
below the 
position you 
drag it to; drag 
to the group to 
make it the first 
link in the group
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To do 
this... 

With the 
mouse... 

From the 
keyboard... 

Notes 

Change the 
link order 

Drag links up or 
down in the 
group 

Press Ctrl+ X to 
cut the selected 
link; press Ctrl+ V 
to paste in the new 
location 

The link always 
appears below 
the position you 
drag it to; drag 
to the group to 
make it the first 
link in the group

See Also 
Dissociate Links From a Group (on page 14) 
Delete a Link Group (on page 15) 
 

Change Link Source Paths 
1. In the Link Explorer, select the required group and click  to expand the group and display 

its links. 

2. On the toolbar, click  ( Edit Links). 
3. On the Link Definitions dialog box, click Browse. 
4. Navigate to the required source file and click Open. 
5. Click Close to close the Link Definitions dialog box. 

 You can change the source path only if the platform is a database file, for example, dBase, 
Excel, ASCII, and so forth. 
 
 

Specify a New Default Folder for All Links 
1. In the Link Explorer, do one of the following: 

 Click  ( Folder). 
 Click Actions > Folder. 

2. In the Default Source File Folder dialog box, click Browse. 
3. Navigate to a file in the required folder and click Open. 
4. Click Apply. 
5. To undo the current default folder settings, click Clear next to the default path. 
6. Click Close. 

 You can change the source path only if the platform is a database file, for example, dBase, 
Excel, ASCII, and so forth. 
 

Export a Group of Links 
1. Click Service > Export Links. 
2. In the Export Link Groups dialog box, select one or more groups that you want to export. 
3. Click OK and, on the dialog box that opens, do the following: 
4. Type the filename of the link file name (you do not have to add the .imp extension). 
5. Navigate to the required location where you will save the link file. 
6. Click Save to save the link file. 
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See Also 
Moving Links Between Databases or Domains (on page 16) 
 

Import Links 
1. Click Service > Import Links. 
2. In the Open File dialog box, navigate to the required ASCII file with the .imp extension which 

you want to use for import and click OK. 
3. When prompted, click Yes to import the group of links from the .imp file. 
4. On the Database Table Definition dialog box, select the Import link table definition check 

box to import the table definition saved in the group of links as well as the links themselves, or 
clear the check box to import only the group of links. 

5. Under Duplicate table definition names, do one of the following: 
 Click Create new to import the link table definition if the imported table definition name is 

the same as the current table definition.  This way, the Import Utility appends a $ sign to 
the imported table definition name.  For example, Process Data will be renamed as 
Process Data$. 

 Click Skip to skip the import of the table definition if the current table definition name is the 
same as the imported table definition. 

6. Click OK to import the group of links. 
 If the links groups or links that you import already exist, the software appends a $ sign to the 

imported link or group name. 

See Also 
Moving Links Between Databases or Domains (on page 16) 
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Import Link Properties 
Import link properties are various parameters that influence the import process when you run the 
link.  You define and manage import link properties using various options on the tabs of the Link 
Properties dialog box.  By selecting properties on the General tab, you control various features 
which influence the import setup process. 
The available options depend on whether the current link is assigned to the Module (multiple 
tables) or Single table import method.  Some of the displayed options depend on the specific 
module that you selected for the link.  When duplicating an import link, all the source import link 
properties are retained. 
 
 

Defining Import Link Properties Common Tasks 
The following tasks are used when you setting the import link properties. 

Open Link Properties 
Use this procedure to display the Link Properties dialog box either from the Link Explorer or 
Import Link window.  For more information, see Open Link Properties (on page 26). 

Set Properties for Handling Mismatched Data 
Use this procedure to determine how the software handles imported source rows with invalid 
empty foreign key columns that are defined as NOT NULL but contain no value.  For more 
information, see Set Properties for Handling Mismatched Data (on page 26). 

Set Import Mode Parameters 
Use this procedure to perform the following operations: 
 Determine the way SmartPlant Instrumentation treats identical source and target rows by 

setting the appropriate parameters in the Import mode tab. 
 Determine how the Import Utility updates target rows during the import process. 
 Select source and target keys for the Import Utility to use to refresh the target data during the 

import process.  This option is available to you only if the source and target tables have been 
already used in a previous import session. 

For more information, see Set Import Mode Parameters (on page 26). 

Specify a Filtering Condition 
Use this procedure to define a filtering condition which will be used by Import to selectively import 
data from the source table.  The filtering condition can contain any combination of the following: 
 Source table columns 
 Operators or functions 
 Alphanumeric values 

For more information, see Specify a Filtering Condition (on page 27). 
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Enable Reference Tables for Import 
Use this procedure to enable data insertion into the target reference tables during the import 
process whenever data exists in the source table but it is missing in the target table.  As a rule of 
thumb, you must always import data into reference tables before importing data into the tables 
they refer to.  You can also control which reference table columns are displayed in the Import 
Link window by selecting a browser view created in SmartPlant Instrumentation.  You can 
perform this procedure only when using the Single table import method.  For more information, 
see Enable Reference Tables for Import (on page 28). 

Set the Tag/Loop Parameters 
Use this procedure to determine the way the Import Utility handles the naming conventions of the 
source data during the import process.  This procedure is possible only if the target table or 
module you selected requires naming conventions, for example, COMPONENT table, LOOP 
table, Instrument Index module, and so forth.  For more information, see Set the Tag/Loop 
Parameters (on page 29). 

Set Custom Parameters for the Module Import Method 
Use this procedure to show in the Import Link window only those table columns that are used in a 
specific browser view style defined in the Browser module.  This way, you can use these columns 
in creating the current import link.  You can perform this procedure only if your import link is 
assigned to the Module (multiple tables) import method and you selected to import data into one 
of the following modules: Instrument Index, Process Data – Line, or Dimensional Data for 
Piping.  For more information, see Set Custom Parameters for the Module Import Method (on 
page 30). 

Set Column Display for the Module Import Method 
When your link is assigned to the Module (multiple tables) import method, you can use this 
procedure to set the Import Utility to display all target module table columns in the Import Link 
window.  By default, when opening an import link assigned to the Module (multiple tables) 
import method, the Import Utility only retrieves those columns that appear in a special hard-coded 
list and displays them in the Import Link window.  The special list serves two purposes: 
 To shorten the list of table columns displayed in the Import Link window. 
 To display data field names instead of the table column names used in the database. 

  You cannot perform this procedure when importing data into the Specifications module. 
For more information, see Set Column Display for the Module Import Method (on page 30). 

Set Properties for an Excel Data Source 
Use this procedure to if your data source is an Excel file and there are source fields containing 
more than 256 characters.  For more information, see Set Properties for an Excel Data Source 
(on page 31). 

Refresh Previously Imported Data 
Use this procedure to keep the tables that you have already used in a previous import session up 
to date by refreshing them.  To refresh tables you previously imported, you need to select the 
same source and target data as you did in the previous import session.  Then you select the 
appropriate source and target refreshing keys which are the source and target table columns 
according to which contents the target data will be refreshed during the import process. 
If the Import Utility detects a change in the selected source refreshing key contents (in comparison 
to the selected target refreshing key contents), the target table column contents will be updated 
accordingly.  For more information, see Refresh Previously Imported Data (on page 31). 
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Open Link Properties 
 To open the Link Properties dialog box, do one of the following: 

 Click . 
 Click Actions > Properties. 

  
 

Set Properties for Handling Mismatched Data 
1. Open the Link Properties dialog box. 
2. On the General tab, under Undefined NOT NULL fields, do one of the following: 

 Select Use default value to sets any reference columns values in the target table to zero 
during the import process if these columns do not appear in the appropriate reference 
table. 

  Selecting the Use default value option overrides any selections you make in the 
Default column on the Target Table Definition dialog box.  To learn how to use the 
Target Table Definition dialog box, see Target Table Definition (on page 43). 

 Select Reject rows to set the Import Utility to reject all source rows that contain reference 
columns that do not appear in the appropriate reference table during the import process. 

See Also 
Common Error Messages (on page 113) 
 

Set Import Mode Parameters 
1. On the Link Properties dialog box, click the Import Mode tab. 
2. Under Target database import mode, do one of the following: 

 Select Insert and update to enable the Import Utility to insert new source rows and 
update existing target rows during the import process. 

 Select Insert to prevent the Import Utility from updating target rows and to enable 
insertion of only new source rows in the target domain during the import process. 

 Select Delete to delete existing rows in the target domain during the import process. 
 Select Move to move the rows in the target domain to a different <unit> in the same 

domain. 

 
 The Delete and Move modes are only available when using the Single table import 

method. 
 If you selected Insert and update, the Update operation is carried out automatically 

whenever a source row contains the same key definition as the target row. 
3. If you chose the Insert and update option in step 2, under Target database update 

condition, select any combination of the following check boxes: 
a. If the source contains a NULL value 

 Select to overwrite the target table column even if the corresponding source table 
column contains a NULL value. 

 Clear to skip source table columns that contain a NULL value. 
b. If the source contains a space or a zero value 
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 Select to overwrite the target table column even if the corresponding source table 
column contains a space value or a zero value. 

 Clear to skip source table columns that contain a space value or a zero value. 

 
 Some database drivers interpret spaces in a source table column as a NULL 

value.  To avoid incorrect overwriting of data in the target, it is highly recommended 
that you select both or neither of the above two check boxes. 

When inserting NULL values for table columns of data type String that can normally 
accept a NULL value, you can specify the insertion of a single space instead of NULL.  To 
do so, in the Intools.ini file, under the [Import] section, type the line: 
FillSpace=Y 

c. Do not insert 
 Select to skip inserting source rows that do not exist in the target table. 
 Clear to insert source rows that do not exist in the target table. 

See Also 
Target Table Definition (on page 43) 
Refresh Previously Imported Data (on page 31) 
 

Specify a Filtering Condition 
1. On the Link Properties dialog box, click the Source tab. 
2. Select Filter the source table to enable filtering during the import process. 
3. Click Modify to open the Import Source Filter dialog box. 
4. To create a filtering condition, do one or more of the following: 

 In the Source table columns data window, double-click the table column that you want to 
add to the filter condition in the data window. 

 Under Operators and functions, click the appropriate operator or function buttons to add 
the appropriate operator or function to the filtering condition. 

 Under Operators and functions, select the desired SQL function from the appropriate 
list.  Then right-click the selected SQL function to be applied in the filter condition.  

 In the Import Source Filter dialog box, type the appropriate expression.  You can also 
add this expression to the filtering condition already displayed in the Import Source Filter 
data window. 

 
 The Filter feature provides you with various built-in operators and functions.  For 

details, see Built-In Operators and Functions (on page 58).  The built-in operators 
and functions are those used in the WHERE SQL statement.  See your database 
platform manual to learn more about database statements. 

 The Filter feature also provides you with special SQL functions, which are native to 
the source database.  For details, see SQL Functions Native to the Source Database 
(on page 60). 

5. Repeat step 4 to add as many table columns, operators, functions and values as required. 
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The new condition appears in the window of the Import Source Filter dialog box, for 
example: 

 
6. To check the filter condition syntax, click Verify. 

An appropriate message is displayed, notifying you that: 
 The condition in the data window is valid – in this case the message also indicates the 

number of rows which match the condition. 
 The condition in the data window is invalid – in this case you can correct the condition and 

try again. 
7. To view the way the filtering condition affects the source data, click View Source. 
8. Click OK to close the Import Source Filter dialog box and return to the Source tab where 

your condition appears in the data window. 
  You can disable the current filtering condition without deleting it.  To do this clear Filter 

the source table after you define a condition. 
9. Under Associate source tables, select Apply to associate additional source data with the 

source data that you selected when you started this import session.  To make the source data 
definitions, click Define.  See Associate Additional Source Data (on page 57) to learn how to 
do this. 

10. Under Process function, select Assign to assign SmartPlant Instrumentation process 
functions to the imported data based on their instrument types.  To make the source data 
definitions, click Define.  For details, see Associate Source Fields with Existing Instrument 
Types (on page 92) or Set Source Fields as Instrument Type Fields (on page 91). 

See Also 
Viewing the Source Data (on page 55) 
Working with Source Data (on page 55) 
 

Enable Reference Tables for Import 
 The link for which you want to enable reference tables must be assigned to the Single 

table import method. 
1. Select a link and open the Link Properties dialog box. 
2. On the General tab, select Insert data into reference tables. 
3. Click the Style tab and do the following: 
4. Under Browser view, select the browser view whose fields you want to display when you 

open the current link in the Import Link window. 
5. Click Style Preview to display the list of data field names and table columns defined for the 

selected browser view style. 
6. Click Select View to apply the style settings for the current link. 

 
 You can only select one browser view. 
 If you click Clear to clear the browser view selection, or select the Display all fields 

check box, when you open the current link in the Import Link window, the software 
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displays all columns of all the reference tables as they are defined in the 
database.  Selecting the Display all fields check box disables browser view style 
selection options. 

 The browser view list contains all browser views defined in SmartPlant 
Instrumentation.  You can define a new browser view in SmartPlant Instrumentation if 
you find no suitable browser view for the current import link. 

7. Click OK. 
 
 

Set the Tag/Loop Parameters 
1. On the Link Properties dialog box, click the Tag/Loop tab. 
2. Do one of the following: 

 Select Define the naming conventions in the link to enable the Import Utility to define 
the naming conventions structure automatically by extracting the naming conventions 
structure from the current link. 

 Clear Define the naming conventions in the link to define the naming convention 
structure manually by entering a naming convention string in the Define Tag Name 
Structure dialog box and/or the Define Loop Name Structure dialog box. 

3. If you cleared the check box in the previous step, do one of the following: 
 Select Redefine the naming convention to redefine links for the tag/loop naming 

conventions parts of the source table. 
 Clear Redefine the naming convention to use the current naming conventions without 

redefining their links. 
  Instrument conventions are defined in the Administration module.  If you select to 

redefine the naming conventions, you need to assign new values to the instrument tag 
segments. 

4. Select Validate tag and loop segments to verify the following during the import process: 
 Whether the instrument type values of the imported tags in the COMPONENT table exist 

in the Instrument Type table (COMPONENT_FUNCTION_TYPE). 
 Whether the loop function values of the imported loops in the LOOP table exist in the Loop 

Function table (LOOP_FUNCTION). 
 Whether the measured variables of the imported loops in the LOOP table exist in the Loop 

Process Variable table (LOOP_PROC).  Note that selecting this option slows down the 
import process. 

  Validate tag and loop segments is selected by default, thus enabling the 
validation check of the imported tags and loops before transferring data.  It is recommended 
you do not clear this box to avoid import failure due to missing data. 

5. Do one of the following: 
 Select Use the loop reference data to also import loop reference data into the 

COMPONENT table during the import process. 
 Clear Use the loop reference data to disregard any loop reference data during the 

import process. 
  To prevent import failure, clear Use Loop reference data if the imported 

COMPONENT table contains empty loop reference columns. 
6. If you selected in the beginning of the current import session to import into the Instrument 

Index module, the Use Tag data check box appears in the Tag/Loop tab folder.  In this case, 
do one of the following: 
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 Select the check box to include source tag number data from supporting tables in the 
current import.  You will need to redefine the naming conventions for all target <units> in 
the Administration module before you start the import process. 

 Clear the check box to exclude tag supporting table data from the current import session. 

See Also 
Define Links for Naming Conventions (on page 63) 
 

Set Custom Parameters for the Module Import Method 
1. On the Link Properties dialog box, click the Custom Fields tab. 
2. To show the custom fields of a line style in the Import Link window, under Line, do the 

following: 
a. Select Use style for line to include the custom fields of the selected style in the Import 

Link window. 
b. From the list, select the browser view style whose custom fields you want to show in the 

Import Link window. 
3. To show the custom fields of an equipment style in the Import Link window, under 

Equipment, do the following: 
a. Select Use style for equipment to include the custom fields of the selected style in the 

Import Link window. 
b. From the list, select the browser view style whose custom fields you want to show in the 

Import Link window. 
4. To show the custom fields of a loop style in the Import Link window, under Loop, do the 

following: 
a. Select Use style for loop to include the custom fields of the selected style in the Import 

Link window. 
b. From the list, select the browser view style whose custom fields you want to show in the 

Import Link window. 
5. To select the dimensional group to be used in the Import Link window for importing data to 

the Dimensional Data for Piping module custom fields, under Select dimensional group for 
custom name, select Apply to enable a selection to be made from the list, and then from the 
list, select the browser view style whose custom fields you want to show in the Import Link 
window.  The following options are available: 
 Computed group name — Automatically creates the source for the Dimensional Group 

Name field in the Import Link window, using the group from the 
COMPONENT_DIMENSIONAL table to which the tag defined in the link belongs. 

 All Groups — Allows you to import data for all custom fields in the module.  The 
Dimensional Group Name section in the Import Link window consists of two table 
columns: Dimensional Group CAD Code and Dimensional Group Description.  With 
this option selected, you can enter an existing group or a new group for the source name. 
  All the custom fields are displayed in the Import Link window and are assigned 

sequential numbers. 
 
 

Set Column Display for the Module Import Method 
  The link for which you want to enable reference tables must be assigned to the 

Module (multiple tables) import method. 
1. Select a link and open the Link Properties dialog box. 



 Import Utility 
 

 

SmartPlant Instrumentation Import and Merger Utilities User's Guide 31 

2. Click the Style tab. 
3. Do one of the following: 

 Select the Display all fields check box to display in the Import Link window all the 
pertinent table columns of the target module. 

 Clear the Display all fields check box to display in the Import Link window only those 
table columns that are included in the hard- coded list. 
  Browser view selection options on the Style tab are only available when the import link 

is assigned to the Single table import method. 
4. Click OK. 
 
 

Set Properties for an Excel Data Source 
  Make sure your Excel import source is defined correctly.  For details, see Define a 

Data Import Source in Excel Spreadsheets (on page 20). 
1. Select a link and open the Link Properties dialog box. 
2. On the General tab, clear the Ignore duplicated source rows check box. 

  You must clear this check box if your Excel file has source fields containing 
more than 256 characters.  If this check box is selected, the software only imports the first 
256 characters from such fields.  This is a limitation of Excel drivers. 

3. Click OK. 
 
 

Refresh Previously Imported Data 
1. On the Link Properties dialog box, click the Import Mode tab. 
2. Click Insert and update to enable refreshing. 
3. Under Refresh from source, select Apply. 
4. Click Parameters. 
5. On the Refresh Parameters dialog box, under Target: 

a. From the Table name list, do one of the following: 
 Select the appropriate target table. 
 Accept the given default value (the current target table). 

 
 The target tables which are available to you in the Target section Table list depend on 

your target data type that you selected in the beginning of the current import session: 
 If you selected to import data into a specific table, only that target table would appear 

in the Table list. 
 If you selected to import data into a module, all the tables which are associated with 

that target module would appear in the Table list. 
b. From the Refresh key list, do one of the following: 

 Select the target table column to refresh during the import process. 
 Accept the given default value (the current target table). 

6. Under Source: 
a. From the Table list, select the appropriate source table.  This box is empty by default. 
b. From the Refresh key list, select the source table column to refresh from during the 

import process.  This box is empty by default. 
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7. Select View saved parameters to automatically select the last saved refreshing parameters. 
  If you click Delete, you are prompted to delete the last saved refreshing parameters. 

8. Click Save to save the refreshing parameters you currently selected in the Refresh 
Parameters dialog box. 

9. When prompted to confirm the new selection, do one of the following: 
 Click Yes to overwrite the last saved refreshing parameters and return to the Link 

Properties dialog box. 
 Click No to return to the Refresh Parameters dialog box without overwriting the last 

saved refresh parameters. 
  If you enable the data refresh option or overwrite the last saved refreshing parameters, 

you are prompted to use data refreshing or overwrite the existing target data during the 
current import session. 

 
 

Link Properties Dialog Box 
This dialog box enables you to define various properties for the current link.  The properties that 
you define influence the import process when you run the link.  You define and manage import 
link properties using various options on the tabs of the Link Properties dialog box.  The available 
options depend on whether the current link is assigned to the Module (multiple tables) or Single 
table import method.  Some of the options are only available if you assign the import link to a 
specific module.  When duplicating an import link, all the source import link properties are 
retained. 
General Tab (see "General Tab (Link Properties Dialog Box)" on page 33) 
Import Mode Tab (see "Import Mode (Link Properties Dialog Box)" on page 34) 
Tag/Loop Tab (see "Tag/Loop Tab (Link Properties Dialog Box)" on page 36) 
Source Tab (see "Source Tab (Link Properties Dialog Box)" on page 37) 
Comparison Tab (see "Comparison Tab (Link Properties Dialog Box)" on page 38) 
Import Level Tab (see "Import Level Tab (Link Properties Dialog Box)" on page 39) 
Specs Tab (see "Specs Tab (Link Properties Dialog Box)" on page 39) 
Custom Fields Tab (see "Custom Fields Tab (Link Properties Dialog Box)" on page 40) 
Style Tab (see "Style Tab (Link Properties Dialog Box)" on page 42) 
Multi-Form Tab (see "Multi-Form Tab (Link Properties Dialog Box)" on page 43) 
Table Definition — Opens the Target Table Definition dialog box where you can view and 
modify the target table definition. 
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General Tab (Link Properties Dialog Box) 
The options on the General tab allow you to set general properties for the import link. 

General parameters 
Generate rejected data report — Allows you to create a report of the rows rejected while 
importing your data.  Selecting this check box may slow down the import process if any rejected 
rows are found. 
Import to supporting tables only — Restricts the Import Utility to insert data only into the 
SmartPlant Instrumentation supporting tables, that is, tag and loop data is not 
imported.  Selecting this option disables the Tag/Loop Parameter settings.  This check box is 
available only if you selected the Module import method on the Link Definitions dialog box. 
Insert data into reference tables — Allows the software to insert the imported data into 
reference tables when this data is missing in the target table.  This check box is available only if 
you selected the Single table import method on the Link Definitions dialog box. 
Messages off — Select this option to cancel the display of messages during the import process. 
Ignore duplicated source rows — Reduces all source rows to one if they contain field values 
which already exist in other source rows. 

 
 If your data source is an Excel file and there are source fields containing more than 256 

characters, you must clear the Ignore duplicated source rows check box.  Otherwise, the 
software only imports the first 256 characters from such fields.  This is a limitation of Excel 
drivers. 

Use reserved symbols with import — Allows you to do the following: 
 Check the source fields for a reserved symbol such as single quote. 
 Correct the target fields so that an SQL statement can be run after the import process is 

completed. 

 
 Selecting this check box slows down the import process to some extent. 

Match case — Makes matching of source and target data values case sensitive.  For example, if 
the value of a panel name in the source is ABC, and in the target it is Abc, with the check box 
selected, the panel name does not exist in the target database, because the cases do not 
match.  With the check box cleared, no check is made for the case match, so the value of the 
panel name is based on the string only, and in this example, it exists in the target.  Note that 
selecting this check box improves the import performance and it is recommended to select it 
whenever possible. 

Undefined NOT NULL fields 
Use these options to define the way the Import Utility deals with data imported into a not null field 
(that is, a field that is required to contain some value) if that data does not match existing 
SmartPlant Instrumentation data.  Selecting one of these options determines how this 
mismatched data is imported. 
Use default value — Sets the software to use the default value (zero) for the rows that contain 
reference fields that are undefined and that are not NULL.  This situation can occur if you do not 
import data into the appropriate reference table.  Selecting this option overrides any selections 
you make in the Default column in the Table Definition dialog box. 
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Reject rows — Sets the software to reject the source row if it contains reference fields that are 
undefined and that are not NULL.  This situation can occur when importing an instrument tag and 
the imported manufacturer ID number does not match any of the existing manufacturers defined in 
SmartPlant Instrumentation. 
Import revisions — Allows you to import revision data from the source database.  This check 
box is available only when importing data into the Process Data module.  If you select this option, 
you must define the link for the REVISION table in the Import Link window. 
Use custom drawing names — Replaces the default document numbers with your own 
customized numbers.  These numbers must be unique on the <plant> level.  Clearing this check 
box allows you to use default document numbers.  This check box is available only when 
importing data into the Process Data module. 
Create calculation sheet — Creates a calculation data sheet for every tag that does not have a 
calculation sheet, and updates all the existing calculation sheets using the imported data.  The 
calculation data is obtained from the source database according to the link that you define in when 
importing data to the module in the Import Link window.  Selecting this option also creates a 
calculation revision record for the source tag associated with the new calculation sheet.  You 
must define the link for the REVISION (Calculation) table in the Import Link window.  This check 
box is available only when importing data into the Process Data module but not available for the 
import of line, level, and pressure data. 

Create complementary elements 
These options are only available when importing data into the Instrument Index module or 
instrument index-related table.  Select the Create check boxes beside the complementary 
elements you want to create during the import process.  Some elements, such as document 
numbers, are created in the target database while for other elements (for example, wiring data), 
only the appropriate connections between the relevant elements are established. 
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Import Mode (Link Properties Dialog Box) 
The options on the Import Mode tab allow you to set properties for handling source data for the 
current link.  You can determine how the transfer of the source data affects the target data by 
specifying one of the following: 
 Insert new data and overwrite the existing data. 
 Insert new data and reject the existing data. 
 Delete existing data. 
 Move existing data within the same target domain. 

If you select to insert and update the target data, you can also set the conditions under which 
identical source and target data will be overwritten. 

Target database import mode 
Select one of these buttons to determine the data transfer mode. 
Insert and update — Inserts new source data and overwrite the target rows that are identical to 
the source rows.  The Import Utility will insert and update the target according to the three options 
that you select from the Target database update conditions group box. 
Insert — Does not overwrite the target rows during the import process.  This means that the 
Import Utility will only insert new source rows into the target domain and reject existing 
ones.  Selecting this button disables the three check boxes in the Target database update 
conditions group box. 

 
 If you are importing a value for which the number of characters exceeds the maximum 

allowed, the Import Utility truncates the extra characters in the target field in the SmartPlant 
Instrumentation database.  If, as a result of truncating the value, the string is identical to an 
existing value in the database, the Import Utility rejects the import if the value is required to be 
unique and the import mode in the import link properties is set to Insert. 

Delete (available only when the link is assigned to the Single table import method) — Deletes 
existing data according to your settings in the Import Link window. 
Move (available only when the link is assigned to the Single table import method) — Moves 
specified target data within the same target domain to another plant hierarchy item.  You specify 
the pertinent plant hierarchy items in the Import Link window. 

Target database update conditions 
Use these options to set the conditions under which Import will overwrite existing target rows 
during the import process and whether to include associated tag numbers when deleting loop 
numbers. 
Update for source containing a NULL value (available only if Insert and update is selected) — 
Select this option to overwrite all target fields even if the source fields contain a NULL 
value.  Clear this check box to skip source fields which contain a NULL value. 
Update for source containing a space or a zero value (available only if Insert and update is 
selected) — Select this option to overwrite all target fields if the source fields contain a space or a 
zero value; also when changing data to a zero or space.  Clear this check box to skip source fields 
which contain a space or a zero value. 
Do not insert (available only if Insert and update is selected) — Select this option not to insert 
source rows which do not exist in the target table.  Clear this check box to insert source rows 
which do not exist in the target table. 



Import Utility 
 

 
36 SmartPlant Instrumentation Import and Merger Utilities User's Guide 

Deletion option 
Delete associated tags — Select this option to delete all tag numbers associated with deleted 
loop numbers.  This option is only available when importing loop numbers and if you selected 
Delete in the Target database import mode group box. 

Refresh from source 
Use these options to refresh the tables you imported previously.  Remember that if you want to 
keep your previously imported tables, you need to select the same source and target data as you 
did in the previous import session.  Then you select the appropriate source and target refresh 
keys.  The target data is refreshed during the import process according to the content of the 
source and target refresh keys.  If the Import Utility detects a change in the selected source 
refresh key contents (in comparison with the selected target refresh key content), the target field 
content is updated accordingly. 

 
 If the data was imported previously with this option selected, the same data records is 

refreshed from the source in subsequent import sessions even if the primary key in the target 
was changed. 

The options below are available only if Insert and update in the Target database update 
conditions group box is selected. 
Apply — Allows you to set the Import Utility to refresh the target data according to the refresh 
parameters you set in the Refresh Parameters dialog box. 
Parameters — Opens the Refresh Parameters dialog box, where you set the import refresh 
parameters. 
 
 

Tag/Loop Tab (Link Properties Dialog Box) 
The options in this tab are available only if the target table or module requires naming 
conventions, for example COMPONENT table or Instrument Index module.  These options 
enable you to determine the way the Import Utility handles the naming conventions of the source 
data during the import process: 
 Verify that the imported tags contain a valid instrument type value. 
 Verify that the imported loops contain valid measuring variable values. 
 Include loop reference data during the import process. 
 Include tag number data from supporting tables when importing into the Instrument Index 

module. 
You can also determine whether to insert leading zeros in the numeric segments of the tag and 
loop name string.  Note, however, that this is a global Import Utility parameter that you set on the 
Preferences dialog box. 
Define the naming conventions in the link — Select this check box to let the Import Utility 
define the naming conventions using a link.  You will define link between the source and target 
fields used for tag and loop number naming conventions in the Import to Table or Import to 
Module dialog box. 
Clear this box to define the naming conventions by entering a naming convention string in the 
Define Tag Name Structure dialog box and/or in the Define Loop Name Structure dialog box. 
Redefine the naming conventions — Select this check box to redefine the links for the tag/loop 
naming convention parts of the source table. 
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Clear this option to use the existing naming convention link without redefining the links. 

 
 The tag number name structure is defined on the Naming Conventions dialog box in the 

Administration module.  If you select to redefine the naming conventions, you must assign 
new values to the tag segments. 

Validate tag and loop segments — Select this check box to verify the following: 
 If the instrument type values of the imported tags in the COMPONENT table exist in the 

Instrument Type table ( COMPONENT_FUNCTION_TYPE) 
 If the loop function values of the imported loops in the LOOP table exist in the Loop Function 

table ( LOOP_FUNCTION) 
 If the measured variables of the imported loops in the LOOP table exist in the Loop Process 

Variable table ( LOOP_PROC) 
Clear this check box to skip the verification process. 

 
 By default, this check box is selected, thus enabling the validation check of the imported tags 

and loops before transferring the data.  It is recommended not to clear this box to avoid import 
failure due to missing data. 

Use loop reference data — Select this check box if you want to create loop numbers and import 
loop number properties together with tag number import.  If you clear this check box, the software 
does not create any loop numbers in SmartPlant Instrumentation. 

 
 If the COMPONENT table contains empty loop reference fields, you must clear this box to 

prevent failure of the Import Utility. 
Use tag data — Select this check box to include tag number data from the Instrument Index 
module supporting tables.  This option is only available when importing data into the Instrument 
Index module.  Remember, if you select this option, you have to define the naming conventions 
for all target <units> before you start the import process. 
 

Source Tab (Link Properties Dialog Box) 
The options on the Source tab enable you to define a filtering condition which will be used to 
import data selectively according to the filtering conditions you set that can contain any 
combination of the following: 
 Source fields 
 Operators or functions 
 Alphanumeric values 

The options in this tab also enable you to further define the import source by doing the following: 
 Import data from more than one source table by associating the columns other tables or 

database files to the source table or database file.  The associated columns then 
automatically become part of the source data which you select on the Link Definitions dialog 
box. 

 Assign a process function to an instrument when importing from a database that has no such 
association. 

Source table filter 
Use filter — This option allows you to filter the source table and this way import selective data 
only. 
Selecting this check box will make the data window accessible and the Modify button available. 
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Modify — Click to open the Import Source Filter dialog box where you can define a filtering 
condition to import selective data only. 
Filter definition — Type the required filter condition in the window.  You can also define the filter 
condition in the Import Source Filter dialog box.  This filter condition will then appear in the data 
window. 

Source tables 
Associate — Select this check box to apply the defined source table associations that you 
defined in the Associating Reference Tables dialog box. 
This check box is active only when importing data into modules that require code adapting, for 
example, the Process Data module. 
Define — Click to open the Associating Reference Tables dialog box where you can associate 
additional source data to the source table that will be imported into one or more target tables. 

Process function 
Assign — Select this check box to apply the process function assignment you defined in the 
Instrument Type Description dialog box. 
Define — Click to open the Instrument Type Description dialog box where you can assign a 
process function to an instrument which has no such association. 
Use system codes — Select this check box to apply the system codes adapted from a source 
database that has system codes for its fields different from SmartPlant Instrumentation.  This 
option is available only if the source table contains fields that require system codes.  Note that 
prior to setting the import parameters, you have to select the appropriate source system in the 
Source System List dialog box and define the system codes in the Adapt System Codes dialog 
box. 
 
 

Comparison Tab (Link Properties Dialog Box) 
This tab is only available when defining properties for a link that you already used to import 
data.  The options on the Comparison tab enable you to set import comparison options.  During 
the import process, the Import Utility modifies the contents of the SmartPlant Instrumentation 
database by inserting, deleting, or updating the rows in the target tables.  Therefore, it is 
advisable to coordinate these source and target rows before you start importing the data. 

Import mode selection for comparison list 
Use these options to select the required rows in the Import Comparison List automatically. 
Apply — Applies the options in this group box that you have selected when generating the 
comparison list. 
Inserted — Allows you to select all the inserted rows in the Import Comparison List. 
Updated — Allows you to select all the updated rows in the Import Comparison List. 
Deleted — Allows you to select all the deleted rows in the Import Comparison List. 
Refreshed — Allows you to select all the refreshed rows in the Import Comparison List. 
Automatically generate comparison list report — Allows you to automatically print out or 
display the print preview of the Comparison List Report right after you click the Run button on the 
Import Comparison List dialog box. 
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Import Level Tab (Link Properties Dialog Box) 
The options on this tab allow you to import source tables defined per plant hierarchy item (for 
example, per <plant> or per <unit>) when your target domain contains more than one plant 
hierarchy item at a particular level. 
As SmartPlant Instrumentation tables are defined per plant hierarchy item, these tables contain 
data unique on a specific level.  For example, the CABLE table is defined per area; therefore, this 
table contains data unique only on the area level of the domain. 
When importing from a domain containing more than one plant hierarchy item, some of the source 
rows may recur due to the existence of several plant hierarchy items.  In this case, you can set 
your import link properties so that the Import Utility differentiates the rows of different plant 
hierarchy items, thus importing the data into the appropriate plant hierarchy items. 

Hierarchy levels 
You can also specify the plant hierarchy level when importing data into additional plant hierarchy 
item if your domain includes more than one <plant>, <area>, and <unit>. 
Apply — Enables you to select a hierarchy level.  If you do not select any hierarchy level, the 
Import Utility rejects all the recurring source rows, as it does not differentiate between the rows of 
different plant hierarchy items.  The Import Utility also rejects all the recurring rows on the plant 
hierarchy levels that is lower than your selection if you import data on the highest plant hierarchy 
levels. 
Data import level — Select the plant hierarchy level at which you want to import data, for 
example, plant, area, unit.  All recurring rows on lower hierarchy levels will be rejected. 
Import unit data using 
 Unit number — Allows you to use the unit number data column as the key for importing data. 
 Unit name — Allows you to use the unit name data column as the key for importing data. 

Specify target projects in link — Allows you to import data into several project at a time if the 
current domain type is Owner operator.  In the Import Link window, if your import method is 
Single table, when defining target table definition, you must provide the table definition for the 
ENGINEER NAME/ENG PROJ ID field in the Target Name column; if your import method is 
Module (multiple tables), when defining target table definition, you must provide the table 
definition for the Engineering Project Name field in the Target Name column.  Also, make sure 
you define the correct hierarchy levels for data import. 
 
 

Specs Tab (Link Properties Dialog Box) 
This tab is only available when the import link is defined for the SPEC_SHEET_DATA table or 
Specifications module.  The options on the Specs tab allow you to set various options for 
importing specifications.  You select the required SmartPlant Instrumentation specification form, 
set document number defaults, and define the link for multi-tag specification format if needed. 
Specification item type (only available when the link is assigned to the Single table import 
method) — Allows you to specify the target item type. 

Specification module 
Specification form — Allows you to select the target specification form from the list. 
Preview — Displays the preview of the selected specification form. 
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Specification sheet option 
Use custom drawing name — Allows you to import spec document numbers from the 
source.  You can then map the Spec Drawing Name field in the Import Link window (in the 
Source Name field of the Target data window).  Document numbers in the import source must be 
unique for each instrument.  If you clear this check box, the Import Utility creates specs with 
default document numbers. 
Include revisions in import — Allows you to import spec revisions from the source.  You can 
then map the Spec Revision No field in the Import Link window (in the Source Name field of the 
Target data window).  If you clear this check box, you cannot import any specification revision 
data using the current import link. 
Use custom drawing name for process data — Allows you to import source document numbers 
for process data sheets.  You can then map the Process Data Drawing Name field in the Import 
Link window (in the Source Name field of the Target data window).  Document numbers in the 
import source must be unique for each instrument.  Even if the target spec form does not contain 
fields from process data tables and you do not import any process data value with the spec, the 
Import Utility creates an empty process data sheet in SmartPlant Instrumentation and associates it 
with the instrument for which you created the spec.  If you clear this check box, if you import any 
process data value, when creating a spec, the Import Utility also creates a process data sheet and 
assigns a default document number to the process data sheet. 

Multiple-item specification format 
Import to multiple-item specification sheet — Select this check box to import all the SEE LIST 
data associated with the source tags.  This option is available only if the specification form you 
selected is a multi-tag form.  Selecting this check box makes the options in Multi-item spec 
format group box active. 
Specification format — Select the required multi-tag format for the current link.  You will not be 
able to change this definition when importing data to a module in the Import Link window.  Note 
that this dialog box is only available if you have selected the Multiple-item spec check box. 
Enable all formats for selection in link — Select this check box to select all the available 
multi-tag format for the current link.  This will let you select the required multi-tag spec format in 
the Import to Module dialog box.  Note that the format displayed in the list box will not affect the 
parameter settings if this check box is selected. 
 
 

Custom Fields Tab (Link Properties Dialog Box) 
The options on this tab allow you to define a link that will contain only Browser module custom 
fields as the target fields.  These custom fields are those fields that used in the browser view style 
that you select on the Custom Fields tab.  As a result, the Import Link window will display only 
the Browser module custom fields in its Target section. 
The options on this tab are only available when the import link is defined for the Instrument Index 
module or Process Data – Line module. 

 Prior to setting these properties, you have to create the required custom browser view 
styles in the Browser Manager in SmartPlant Instrumentation. 

Select style for custom name 
Line — Select the required custom browser view style for the line from this list. 
Use style for line — Select this check box to use the selected line style in the import process. 
Equipment — Select the required custom browser view style for equipment from this list. 
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Use style for equipment — Select this check box to use the selected equipment style in the 
import process. 
Loop — Select the required custom browser view style for the loop from this list. 
Use style for loop — Select this check box to use the selected loop style in the import process. 

Select dimensional group for custom name 
From the list, select Computed group name to use the custom fields from the dimensional group 
associated with the tag number as a source of custom data.  A dimensional group is associated 
with a tag number if the tag number has a profile that includes a dimensional group 
definition.  Selecting All Groups allows you to type in the import link as the source the name of 
any dimensional group for which you want to use the custom fields. 
Apply — Select this check box to enable the selection of an option from the list.  The software 
clears this check box automatically when you select All groups from the list. 
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Style Tab (Link Properties Dialog Box) 
The options on the Style tab allow you to control what fields are displayed in the Import Link 
window if you are defining a link where data will be inserted into reference tables.  When creating 
a link using the Single table import method, and also include reference tables in the link, you can 
select an existing browser view that determines which fields are displayed in the Import Link 
window when you open the link.  If there is no browser view that satisfies the needs of the current 
import session, create a browser view in the Browse Manager in SmartPlant Instrumentation. 
When creating a link using the Module (multiple tables) method, only the Display all fields 
check box is available.  You can select this check box to display all the fields of the target module 
tables and not just the fields contained in a special hard-coded list that limits the field list that 
appears in the Import Link window.  This special list serves two purposes: 
To shorten the field list displayed in the Import Link window. 
 To display engineering field names instead of the names used in the database. 

Display all fields — The check box selection functions according to the import method assigned 
to the link: 
 When a link is assigned to the Single table import method, and also includes reference 

tables, the software disables browser view selection options.  When you open the link in the 
Import Link window, the software displays all the fields that the target reference tables contain. 

 When a link is assigned to the Module (multiple tables) method, and you selected any 
module apart from the Specifications module, the software adds the fields to the Import Link 
window that are not included in the special hard-coded list so that all target module table 
columns are displayed.  In the Import Link window, the filed names appear as they are in the 
database if they are not included in the special list.  The fields that are included in the special 
list display meaningful engineering names. 

Browser views 

(Only available when using the Single table import method, provided that you also included 
reference tables in the link) 
The data window displays all the existing browser views. 
Style Preview — Displays the field list defined in the selected browser view.  This opens the 
Style Preview dialog box where the fields selected the browser view are displayed in red.  The 
View check box is selected next to the field names that will be displayed in the Import Link 
window. 
Clear — Clears the browser view selection.  In this case, the Import Utility does not use any 
browser view style but displays all the reference table columns in the Import Link window. 
Select View — Applies the current style settings for the current link. 
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Multi-Form Tab (Link Properties Dialog Box) 
This tab is only available when you assigned the import link to the Module (multiple tables) 
method and selected Multiple Spec Forms as the module name.  The options on the Multi- 
Form tab allow you to select an existing multi-form browser for importing data to fields used in 
various spec forms according to the field headers that the browser contains.  You must first define 
multi-form browsers in the Specifications module.  For details, see Define a Multi-Form Browser. 

Select multi-form browser 
Displays all the existing multi-form browser names and allows you to select a specific browser as 
a target for importing data into spec form fields.  When you open the link in the Import Link 
window, in the Target pane, the software displays the form field headers under Target Name and 
the form field names under Column Name.  After you select a browser, the software saves your 
selection for the current link.  When you reopen the Multi-Form tab, the browser assigned to the 
current link remains selected. 
Browser — Displays the multi-browser field name as defined in the Specifications module. 
Description — Displays the multi-form browser description as defined in the Specifications 
module. 
 
 

Target Table Definition 
Every table in SmartPlant Instrumentation has at least one definition that you can use when 
importing or comparing data.  When you open a link in the Import Link window, all the displayed 
columns appear in the table definition that is set as the active definition.  By default, every table 
has its own active definition called Default.  You can set any other user-defined or shipped 
definition as the active definition instead of the Default definition.  You manage table definitions 
using the Target Table Definition dialog box options.  Your working area, where you create or 
modify key definitions, is the Key definition pane; a complete definition appears in the Column 
definition pane, where each column is indicated with a designated color.  For details, see Target 
Column Colors (on page 46). 

 
 Changing the settings in the Target Table Definition dialog box alters the relations between 

the tables.  We therefore recommend you do not change these settings unless absolutely 
necessary and only if you are familiar with the SmartPlant Instrumentation database structure. 

When importing data using the Comparison List options, table definitions allow you to control the 
way in which the Import Utility regards the source and the target rows as identical during the 
import process.  This is important, because when the Import Utility encounters identical source 
and target rows, it can overwrite the target row or leave it intact, depending on the Comparison 
options which you select on the Link Properties dialog box.  You can therefore control the import 
process result by selecting the appropriate import comparison criteria. 
In SmartPlant Instrumentation, the database is organized in tables, for example, CABLE, 
COMPONENT, CONTROL_VALVE, and so forth.  These tables contain data arranged in table 
columns, which represent properties of various items such as instruments, cables, panels, and so 
forth.  For example, the COMPONENT table contains all the instrument tag data together with the 
appropriate links to other tables that are contain instrument properties, such as 
COMPONENT_MFR (instrument manufacturer table), COMPONENT_MOD (instrument model 
table), and so forth. 
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Every SmartPlant Instrumentation table is defined at a specific plant hierarchy level.  This means 
that the value of the primary key column of that table is unique at the specified level.  For 
example, CMPNT_NAME is a primary key in the COMPONENT table.  If you define the 
COMPONENT table at the <unit> level, the CMPNT_NAME value becomes unique at the <unit> 
level.  This means that at the <unit> level, there cannot be more than one row with the same value 
in the CMPNT_NAME column.  In the following example, the COMPONENT table primary key is 
CMPNT_ID, which holds database ID numbers of instrument tags.  Each row in the 
COMPONENT table has a unique value at the <unit> level for the CPMNT_ID column. 
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The CABLE_MFR_MOD table key definition consists of the CABLE_MFR_ID and CABLE_ 
MOD_ID keys.  These keys ensure that the value of any particular cable model is unique.  Both 
keys are required because different manufacturers may use the same model number, and 
therefore the manufacturer name must be included to specify model uniqueness, as shown in the 
following example. 

 
Every SmartPlant Instrumentation table has a key definition, which is used to specify a unique set 
of values.  You can use one or more table columns in each table as constituents of the key 
definition. 
Key name — Appears in every table and is used only by SmartPlant Instrumentation to access 
the corresponding table.  The key name column is usually denoted by an _ID suffix.  In most 
cases, the key name is designated as a primary key. 
Reference table column — Appears in every table and is used by the user to access the 
table.  For the COMPONENT table, the reference column is CMPNT_NAME.  This means that 
each row in the COMPONENT table has a different value in the CPMNT_NAME column.  You can 
select an appropriate reference table column for every table in the database.  This way you can 
create a different comparison criteria for each table. 
Foreign key — In some tables, the key name is designated as a foreign key, which is used as a 
reference column to link to another table called a reference table.  For example, the 
CPMNT_MFR_ID foreign key in the COMPONENT table contains the COMPONENT_MFR table 
value in its key definition.  This way, the CPMNT_MFR foreign key column links the 
COMPONENT table to the COMPONENT_MFR table.  This allows SmartPlant Instrumentation to 
obtain the required instrument manufacturer data from the COMPONENT_MFR table.  You can 
create a link to other tables by defining appropriate foreign keys.  This way the Import Utility 
imports additional reference data during the import process, depending on the selection you make 
on the Source tab of the Link Properties dialog box. 
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Regular column — Appears in most tables and contains the appropriate table data such as 
display color, item price, remarks, specifications, and so forth. 

 
 Both the key name and the reference table column provide access to the SmartPlant 

Instrumentation database, but only the reference table column is accessible to you (the key 
name is for SmartPlant Instrumentation internal use only). 

 When comparing rows, the Import Utility treats source and target rows as identical only if both 
the source and the target reference table column values are the same.  For example, if the 
COMPONENT table in both source and target rows contains the same values in the reference 
table column data fields, both rows are considered as identical. 

 When the Import Utility encounters identical source and target rows it can either replace the 
contents of the target row with the source row contents or leave this target row intact, 
depending on the import process settings. 

 

Target Column Colors 
Table columns appear in the Column definition pane in four possible colors: 
 Red — Primary key (must be defined) 
 Blue — Foreign key 
 Black — Regular column in the target table 
 Magenta — Reference table column which is defined as a regular table column (for example, 

not used to get linked data) 
 
 

Key Numbering System 
The software uses three numbering systems: 

Global numbering system 
When this system is used, the selected key number originates from a general number list that 
applies to the entire system. 

Local numbering system 
When this system is used, the selected key is numbered within a table.  A primary key and a 
foreign key may contain more than one column.  For example, the CABLE table primary key can 
contain both CABLE_ID and CABLE_NUM columns.  Each key is numbered in the table.  If a key 
contains more than one column, each column is numbered in the key.  If CABLE_ID and 
CABLE_NUM are the columns comprising the CABLE table primary key, then each column has a 
serial number within the CABLE table primary key, for example, 1 and 2.  The PANEL_STRIP 
table primary key also consists of two columns: 
 PANEL_NAME, which originates from the PANEL table and is numbered globally 
 STRIP_NAME, which is numbered locally 

Therefore, in every new panel, the terminal strip numbering restarts from 1, whereas the panel 
numbering continues the global numbering. 

Local revision numbering system 
This is a local numbering method which starts from zero instead of from one. 
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Reference Key Definition 
In the Key definition working area, selecting a value for the Reference Key table column is not 
required if the current key is a not a foreign key.  When the current key is a foreign key, the 
following two situations are possible: 
 The value in the Reference Key data column is the same as the one specified under Key 

Name; in this case the Reference Key data column is left empty, as in the following example: 
If using the CABLE_MOD_ID from the CABLE table in the key definition, the key name 
CABLE_ID is identical to the reference key. 

 The value in the Reference Key data column is different from the one specified under Key 
Name; in this case the appropriate value appears under the Reference Key data column, and 
the column title Reference Key is displayed in bold text, as in the following example: 
If using the CONNECTOR_SIDE1_ID from the CABLE table in the key definition, the key 
name CABLE_ID is different from the reference key, the value of which in this case is 
CONNECTOR_ID. 

 
 

Changing the Target Column Type 
You can change the target table column type, for example, from char to number and vice 
versa.  This is required if the source table column and the target table column are of different 
types; for example, one table column is defined as char and the other is defined as number.  In 
this case, you can change the column type of the target table into char by defining it as a foreign 
key or change the table column type into number by deleting this column key definition.  See 
Delete Key Definitions of a Specific Table (on page 52) to learn how to delete the column key 
definition. 
 
 

Key Levels 
The key level operation is designated for tables that contain terminal strip data, such as 
PANEL_STRIP, STRIP_CONFIG, STRIP_MFR, and so forth.  You can specify what fields the 
Import Utility creates during the import process prior to generating a selected target column.  You 
do this by activating the key level option and specifying the required target field to create prior to 
generating the selected target field. 

Example 
The STRIP_MFR_MOD table primary key contains two columns: STRIP_MFR_ID and 
STRIP_MOD_NAME. 
To generate the STRIP_MOD_NAME column, the Import Utility will create the STRIP_MFR_ID 
and the STRIP_MOD_ID columns prior to generating the STRIP_MOD_NAME column. 
If you select Define parameters for key levels, in the Column definition pane, the Import Utility 
automatically creates the fields which you specify under Key Level prior to generating the 
corresponding table column under Column Name. 
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Table Definitions Common Tasks 
The following tasks are used when you need to modify a table column definition specified for a 
particular table. 

Create a Table Definition on the Basis of Another Definition 
Use this procedure to create a new table definition on the basis of an existing definition.  For more 
information, see Create a Table Definition on the Basis of Another Definition (on page 48). 

Set a Definition as the Active Definition 
Use this procedure to set an existing table definition as the active definition for that table.  In the 
Import Link window, the software only displays table columns that exist in the table definition set 
as the active definition.  By default, every table has its own active definition called Default.  For 
more information, see Set a Definition as the Active Definition (on page 49). 

Modify a Table Definition 
Use this procedure to modify the table column definitions in the target database. 

  The software does not validate whether your table definition is correct.  Importing 
wiring data using incorrect table definitions or altering default definitions might result in severe 
data integrity problems in SmartPlant Instrumentation. 
For more information, see Modify a Table Definition (on page 49). 

Rename a Table Definition 
Use this procedure to rename an existing table definition.  For more information, see Rename a 
Table Definition (on page 51). 

Delete Key Definitions of a Specific Table 
Use this procedure to delete column key definitions for a given table.  For more information, see 
Delete Key Definitions of a Specific Table (see "Delete a Table Definition" on page 52). 

Delete a Table Definition 
Use this procedure to delete a table definition.  For more information, see Delete a Table 
Definition (see "Delete Key Definitions of a Specific Table" on page 52). 
 
 

Create a Table Definition on the Basis of Another Definition 
1. On the Target Table Definition dialog box, for the target table, click Definition. 
2. On the Table Definition Name dialog box, select a definition that you want to use as a source 

for creating a new definition. 
3. Click OK. 
4. When prompted to view the definition, click Yes. 
5. Make the changes that you require.  For details, see Modify a Table Definition (on page 49). 
6. Click Clear to clear the Key definition working area. 
7. Click Save As. 
8. On the Definition Names dialog box, do the following: 
9. Click Insert. 
10. Click the new row and type a unique name. 
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11. Click OK. 
12. On the Target Table Definition dialog box, click Close. 
13. If prompted to set the new definition as the active definition, do one of the following: 

 Click Yes to and set this definition as the definition that is used in the Import Link window. 
 Click No to leave the new definition in the list of the definitions assigned to the current 

import link. 
  The software prompts you to set the new definition as the active definition instead of the 

existing one if you opened the Table Definitions dialog box from the Link Properties dialog box. 
 
 

Set a Definition as the Active Definition 
1. On the Target Table Definition dialog box, for the target table, click Definition. 
2. On the Table Definition Name dialog box, select a definition that you want to set as active 

and use in the Import Link window instead of the current active definition. 
3. Click OK. 
4. When prompted to view the definition, click No. 
5. When prompted to set the selected definition as the active definition instead of the existing 

one, click Yes. 
 
 

Modify a Table Definition 
1. Do one of the following: 

 On the menu bar, click Service > Target Table Definition. 
 On the Link Properties dialog box, click Table Definition. 

2. On the Target Table Definition dialog box, under Table List, select the table whose column 
definitions you want to modify. 

 
 The automatically selected option button beneath the Table List pane indicates the plant 

hierarchy level of the table in the target domain. 
 If you open the Table Definition dialog box from the Link Properties dialog box, you can 

only modify the definition for the source tables to which the import link is assigned. 
3. Click Definition. 
4. On the Definition Names dialog box, do one of the following: 

 In the Description data window, select an existing definition. 
 Click Insert to add a new definition in the Description data window and then click Edit to 

type the new definition name. 

 
 For each table there is one shipped definition called Default.  You can use the 

Default definition as a basis for creating new definitions.  We recommend that you do 
not modify the Default definition itself. 
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 For certain tables, apart from the Default definition, there is a number of other 
shipped definitions.  You must select a definition that is appropriate for the type of 
association of the items that you are going to import.  For example, when importing 
terminal strips, several definitions exist for the PANEL_STRIP table because you 
might have some panels with direct connections to strips, and other panels that 
include items above the strip, such as a panel–rack–wiring equipment–strip 
association.  In this case, you need to create several import links, each with an 
appropriate definition for the desired association. 

5. Click OK to return to the Table Definition dialog box. 
6. In the Column Definition section, do the following: 

a. Select Visible for each column you want to display in the Import Link window. 
b. Select Default for each column to import the default value (space, zero or asterisk) 

whenever the column value is not defined. 
 For some columns, for example, primary keys, the Import Utility automatically 

clears the Visible check box.  To avoid import failure, we recommend that you do not make 
these table columns visible. 

7. To set the type of the table column selected under Key Definition, do one of the following: 
 Accept the displayed key definition. 
 Select Primary key to use this column as a primary key. 
 Select Foreign key to use this column as a foreign key. 

 Selecting Foreign key opens the Foreign Key List pop-up window.  If you do not 
intend to modify the foreign key definition, close the Foreign Key List pop-up window. 

8. If you need to modify the definition of a foreign key, from the Foreign Key List pop-up 
window, drag the appropriate foreign key to the Key definition working area . 

9. To link the selected table column to a reference table, do the following: 
a. From the Reference Table list, select the appropriate reference table. 
b. From the Reference Column list, select the appropriate primary key. 

 
 If the current key is a foreign key, the value under Reference Column is a column 

name in the reference table specified under Reference Table. 
 If the current key is not a foreign key, the value under Reference Column is a column 

name in the current table. 
10. From the Reference Key list, do one of the following: 

 Accept the given default values (recommended). 
 Select the appropriate reference key if required. 

11. To determine the way the current key will be numbered in the target database (note that this is 
an internal value which is not accessible to you), do one of the following: 
 Select the Local check box to follow the previous- level numbering to make the currently 

defined table column address unique in the target database. 
 Clear the Local check box to follow the global numbering in SmartPlant Instrumentation. 

12. To modify the definition of the additional column of the current table, do the following: 
a. Drag the appropriate table columns from the Column definition pane to the Key 

definition working area. 
b. If needed, select Define parameters for Level Key to specify the columns for automatic 

creating during the import process.  This way, in the Column definition pane, the Import 
Utility creates the table columns specified under Level Key before creating the 
corresponding table columns under Column Name. 
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c. In the Column definition pane, click  to display the Level Key fields. 
d. Under Level Key, do one of the following: 

 Type the names of the table columns to be created by the Import Utility during the 
import process before it creates the corresponding table columns under Column 
Name. 

 Clear Define parameters for Level Key to discard the table columns specified under 
Level Key. 

13. Click Apply. 
14. When prompted, click Yes to confirm the changes and clear the Key definition working area. 
15. Click Save to save your selection of table keys. 
16. Click Close to close the Table Definition dialog box. 

See Also 
Import Wiring Connection Data (on page 111) 
 

Rename a Table Definition 
1. On the Target Table Definition dialog box, for the target table, click Definition. 
2. On the Table Definition Name dialog box, select a definition that you want to rename. 

 You cannot rename the Default definition. 
3. Click OK. 
4. When prompted to view the definition, click Yes. 
5. Make the changes that you require.  For details, see Modify a Table Definition (on page 49). 
6. Click Clear to clear the Key definition working area. 
7. Click Save As. 
8. On the Definition Names dialog box, click the definition name and then type a unique name 

instead of the existing one. 
9. Click OK to close the Definition Names dialog box. 
10. On the Target Table Definition dialog box, click Close. 
11. If prompted to set the renamed definition as the active definition, do one of the following: 

 Click Yes to and set this definition as the definition that is used in the Import Link window. 
 Click No to leave the renamed definition in the list of the definitions assigned to the current 

import link. 
  The software prompts you to set another definition as the active definition instead of the 

existing one if you opened the Table Definitions dialog box from the Link Properties dialog 
box. 
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Delete Key Definitions of a Specific Table 
1. On the Target Table Definition dialog box, under Table list, select the table whose key 

definitions you want to delete. 
2. Click Definition. 
3. In the Definition Names dialog box, under Description, select the definition. 
4. Click OK to display the columns of the selected table in the Table list pane. 

  The appropriate table columns appear in the Column definition pane.  The 
comparison definition also appears in the Key definition working area. 

5. Click Delete Key to delete all the key definitions of the selected table. 
6. When prompted, click Yes to confirm the deletion and clear the Key definition working area. 
7. Click Save. 
8. Click Close. 
 
 

Delete a Table Definition 
1. On the Target Table Definition dialog box, under Table list, select the table whose definition 

you want to delete. 
2. Click Definition. 
3. On the Definition Names dialog box, select the definition you want to delete. 
4. Click Delete. 

  You can select and delete one definition at a time. 
5. When prompted, click Yes to confirm the deletion. 
6. Click OK. 
7. On the Target Table Definition dialog box, click Save. 
8. Click Close. 
 
 

Working with Log Files 
A log file allows you to keep track of all your import operations.  Log files carry all the information 
about your import activities.  When you first start the Import Utility, you will create your first log 
file.  It will keep growing as you continue importing data unless you decide to change the current 
log file.  The information in the log file is organized in an ascending chronological order.  This 
information includes: 
 The domain details. 
 The source and target details (the source table/file name; the target table/module name). 
 Rejected data rows details (if there are any). 
 The import results (the number of total rows, inserted, updated, and rejected rows). 

  You can perform the import process without a log file but it is not advisable, as you will not 
have a record of the import execution.  If you start the Import Utility with no log file defined, you will 
get a message after you select the target <unit> in the Open dialog box. 
You can create a new log file, open an existing log file, delete a log file, view a log file, check the 
name of the current log file, or close the current log file. 
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Working with Log Files Common Tasks 
The following tasks are used when you work with log files. 

Create a New Log File 
This procedure shows you how to create a log file.  It is advisable to create a new log file each 
time you perform an important import operation.  You should also create a new log file if your 
existing log file has become too long. 
For more information, see Create a New Log File (on page 54). 

Open an Existing Log File 
This procedure shows you how to open an existing log file.  It is advisable to open a log file before 
you perform an import procedure so that you have a record of the import process. 
For more information, see Open an Existing Log File (on page 54). 

View the Current Log File 
You can view the current log file to review the previous import process information.  You can also 
view any other existing log file. 
For more information, see View the Current Log File (on page 54). 

Check the Name of the Current Log File 
This procedure shows you how to check the name of current log in use. 
For more information, see Check the Name of the Current Log File (on page 54). 

Close the Current Log File 
You can also import data without a log file.  If you choose to do this and there is a current log file, 
you can close it. 
For more information, see Close the Current Log File (on page 55). 

Delete an Existing Log File 
You can delete a log file when the information in it becomes unimportant. 

  This action deletes the selected log file from your hard disk. 
For more information, see Delete an Existing Log File (on page 55). 

Log the Import Parameters 
This procedure shows you how to log the import parameters which you use in the current import 
process. 
For more information, see Log the Import Parameters (on page 55). 
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Create a New Log File 
1. Click Log File > New. 
2. In the New Log File dialog box, type the name of your new log file, select the required path 

and click OK. 
 The Import Utility opens a new (empty) log file automatically, even though you do not see it. 

  
 

Open an Existing Log File 
1. Click Log > Open. 
2. In the Open Log File dialog box, select the name of the log file you want to open and click OK. 

 After you create a new log file or open an existing one, it stays open even though you do 
not see it displayed.  The log file remains active until you close the Import Utility.  When you exit 
the Import Utility, the log file closes automatically and reopens when you restart the Import 
Utility.  See Close the Current Log File (on page 55) to learn how to close the current log file 
manually. 
  
 

View the Current Log File 
 Do one of the following: 

 Click . 
 Click Log > View. 
 The current log file is opened for viewing by Notepad.  SmartPlant Instrumentation uses 

Notepad to view the log file.  However, Notepad is limited by file size that it can handle.  If your 
log file becomes too large for Notepad, you will get an appropriate message.  In this case you can 
view your log file using Windows Write or another appropriate utility. 
  
 

Check the Name of the Current Log File 
On the Log File menu, click Log File Name. 

  The Import Utility shows you a message where it states the path and filename of your 
current log file.. 
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Close the Current Log File 
On the Log File menu, click Close. 

  The Import Utility immediately closes the current log file.  After you close the current log 
file you need to define a new log file to resume tracking the import process.  For details, see 
Create a New Log File (on page 54). 
 
 

Delete an Existing Log File 
1. Click Log File > Delete. 
2. In the Open Log File Name dialog box, select the name of the log file you want to delete and 

click OK. 
  
 

Log the Import Parameters 
Click Log > Show Link Parameters. 

 
 The Show Link Parameters command remains checked on the Log File menu.  Click 

the command again if you need to clear this option. 
 After you run the import process, a section named Link Parameters is added in the 

current log file, where you see the import parameters used in this import process. 
 
 

Viewing the Source Data 
It is possible to view the contents of the source table or database file specified for a particular 
import link.  You can view source data from any of the following locations in the Import Utility: 
 Link Definitions dialog box, after selecting the source data 
 Import Source Filter dialog box 
 Import Link window 

 
 

Working with Source Data 
The following tasks are used when you working with the source table or database file. 

View the Source Data 
Use this procedure to view the contents of the source table or database file that you selected when 
entering the Import Utility.  For more information, see View the Source Data (on page 56). 

Select the Desired Viewing Option 
Use this procedure to select viewing options for your data source.  The following viewing options 
are available: 
 Viewing all source data fields. 
 Viewing only linked source data fields. 
 Viewing only selected source data fields. 
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For more information, see Select the Desired Viewing Option (on page 56). 

Filter the Displayed Source Data Fields 
Use this procedure to filter the source data displayed in the Source Data section according to the 
filtering condition you defined on the Source tab of the Link Properties dialog box.  To use this 
option, you must define a filtering condition.  For more information, see Filter the Displayed 
Source Data Fields (on page 57). 

Sort the Displayed Source Data Fields 
Use this procedure to perform an alphanumeric ascending sorting of the information displayed in 
the Source Data window according to one or more selected data fields.  For more information, 
see Sort the Displayed Source Data Fields (on page 57). 

Associate Additional Source Data 
Use this procedure to import additional data and associate it to the source table that you selected 
on the Link Definitions dialog box.  This way you can import data into your database from more 
than one source table.  You do this by associating columns from other tables or database files 
with the source table or database file.  The associated columns automatically become a part of 
the source data which you have selected on the Link Definitions dialog box. 

  You can use associations which have been previously saved in a link.  To do this you 
have to start the import process using a previously saved link. 
For more information, see Associate Additional Source Data (on page 57). 
 
 

View the Source Data 
Do one of the following to display the Source Data window: 

 In the Import Link window, click . 
 On the Link Definitions or Import Source Filter dialog box, click View Source. 

 
 

Select the Desired Viewing Option 
1. With the Source Data window open, do one of the following: 

 To view all the source data fields, click Show > All. 
 To view only the fields of the displayed source data which are linked to other tables or to 

the database, click Show > Linked fields. 
 You can view linked data fields only if you have already defined the links between the 

source and the target data fields in the Import Link window or if you have already used the 
definitions of a previously saved link. 

2. To view selected source data fields, do the following: 
a. Click Show > Select Fields. 
b. On the Display Source Columns dialog box, drag the data fields you want to view from 

the Source Columns pane to the Selected Columns pane. 
3. Click OK. 
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Filter the Displayed Source Data Fields 
 With the Source Data window open, do one of the following: 

 On the Filter menu, click On to filter the displayed source data according to the filtering 
condition you previously defined. 

 On the Filter menu, click Off to display the source data without filtering it. 
 
 

Sort the Displayed Source Data Fields 
1. With the Source Data window open, click Sort > Custom Set. 
2. In the Display Source Fields dialog box, drag the data fields by which you want to sort the 

displayed source data from Source Fields to Selected Fields. 
3. Click OK. 

 Sorting the source data in this dialog box does not affect the import results. 
  
 

Associate Additional Source Data 
1. Select the desired link and click . 
2. In the Link Properties dialog box, click the Source tab. 
3. Under Source tables, click Define. 
4. In the Associate Source Data dialog box, click Add to add a data set (for example, a table or 

a database file) to the Source list data window. 
5. Repeat the previous step to add as many data sets as required. 

 It is possible to use the same table more than once as a source. 
6. Highlight the desired data set to associate to and under the Association group box, click 

Select.  The selected data set is copied to the Source for association data window. 
7. Expand the data sets as desired in each data window by double-clicking them, then drag the 

required item in that data set to the appropriate data set item in the Source for association 
data window.  

The association between the two data items is indicated by the appearance of an icon ( ) to 
the right of each data item in the appropriate section. 

 In SmartPlant Instrumentation, table columns contain numbers (num type 
columns) and characters (char type column).  You cannot associate a num type column with 
a char type column or the other way around. 

8. Repeat the previous step to associate other data items as desired. 

 
 You can associate several items with a single data set item, however, you cannot 

associate data from a data set with itself. 
 To delete an association, select the desired item in the Source for association data 

window and press Delete on the keyboard. 
9. Click Verify to make sure your selections are valid (this way you can check, for example, 

whether the associated table columns are both of the same data type - numeric or 
alphanumeric).  
An appropriate message is displayed: if the associations are valid, the total number of rows of 
the source data set (including the associated data) is indicated, or else you are notified that 
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the associations are invalid, in which case you should correct your selection in the Source 
Associations dialog box. 

10. Click Confirm. 
11. When prompted, click Yes to save your associations.  

The data sets disappear from the right data window and appear at the top of the left data 
window. 

12. To make the fields of the associated data appear in future dialog boxes, do the following: 
a. Expand the associated data sets by double-clicking them. 
b. Click once on every item you want to view. 
The icons appear as follows: 

Item selected:  

Item not selected:  
 You can view the contents of an associated data item in the Import Link window.  To be 

able to view the associated data, click  when available, after you select the required 
table.  For further details, see Viewing the Source Data (on page 55). 

 Make sure you remove all disassociated tables from the data windows in the 
Source Associations dialog box before you click Save. 

13. Click Save to save your association. 
14. In the Link Properties dialog box, under Source Associations, do one of the following: 

 Select Apply to use your associations in the current import process. 
 Clear Apply to skip the defined associations. 

  
 

Built-In Operators and Functions 
Operator / 
Function 

Description Example 

= Equal to cpmnt_mfr = 'Shell' 

> Greater than cmpnt_num > 101 

< Less than item_price < 100 

>= Greater or equal to cmpnt_num >= 10 
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Operator / 
Function 

Description Example 

=< Less than or equal to item_price =< 30 

<> Not equal to suffix <> 'AA' 

AND Include the following 
expression in the filter 
combination 

(name <> '') AND 
(num <> 0) 

OR Accept either the 
previous or the following 
expression in the filter 
combination 

(loop = '') OR (line = '')

NOT Select the value opposite 
to the following 
expression 

NOT (item_price = 0) 

LIKE[value] Select a similar value that 
is similar to the one in the 
[value] field.  You can 
use the following 
wildcard characters: % – 
any combination of 
characters. _ – any single 
character. 

cmpnt_num LIKE 
'%AA%' 

IN Select a value that is 
equal to one of those 
specified in the 
parentheses 

cpmnt_num = IN 
(101,103) 

BETWEEN Select a value which is 
within the following 
interval 

item_price 
BETWEEN 100 AND 
500 

IS NULL Contains an undefined 
value 

loop_name IS NULL 

IS NOT NULL Not equal to NULL cpmnt_name IS NOT 
NULL 
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SQL Functions Native to the Source Database 
The SQL Functions select list enables the use of special functions which are native to the source 
database.  The following functions are the most common ones: 

SQL Function and Source 
Databases 

Description Syntax and Output Example 

LTRIM (<value>)dBase Sybase 
Adaptive Server Anywhere 10.0, 
Oracle, SQL Server 

Removes all leading 
spaces in the field 
indicated in the 
parentheses. 

LTRIM(cmpnt_mfr) cmpnt_mfr = ' 
Shell' LTRIM(cmpnt_mfr)='Shell' 

RTRIM(<value>) dBase Sybase 
Adaptive Server Anywhere 10.0, 
Oracle, SQL Server 

Removes all trailing 
spaces in the field 
indicated in the 
parentheses. 

RTRIM(cmpnt_num) IS NULL 
cmpnt_num =  
'108-FT 100' 
RTRIM(cmpnt_num)='108-FT 
100' 

SUBSTRING(<value>,<begin>,
<count>)dBase Sybase Adaptive 
Server Anywhere 10.0, Oracle 

Retrieves a part of the 
field indicated in the 
<value> data field from 
the <begin> position for 
the number of 
characters indicated in 
the <count> field. 

SUBSTRING(cmpnt_mfr,1,4) 
cmpnt_mfr = 'Shell' 
SUBSTRING(cmpnt_mfr,1,4)='Sh
el' 

SUBSTR(<value>,<begin>,<co
unt>)SQL Server 

Retrieves a part of the 
field indicated in the 
<value> data field from 
the <begin> position for 
the number of 
characters indicated in 
the <count> field. 

SUBSTR (cmpnt_mfr,1,4) 
cmpnt_mfr = 'Shell' 
SUBSTR(cmpnt_mfr,1,4)='Shel' 

UCASE(<value>)dBase Sybase 
Adaptive Server Anywhere 10.0 

The upper case format 
of the contents of the 
field indicated in the 
<value> data field. 

UCASE(cpmnt_name) 
cmpnt_name = '101-aa' 
UCASE(cmpnt_name)='101-AA' 

UPPER(<value>)Sybase 
Adaptive Server Anywhere 10.0, 
Oracle, SQL Server 

The upper case format 
of the contents of the 
field indicated in the 
<value> data field. 

UPPER(cpmnt_name) 
cmpnt_name = '101-aa' 
UPPER(cmpnt_name)='101-AA 

LCASE(<value>)dBase Sybase 
Adaptive Server Anywhere 10.0 

The lower case format of 
the contents of the field 
indicated in the <value> 
data field. 

LCASE(loop_name) loop_name = 
'101- AA' 
LCASE(loop_name)='101-aa 

LOWER(<value>)Oracle, SQL 
Server 

The lower case format of 
the contents of the field 
indicated in the <value> 
data field. 

LOWER(loop_name) loop_name 
= '101- AA' 
LOWER(loop_name)='101-aa 
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Mapping Import Links (Primary Keys and Primary 
Values) 

Each SmartPlant Instrumentation table contains a primary key data field, which, like the primary 
key table column, is used as a prime key for accessing the table data.  The difference between 
the primary key table column and the primary key data field is that you can only access the latter, 
whereas the primary key table column is an internal database key used by SmartPlant 
Instrumentation only. 
Example: 
The COMPONENT table contains a primary key table column, CMPNT_ID, which is an internal 
SmartPlant Instrumentation database key, and a primary key CMPNT_NAME, which contains the 
tag number. 
If you import data using the Single table method you can: 
 Allow the Import Utility to generate the primary key data field automatically according to the 

naming conventions that you will enter; to do this you will need to manually define appropriate 
naming conventions for both the tag and the loop.  This way, the primary key data field will 
contain the value Computed which means that its contents have been predetermined by the 
Import Utility, based on the naming conventions you entered. 

 Use the naming conventions in the link; this way you will need to manually create the primary 
key data field contents and naming conventions by specifying the appropriate parts (for 
example, PREFIX, SUFFIX).  This way, you define the value of all the target data fields that 
you require either by typing in the appropriate value in the target data field, or by selecting the 
appropriate source table column and linking it to the desired target data field. 

  If you select to import data using the Single table method you must define the links of all 
primary key data fields.  If you have selected to import data using the Module (multiple tables) 
method, you do not need to define the links to all the primary key data fields, because it is possible 
to limit the import of data only into certain target tables. 
At this stage you can also:: 
 Make a more precise selection by selecting the required source and target rows which will be 

processed during the import process. 
 Select the reference tables you want to import. 
 Save the current link to be used in future import sessions. 
 View the source rows. 
 Perform a test run to evaluate the import process results. 
 Carry out the import process. 

After you map all the desired source and target data you can make a more precise selection.  You 
do this by selecting the source and target rows to be inserted updated or deleted during the import 
process. 
When you finish defining the mapping between the target and the source, you will come to the end 
of the import setup process at which point you will be able to carry out the actual import of data. 
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Map Source and Target Fields Common Tasks 
The following tasks are used when you map the fields in your data source with target table 
columns in SmartPlant Instrumentation. 

Define Links for Naming Conventions 
In this procedure you define the source naming conventions of the tag name and the loop 
name.  You have to go through this stage in one of the following situations: 
 You have selected the Redefine the naming conventions check box in the Tag/Loop tab on 

the Link Properties dialog box. 
 You have started a new import session but you did not clear Define the naming conventions 

in the link check box in the Tag/Loop tab on the Link Properties dialog box. 
You define the links for the naming conventions on the Define Tag Name Structure dialog box 
and/or on the Define Loop Name Structure dialog box depending on whether the target contains 
component names, loop names or both.  You have to complete the definitions in one or both 
dialog boxes depending on whether the target table or tables contain one or both naming 
conventions. 
The current naming conventions are those that the Domain Administrator previously defined in the 
Administration module.  For more information, see Define Links for Naming Conventions (on 
page 63). 

Open Import Links 
This procedure shows you how, after selecting the required import links in the Link Explorer, you 
can open the links to view or modify the mapping before importing data.  For more information, 
see Open Import Links (on page 64). 

Define the Import Mapping 
This procedure shows you how, after creating the import links and defining the required 
properties, to map the source and target data.  Depending on the import method (Single table or 
Module), you define the link mapping in the appropriate Import Link window.  The table columns 
that you need to map depend on the target data type.  For more information, see Define the 
Import Mapping (on page 64). 

Configure Source Data for Variable Length Data Fields 
Where a source data field is likely to vary in length and it is only a sub-string of another field, you 
should ensure that your source data is configured correctly.  For more information, see Configure 
Source Data for Variable Length Data Fields (on page 65). 
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Define Links for Naming Conventions 
 In this procedure, the Define Tag Name Structure dialog box is used as an example. 

1. If required, do the following to instruct the Import Utility to put leading zeros in front of the 
numeric part of the loop / tag name (for example, to have the tag 108-FT 0001 instead of 
108-FT 1) for the loops or tags in all the available import links: 
a. Click File > Preferences. 
b. In the Import Preferences dialog box, click the Tag/Loop tab. 
c. Select Insert leading zeros for numeric values and click OK. 

2. In the Link Explorer, select the desired links that include loop or tag data. 

3. Click  to open the Link Properties dialog box and click the Tag/Loop tab. 
4. Do the following: 

a. Clear Define the naming conventions in the link. 
b. If required, select Redefine the naming conventions. 
c. If required, select Replace null string with space to instruct the Import Utility to translate 

any null strings in your source data into spaces. 
d. Click OK. 

 It is advisable to select the Replace null string with space check box if you are not sure 
if any source table columns are null or not. 

5. Do one of the following: 

 Click  to open the links. 

 Click  to import data using the links. 
6. In the Define Tag Name Structure dialog box, select the name of the source table from the 

Source Table Column List data window. 
 You can search for a source name in the Source Table Column List by pressing the key 

corresponding to the first letter of the source name.  Make sure you select one of the rows in 
the Source Table Column List data window first. 

7. Drag the selected source name to the Name Convention window (the target) and drop it in 
the appropriate Source Name row. 

 You should ensure that your source data configured correctly if the loop or tag names are 
likely to be of variable length.  For details, see Configure Source Data for Variable Length 
Data Fields (on page 65). 

8. In the Start column of the Name Convention data window, enter the starting location of the 
string within the naming convention. 

 If you click Cancel in the Define Tag Name Structure dialog box or in the Define Loop 
Name Structure dialog box without completing the tag or loop definition, an appropriate 
message will be displayed, after which you will return to the Link Explorer. 

9. Select Enable any source name for prefix to allow you to enter any value for the prefix or 
clear the check box to restrict the prefix to a fixed value based on the current plant hierarchy 
item. 

 If you are importing data for both loops and tag numbers, you must select or clear this 
option for both the loop and tag name structures. 

10. Click View Source to view the source table.  For further details, see Viewing the Source Data 
(on page 55). 

11. Click OK to proceed with the import setup process. 
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Open Import Links 
1. In the Link Explorer, select the required groups or links in the Link list. 
2. Do one of the following: 

 Click Actions > Open Link. 

 Click  ( Open Link). 
3. In the Import Link window, make changes to the link mapping as required.  For details, see 

Using the Link Explorer Window (on page 21). 

See Also 
Viewing the Source Data (on page 55) 
Tag Class Mapping Codes for Instrument Index Import (on page 68) 
 

Define the Import Mapping 
1. In Import Link window, in the Target pane, review the status of the target data fields.  The 

status is indicated by the following colors: 
 Red — Indicates a primary key column (must be defined in the link). 
 Blue — Indicates a foreign key column. 
 Black — Indicates a regular column in the specific target table. 
 Magenta — A column defined as NOT NULL and which is defined in the Table Definition 

dialog box as NOT DEFAULT. 
  When importing data using the Module method, you do not need to define the 

Primary Key links.  However, if you want to import any part of a table, its supporting table, or 
its reference tables, you must define that table's Primary Key links. 

2. In the Target pane, under Source Name, do one of the following: 
 Click the desired row under Source Name, and then select one or more table columns in 

turn from the Source pane. 
 Type known source table column values. 
 Enter a fixed string (for example, a formula) instead of linking source data.  The fixed 

string must be enclosed in single quotes ( '...'). 
 Drag one or more selected table columns from the Source pane to the desired row under 

Source Name in the Target pane. 

 
 Whenever you drag a new source table column to a field under Source Name, a + sign is 

automatically added before the new field, for example: 
CMPNT_NAME+FUNC_DESC+FUNC_TYPE 

 When defining import mapping for COMPONENT table columns, you must specify a 
correct value for the CMPNT CAT ID ( Tag Class) column.  For details, see Tag Class 
Mapping Codes for Instrument Index Import (on page 68). 

3. If needed, in the Source Name fields, use formulas and arithmetic functions.  For details, see 
Formulas and Arithmetic Functions in Import Links (on page 66). 

  If the total length of the Source Name data field is longer than the target field length (in 
the Length data field of the Target pane), a scissors symbol ( ) appears to the left of the 
Source Name data field. 

4. In the Source Name column, modify the data fields as you require, using various string 
operators.  For details, see String Operators in Import Links (on page 66). 
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  If you need to define import mapping for a process function ( PROC_FUNC_NAME 
column), note that you can set the software to use the @PROC_FUNC_NAME macro, so that 
you do not need to define manual mapping for process function and instrument type 
fields.  The software uses this macro if you have assigned process functions to instrument 
type fields using the Source tab options of Link Properties dialog box.  For details, see Set 
Source Fields as Instrument Type Fields (on page 91).  This macro appears in the Import 
Link window whenever the PROC_FUNC_NAME column exists in the target table. 

5. After defining all desired settings in the Import Link window, do one of the following: 

 Click  to start an import test run which helps you evaluate the import results without 
saving data to the target table or tables.  For details, see Test the Import Process (on 
page 82). 

 Click  to start the import process. 

 Click  to save the current link settings in the Import Utility.  You can use the saved link 
in other import sessions. 

See Also 
String Operators in Import Links (on page 66) 
Example of Concatenated Sources (on page 95) 
 

Configure Source Data for Variable Length Data Fields 
Where a source data field is likely to vary in length and it is only a sub-string of another field, you 
should create a separate data field in the source for each of the sub-strings (PREFIX, 
MEASURED VARIABLE, FUNCTION TYPE, and so forth). 
For example, the source table may contain the following tags (the instrument type is indicated in 
bold type): 

108 FT100 
108 ICP100 
108 FT100 
108 ILP100 

In this case the data field in bold type varies in length according to the particular tag.  Therefore, 
you need to create a separate data field for each of the parts of the instrument type, for example: 

108 FT  100 
108 ICP  100 
108 FT  100 
108 ILP  100 

If you have defined a fixed-name string as a prefix, you do not have to link source data to this part 
of the naming convention.  The Import Utility will create this part automatically during the import 
process. 
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String Operators in Import Links 
When defining the import mapping, you can use various string operators in the Source Name field 
of the Import Link window.  The following string operators are available: 

Operator Description Example 

'...' Single quotes.  You must enclose any 
fixed string in single quotes if you do 
not want to link the source data 
directly. 

'101-FT-100' — Imports a specific tag 
number. 

(n,n) Sub-string operator.  This operator 
allows you to transfer a sub-string of a 
source field value by adding in 
parentheses the string parameters: 
the starting character and the string 
length. 

cab_name(3,2) — Indicates that you want to 
transfer two characters from the cab_name 
field, starting from the third character. 

& Ampersand character.  This 
character allows you to trim any 
leading or trailing spaces in the 
imported value.  You must add the & 
character before the field value in the 
link. 

&tag_name(5,5) — In this example, the 
source field (tag_name) is a string 
representing an entire tag name such as 
101-FT   -100 (where the instrument type 
segment can be up to 5 characters long and 
includes trailing spaces).  This example 
includes a sub-string of 5 characters in 
length starting from the 5th character, which 
in this case is 'FT   ' (with 3 trailing spaces). 
The '&' character preceding the string 
ensures that these trailing spaces are 
trimmed, so that the imported string will 
actually be 'FT'. 

# Pound character.  The # character, 
preceded and followed by a + 
character (...+#+...) indicates the end 
of the current line so that the imported 
value following #+ appears on the 
next line. 

spec_note1+#+spec_note2 — Imports two 
spec note from a predefined source fields 
and displays the second note on a new line.

 You can use any combination of the string operators in an import link. 

See Also 
Example of Concatenated Sources (on page 95) 
 

Formulas and Arithmetic Functions in Import Links 
When defining the import mapping, as an alternative to using individual source table columns 
dragged from the Source pane of the Import Link window, you can also link together several 
values in the Target pane, in the Source Name column and use them as a single source.  For 
example, the source used for the drawing name is dwg + equip which is a combination of the 
drawing ID and equipment ID (the '+' character is entered automatically if you select both sources 
by dragging them to the same data field). 
The source can be composed of several different functions using the arithmetic operators (+, -, /, 
*) in addition to the string operators.  The following conventions apply: 
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 Arithmetic operators are treated as such only in data fields whose table column type is 
number. 

 Each arithmetic operator is preceded by the '!' character, for example: 
param1 !+ param2 !- param3 
(If the values are: param1 = 2, param2 = 10, and param3 = 5, the result of the above formula will 
be 7.) 
 Constants must be enclosed within single quotes, for example: 

param1!+ '2' !* '5' 
(Since the operations are performed from left to right, if the value of param1 is 2, the result of the 
above formula will be 20.) 
In the following example, the fluid temperatures are calculated using the base temperatures in the 
following formulas: 
 Normal temperature = Base temperature + 10 
 Minimum temperature = (Base temperature + 10) / 1.2 
 Maximum temperature = (Base temperature + 10) * 1.2 

The syntax used by the Source Name data field is entered as follows: 

 

See Also 
Example of Concatenated Sources (on page 95) 
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Tag Class Mapping Codes for Instrument Index Import 
In SmartPlant Instrumentation, if you have instruments belonging to more than one tag class, you 
must define a mapping value for the Tag Class ( CMPNT_CAT_ID) column when defining an 
import link for COMPONENT table columns.  In the database, CMPNT_CAT_ID is the column 
that contains the tag class ID numbers.  Depending on the import method you selected on the 
Link Definitions dialog box, the Import Link window either displays CMPNT CAT ID (the 
definition in the database) or Tag Class (the definition in the SmartPlant Instrumentation 
interface): 
 When defining a link for importing data using the Module method, the Import Link window 

displays Tag Class under the Target Name column and also displays CMPNT CAT ID under 
the Column Name column. 

 When defining a link for importing data directly into the COMPONENT table, using the Single 
table method, the Import Link window only displays CMPNT CAT ID under the Target Name 
column. 

The following table lists ID values for all possible instrument tag classes that SmartPlant 
Instrumentation supports.  Note that there is no 4 value. 

Tag Class (CMPNT CAT ID Column) Mapping Code 

Conventional 0 

Telecom 1 

Foundation Fieldbus 2 

Typical 3 

Electrical Signal Tag 5 

Analyzer Component 6 

Analyzer Stream 7 

Functional Requirement 8 

Foundation/Profibus PA virtual tag 9 

Profibus DP 10 

Profibus PA 11 

HART Device 12 

HART Signal 13 

Soft Tag 14 

Test Equipment 15 

See Also 
Import Instrument Index (on page 93) 
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Process Function Mapping Codes for Instrument Index 
Import 

The following table lists the process functions that exist in SmartPlant Instrumentation and 
displays the corresponding codes that you must include in the import source in a separate column 
or define manually when mapping the PROC_FUNC_ID column in the PROCESS_FUNCTION 
table in the Import Link window. 

Process Function Mapping Code 

General 0 

Flow 1 

Level 2 

Pressure 3 

Temperature 4 

Analyzer 5 

Control Valve 6 

Relief Valve 7 

  Do not import data into the PROCESS_FUNCTION table.  This might damage your 
database. 

See Also 
Import Instrument Index (on page 93) 
 

Fluid State Mapping Codes for Process Data Import 
The following table lists the fluid states that exist in SmartPlant Instrumentation and displays the 
corresponding codes that you must include in the import source in a separate column or define 
manually when mapping the Fluid State ( PD_FLUID_PHASE) column in the PD_GENERAL 
table in Import Link window.  Mapping the fluid state is required for process data import or 
specification import using the Module (multiple tables) import method. 

  In the Import Link window, the Fluid State ( PD_FLUID_PHASE) column is also referred 
to as Upstream Condition. 

Fluid State (PD_FLUID_PHASE) Mapping Code 

Gas/Vapor G 

Liquid L 

Steam S 

Water W 

Solid/Powder P 

N/A or other O 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
Create Specs Using the Module Import Method (on page 96) 
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Mapping Codes for Wiring Data Import 
In SmartPlant Instrumentation, wiring items can appear either as reference items in the 
Reference Explorer or as <plant> items in the Domain Explorer.  Therefore, when defining 
import mapping, you must first map the DEF_FLG flag.  According to the DEF_FLG flag mapping, 
data that you import appears either in the Domain Explorer or Reference Explorer in SmartPlant 
Instrumentation.  Each wiring item has a distinct mapping code that you must specify in the 
Import Link window.  Depending on the mapping code, wiring items that you create appear 
under specific categories in SmartPlant Instrumentation.  For example, if you want to import 
device panels, you must map the PANEL_CATEGORY column the PANEL table as 4 and also 
map the PANEL_SUB_CATEGORY column as 410 in the Import Link window. 
The following tables list all the codes that you need to use for correct import of wiring data.  You 
must either include the codes in the import source in a separate column or define the code values 
manually when mapping the wiring data columns in the Import Link window. 

Mapping for the DEF_FLG Flag 

DEF_FLG Mapping Code Note 

<Plant> data 
import 

N In SmartPlant Instrumentation, the imported data 
appears in the Domain Explorer in the appropriate 
<plant>. 

Cross cable data 
import 

C In SmartPlant Instrumentation, the imported cables 
appear in the Domain Explorer in the Cross 
Cables folder. 

Reference data 
import 

Y In SmartPlant Instrumentation, the imported data 
appears in the Reference Explorer. 

Mapping for the PANEL_CATEGORY Column in the PANEL Table 
 After defining mapping for a panel category, you must also define mapping for the 

panel sub-category. 

Panel Category Mapping Code 

Junction Box 1 

Marshaling Rack 2 

Cabinet 3 

Device Panel 4 

DCS 5 

PLC 6 

Mapping for the PANEL_SUB_CATEGORY Column in the PANEL Table 

Panel Sub-Category Mapping Code 

Junction Box 110 

Fieldbus Plug-and-Socket Junction Box 120 

Splice Panel 130 
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Panel Sub-Category Mapping Code 

Patch Panel 140 

Telecom Junction Box 150 

Marshaling Rack 210 

Distribution Frame 220 

Cabinet 310 

PA Cabinet 320 

PABX Cabinet 330 

Miscellaneous Cabinets 340 

Hub Cabinet 350 

Intercom Cabinet 360 

Power Distribution Board 370 

Device Panel 410 

Telecom Plug-and-Socket Device Panel 420 

Fieldbus Plug-and-Socket Device Panel 430 

Telecom Device Panel 440 

Multi-Input Device Panel with Plugs 450 

Multi-input Device Panel Without Plugs 460 

DCS 510 

Safety System 520 

PLC 610 

Telecom Equipment 620 

Mapping for the STRIP_CATEGORY Column in the PANEL_STRIP Table 

Terminal Strip Category Mapping Code 

Regular Terminal Strip 0 

Plug-and-Socket Box 2 

Connector 6 

Switch Port (Telecom) 7 

Apparatus 8 

Mapping for the TERMINAL_CATEGORY Column in the PANEL_STRIP_TERM Table 

Terminal Category Mapping Code 

Regular Terminal (General) G 

Apparatus Right Terminal R 
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Terminal Category Mapping Code 

Apparatus Left Terminal L 

Apparatus Left and Right Terminal H 

Mapping for the CABLE_CATEGORY Column in the CABLE Table 

Cable Category Mapping Code 

Fieldbus Home-Run H 

Conventional R 

Telecom T 

Mapping for the APPAR_CAT_ID Column in the APPARATUS Table 

Wiring Equipment Category Mapping Code 

Miscellaneous Wiring Equipment 0 

I/O Card 1 

I/O Termination 2 

Hub 4 

Intercom 5 

Switch 6 

Miscellaneous Telecom Equipment 7 

Fieldbus Brick 8 

Isolator 9 

Safety Barrier 10 

Relay 11 

Trip Amplifier 12 

Amplifier 13 

Mapping for the CHANNEL_CATEGORY Column in the CHANNEL Table 

Channel Category Mapping Code 

Conventional G 

Apparatus H 

I/O Channel I 
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Import Data Comparison 
After you have run an import session on a set of data at least once, you can run subsequent 
sessions by comparing the new rows to be imported with previously imported rows.  You can do 
this on the Import Comparison List dialog box as well as on the Comparison tab of the Link 
Properties dialog box.  You can also start transferring data after you have selected specific rows 
that you want to import from the source to the target. 

 When importing a satellite project back to the host project, changes made to reference data 
(redlining, drawing item positions, certain supporting tables and so-forth) on Enhanced Report 
Utility drawings are not imported back to the host project. 

See Also 
Target Table Definition (on page 43) 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
 

Setting the Import Comparison List Options 
During the import process the Import Utility modifies the contents of the SmartPlant 
Instrumentation database (for example, the target module or table).  This is done by inserting, 
deleting and updating rows in the SmartPlant Instrumentation database.  It is therefore advisable 
to be able to coordinate between these rows before you start the import process. 
This feature provides you with the means to coordinate between the rows to be inserted, deleted 
or updated during the import process.  You do this by reviewing the source and target rows and 
selecting the appropriate rows which will be processed during the import process. 

  The Comparison tab only becomes active after the first time you have imported data and 
saved the selected link. 

See Also 
Import Comparison (see "Import Data Comparison" on page 73) 
Preview and Print the Source and Target Rows (on page 75) 
Target Table Definition (on page 43) 
 

Comparison Options Common Tasks 
The following tasks are used when you compare import data against data already imported. 

View the Source and Target Rows 
Use this procedure to view the source and target rows according to the selection you made, or per 
process (for example, rows that will be inserted, rows that will be deleted, and so forth).  For more 
information, see View the Source and Target Rows (on page 74). 

Filter the Displayed Target Rows 
Use this procedure to filter the target rows displayed on the Import Comparison List dialog 
box.  Filtering the target rows this way does not affect the target rows currently selected to be 
included in the import process.  For more information, see Filter the Displayed Target Rows (on 
page 74). 

Preview and Print the Source and Target Rows 
Use this procedure to preview and print out the source and target rows displayed on the Import 
Comparison List dialog box.  For more information, see Preview and Print the Source and 
Target Rows (on page 75). 
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Import Data Using the Comparison List 
Use this procedure to import data using the comparison list.  For more information, see Import 
Data Using the Comparison List (on page 75). 
 
 

View the Source and Target Rows 
1. On the Import Comparison List dialog box, under Show, do one of the following: 

 Select All to view all target rows. 
 Select the Selected option to view only the selected target rows.  Selecting this option 

displays only the rows you have previously selected. 
 Select By mode to view the displayed rows according to their import mode. 

2. If you selected the By mode option, under Import mode, do one or more of the following: 
 Select Inserted to select all the source rows whose status is Insert (for example, the 

letter I appears in the Mode column). 
 Select Updated to select all source and target rows whose status is Update (for example, 

the letter U appears in the Mode column). 
 Select Deleted to select all source rows whose status is Delete (for example, the letter D 

appears in the Mode column). 
 Select Refreshed to select all source and target rows whose status is Refresh (for 

example, the letter R appears in the Mode column). 
  You can select more than one import mode by which the data in the data window will be 

displayed.  This way you show the source and target data by more than one import mode. 
3. Click Display to display rows in the Comparison data pane according to the specified 

filtering options. 
 
 

Filter the Displayed Target Rows 
 At the bottom of the Import Comparison List dialog box, click Filter to open the Import 

Target Filter dialog box. 
  The source table columns available in this data window are only the ones currently 

displayed in the Import Comparison List dialog box.  These are the same table columns that 
you linked in the Import Link window. 

See Also 
Specify a Filtering Condition (on page 27) 
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Preview and Print the Source and Target Rows 
1. At the bottom of the Import Comparison List dialog box, click Report. 
2. On the Print Preview dialog box, view the displayed data. 

  Placing the cursor on the scroll box displays the current page number.  Scroll the box 
down in the scroll bar to display the total number of pages that the printout includes. 

3. Click Print. 
 
 

Import Data Using the Comparison List 
1. Do one of the following: 

 In the Import Link window for a table or module, click . 
 Specify the deviation options on the Comparison tab of the Link Properties dialog 

box.  This method applies only if you started this import session using a saved link. 
2. In the Import Comparison List dialog box, under Show, click All to display all the data rows. 

  If you have already defined a source filter condition in this session (in the Link 
Properties dialog box), only the source rows which comply with this condition will be 
displayed in the Import Comparison List dialog box.  See Specify a Filtering Condition (on 
page 27) for details. 

3. Select the required data rows to be processed for import by doing one of the following: 
 Select the check box in the Select column for each row you want to include. 
 In the Select rows section, click the All button to select all the rows. 
 In the Select rows section, select one or more of the check boxes to include all the rows 

where the mode corresponds to the selection. 
4. Select Re-open the Comparison List. 

  Rows where data was changed are highlighted in light blue. 
5. Click Test to check the import process without actually saving data to the target table. 
6. Modify the link mapping, if required, to correct any errors. 
7. Click Run to import the data. 
 
 

System Codes 
When importing data from a non-SmartPlant Instrumentation database that uses system or unit of 
measure codes different from the ones used in your target SmartPlant Instrumentation database, 
you are required to adapt the source system and unit of measure codes to the codes used in your 
target SmartPlant Instrumentation database.  This feature can also be used to adapt system and 
unit of measure codes of a SmartPlant Instrumentation source domain, when importing data from 
one SmartPlant Instrumentation domain to another. 
Suppose a source table contains a code (for example, A) that is used as a reference in another 
source table.  This code may be different from the one used in your corresponding target 
SmartPlant Instrumentation database (for example, psia).  Therefore, prior to running import, you 
have to make the appropriate adaptations for the system codes and unit of measure codes. 
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  If you want to use system codes in your current import session, you must select the 
appropriate source system and adapt its code prior to starting the import of data (see the 
procedure below for details).  Also note that the target code values are predefined in the system 
and cannot be modified.  When importing process data and/or calculation data and the units of 
measure are not defined, the Import Utility will insert default unit of measure values belonging to 
the SmartPlant Instrumentation <unit> with which the imported tag data is associated. 
To adapt source system and unit of measure codes you need to do the following: 
 Select the source system whose codes you want to adapt.  for details, see Define Source 

Systems (on page 77). 
 Adapt the source codes to the target codes.  for details, see Adapt System Codes (on 

page 78). 
Using this feature you can also keep the code adaptation data in a text file (with a .cds extension) 
and use it in future import sessions.  You can do the following: 
 Import a code file that contains adapted system codes, unit of measure codes or both.  For 

details, see Import Codes (on page 79).  Importing codes this way does not overwrite the 
current code adaptations. 

 Export a code file that contains adapted system codes, unit of measure codes or both.  For 
details, see Export Codes (on page 80). 

 Display the name of the source system set as the currently source system.  For details, see 
View the Currently Selected Source System Name (on page 80). 

See Also 
System Codes Table (on page 116) 
Unit of Measure Codes Table (on page 125) 
 

Working with System Codes Common Tasks 
The following tasks are used when you import data from a non-SmartPlant Instrumentation 
database that uses system or unit of measure codes different from the ones used in your target 
SmartPlant Instrumentation database. 

Define Source Systems 
Before you can adapt the source codes to comply with the target codes, you need to specify the 
source systems whose codes you want to adapt.  At this stage, you also select the current source 
system whose codes you want to use during the current import session.  For more information, 
see Define Source Systems (on page 77). 

Adapt System Codes 
Use this procedure to adapt the codes which are not associated with units of measure to the codes 
that are used in the target SmartPlant Instrumentation database.  Several source code values can 
be represented by a single target code value.  For example, the source code values AA, BB, CC, 
DD can be represented by (adapted to) a single target code: XX.  For more information, see 
Adapt System Codes (on page 78). 

Adapt Unit of Measure Codes 
This procedure shows you how to adapt unit of measure codes for SmartPlant 
Instrumentation.  For more information, see Adapt Unit of Measure Codes (on page 78). 

Import Codes 
This feature allows you to import from the same code file (with a .cds extension) both the system 
codes and the unit of measure codes or just one of them, depending on whether these codes exist 
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in the ASCII file you are going to use.  This way you can use code adaptation settings that were 
previously saved in files without having to redefine the code adaptation for every case.  For more 
information, see Import Codes (on page 79). 

Export Codes 
This feature allows you to export the current code settings of any selected source system to a 
code file (with a .cds extension).  You can export both the system codes and the unit of measure 
codes or just one of them.  This way you can keep code adaptation settings in a file and use them 
in future import sessions without having to redefine the code adaptation for every case.  For more 
information, see Export Codes (on page 80). 

View the Currently Selected Source System Name 
This option enables you to view the currently selected source system name.  For more 
information, see View the Currently Selected Source System Name (on page 80). 

Use Source Codes in an Import Link 
After you have adapted unit of measure codes and system codes, this procedure describes how to 
use them in your import links.  For more information, see Use Source Codes in an Import Link (on 
page 80). 

See Also 
System Codes Table (on page 116) 
Unit of Measure Codes Table (on page 125) 
 

Define Source Systems 
1. On the System Codes menu, click Select Source System. 
2. In the Source System List dialog box, do one of the following: 

 Add a new source system (see step 3). 
 Edit an existing source system name (see step 4). 
 Delete an existing source system (see step 5). 
 Select the current source system (see step 6). 

3. To add a new source system, do the following: 
a. Click New. 
b. Click in the highlighted line. 
c. Type the new source system name. 

4. To edit an existing source system name, do the following: 
a. In the data window, highlight the source system whose name you want to modify. 
b. Click Edit to make the line selected in the data window. 
c. Edit the source system name as required. 

5. To delete an existing source system, do the following: 
a. In the data window, highlight the source system you want to delete. 
b. Click Delete to delete the line selected in the data window. 
c. To select the current source system, in the data window, highlight the required line. 

6. Click OK. 
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Adapt System Codes 
 You can adapt system codes and unit of measure codes only if you selected a source 

system.  For a list of system codes you can adapt, see System Codes Table (on page 116). 
1. Click System Codes > Adapt System Codes. 
2. In the Source System List dialog box, select the source system whose codes you want to 

adapt.  The available source systems are the ones you entered in the Source System List 
dialog box. 

3. In the Adapt System Codes dialog box, under Module, do one of the following: 
 Click All to make all properties available. 
 Click the SmartPlant Instrumentation module whose properties you want to make 

available ( Process Data, Wiring, or Calculation). 
 Click Other to make the properties available for all modules except for Process Data, 

Wiring, and Calculation. 
4. From the Code Values list, select the property whose codes need adapting. 
5. To set the code values, do the following: 

a. In the data window, click the Source Code field of the appropriate code.  The selected 
Source Code field becomes editable (if the field color was light blue, it changes to white). 

b. Type the source value corresponding to the target system code value. 
c. To clear the currently selected source system code value, click Unused. 
d. To specify an additional source system code value for the target system code value 

currently selected in the data window, click Duplicate and type an additional value in the 
Source Code column of the new row. 

 You can only set the values of source codes where the Source Code field color is 
either light blue or white. 

6. Repeat steps 3 through 5 for every required SmartPlant Instrumentation module. 
7. Repeat steps 2 through 6 for other source systems whose codes need adapting. 
8. Click OK to close the Adapt SystemCodes dialog box. 
  
 

Adapt Unit of Measure Codes 
 You can adapt system codes and unit of measure codes only if you selected a source 

system.  For a list of system codes you can adapt, see Unit of Measure Codes Table (on 
page 125). 
1. Click Codes > Adapt Unit of Measure Codes. 
2. On the Adapt Unit of Measure Codes dialog box, from the Source System list, select the 

source system whose codes you want to adapt.  The available source systems are the ones 
you entered on the Source System List dialog box. 

3. From the Unit of measure type list, select the unit of measure category whose codes need 
adapting. 

4. To set the code values, do the following: 
a. In the Codes pane, click the Source UOM Code field of the appropriate code. 

 You can only set the values of source codes where the Source UOM Code field 
color is either light blue or white. 

b. Type the source value which corresponds to the target unit of measure code value. 
c. Click Unused to clear the currently selected source unit of measure code value. 
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d. Click Duplicate to specify an additional source unit of measure code value for the target 
unit of measure code value currently selected in the data window. 

5. Repeat steps 3 and 4 for every required SmartPlant Instrumentation module. 
6. Repeat steps 2 through 5 for other source unit of measure whose codes need adapting. 
7. Do one of the following: 

 Click OK to save the changes you made to the current unit of measure code settings and 
close the Adapt Unit of Measure Codes dialog box. 

 Click Apply to save the changes you made to the current unit of measure code settings 
and keep the Adapt Unit of Measure Codes dialog box open.  This way you can save 
the portion of the work you have done so far and keep working with the Adapt Unit of 
Measure Codes dialog box. 

See Also 
Unit of Measure Codes Table (on page 125) 
 

Adapt Unit of Measure Codes - Special Characters 
To type power indexes (for example, 2 as in cm2) and other special characters (for example, as in 
C), do the following: 
1. Run the Windows Character Map utility and select the appropriate character to copy, and 

then, click the Copy button. 
2. Do one of the following: 

 Switch to the Import Utility and paste the character in the required location. 
 Hold down Alt and, with the Num Lock indication on, type the required character's ASCII 

value (a four-digit number) using the keyboard numeric keypad (see your Windows User 
Guide for additional information about ASCII numbering). 

For example: 
Type Alt + 178 to add: 2 
Type Alt + 179 to add: 3 

See Also 
Unit of Measure Codes Table (on page 125) 
 

Import Codes 
 Importing codes from an external file does not overwrite existing code settings. 

1. Click Codes > Import Codes. 
2. On the Import Codes dialog box, do one of the following: 

 Under File, type the full path and filename of the ASCII file from where you want to import 
the codes, if you know it. 

 Click Browse to navigate to the desired file. 
3. Under Import data, select the code type you want to import: system codes, unit of measure 

codes, or both. 
 The code type that will be imported depends on whether the file you selected in step 2 in 

this procedure actually contains the code type that you select in the Import data section. 
4. Click OK to import the selected codes. 
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Export Codes 
1. Click Codes > Export Codes. 
2. On the Export Codes dialog box, select one or more source systems whose code settings 

you want to export to a .cds file.  To clear a system, click it again. 
3. Under Export data, select the code type you want to import: System codes, Unit of 

measure codes, or both. 
4. Click OK. 
5. On the Enter Export File Name dialog box, select the file where you want to keep the codes 

of the system you selected in step 2 in this procedure. 
6. Click Save to export the codes to the selected file. 
  
 

View the Currently Selected Source System Name 
 Click Codes > Current Source System. 

  
 

Use Source Codes in an Import Link 
1. In the Link Explorer, select the link where you want to use source codes. 
2. Click Actions > Properties. 
3. On the Link Properties dialog box, click the Source tab. 
4. Select Use system codes. 
5. Click OK. 
6. In the Update mode, if prompted to use the overwrite option, click Yes. 
7. Open the link which you want to use to import your data. 
8. Define the link mapping by dragging the appropriate source names to the target window. 
9. In the Import Link window link, select the check boxes in the target window under the Code 

column for those link parameters for which you want to use source codes. 
 To use all available source codes in the link, on the menu bar, click Actions > System 

Codes > Check All. 
  
 

Data Import Prerequisites 
Before importing data into SmartPlant Instrumentation, the following general prerequisites must 
be met: 
 There must be a target SmartPlant Instrumentation domain containing at least one plant 

hierarchy item at the lowest level of the hierarchy (by default, this is a <unit>).  You create 
plant hierarchy items in the Administration module. 

 There must be a naming convention for instruments and loops in each target <unit>.  This is 
necessary only if you intend to work with tables whose columns require naming conventions 
(for example, COMPONENT, LOOP).  You set naming conventions in the Administration 
module. 

 In SmartPlant Instrumentation, you must specify the valid Temporary folder path on the 
General page of the Preferences dialog box. 
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 If you are importing from SmartPlant P&ID, SmartPlant P&ID must be closed before starting 
the import session, to ensure that any modifications made to the drawings are properly 
imported to SmartPlant Instrumentation.  

 
 When importing a satellite project back to the host project, changes made to reference data 

(redlining, drawing item positions, certain supporting tables and so-forth) on Enhanced Report 
Utility drawings are not imported back to the host project. 

 The software does not update the PLANT table, which contains the active item library 
designation.  Therefore, when importing hook-up data, if the active item library designation 
was changed in the source, you must select the active item library manually after performing 
the import in order to be able to continue to work with the data. 

See Also 
Import Links (on page 15) 
Prerequisite for Importing Instrument Types (on page 90) 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
 

Matching Naming Conventions 
It is very important to adjust the import links so that they match the naming conventions of tags 
and loops used in the domain into which you are about to import data. 
For example, in the SmartPlant Instrumentation demonstration domain, the naming convention 
structure of conventional instruments is as follows: 

101-AAAA-BBBB 
In this convention, 101 is the <unit> number prefix, AAAA represents the instrument type segment 
and BBBB represents the tag number segment; the hyphens are segment 
separators.  Therefore, an instrument with tag number 101FE22212 is represented in the 
demonstration domain as 101-FE -2212. 
Before starting the import setup process, you need to pay attention to the source table columns 
that construct the source instrument and loop and how they match the SmartPlant Instrumentation 
instrument and loop data. 
When you select an import link that is associated with either instruments or loops, you are 
prompted to define the naming convention structure. 

  When redefining the naming convention structure, make sure that no data redundancy 
is created.  Such a redundancy may be caused, for example, if the source table columns use data 
segments that are shorter than those used in the target table columns.  For example, the source 
tag number 101PS2212 uses only a two-character table column for the instrument type.  In 
SmartPlant Instrumentation, this tag number appears as 101-PS – 2212.  This situation may 
cause a data redundancy problem, since this tag number can stand for either 101-PSH -2212 or 
101-PSL-2212. 
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Importing Data Common Tasks 
The following tasks are used when testing data import and when importing data. 

Test the Import Process 
You can run a test of the import process according to the parameters you have set in the Import 
Link window.  The software tests the import process without carrying out the actual import of 
data, for example, without inserting, updating or deleting rows of the SmartPlant Instrumentation 
database. 
Testing the import process can be useful when testing a single link before carrying out a large 
batch operation.  A test can also give you an indication on the rejected rows and allow you to fix 
the problem prior to a batch operation.  A test run is carried out slightly faster than the actual 
import operation.  For more information, see Test the Import Process (on page 82). 

Run an Import Session from the User Interface 
Use this procedure to run an import session from the Import Utility.  The data import process 
involves creating links that map between the source and the target tables.  After defining the links, 
you perform the actions that import the data into SmartPlant Instrumentation.  For more 
information, see Run an Import Session from the User Interface (on page 83). 

Run an Import Session from the Command Line 
You can use command-line parameters to start an import session that executes an existing import 
link.  This way you can import data using the settings in the selected link without having to open 
the Import Utility.  For more information, see Run an Import Session from the Command Line (on 
page 84). 

Disable Test Mode 
Use this procedure if you do not want to perform any import tests.  Note that disabling the test 
mode results in actual data import when trying to test an import process.  For more information, 
see Disable Test Mode (on page 85). 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
 

Test the Import Process 
 Make sure that, in the [Database] section of the Intools.ini file, the following parameter 

setting appears: AutoCommit= 0.  If the parameter setting is AutoCommit=1, the test mode is 
disabled and trying to test the import process results in actual data import. 
1. Define a log file, if you have not yet done so. 

 You can perform a test run of a sub-set of the selected source and target data by 
applying the appropriate filtering condition to the data (see Specify a Filtering Condition (on 
page 27)) or partially linking the source and target data (see Define the Import Mapping (on 
page 64)). 

2. With the Import Link window open, on the toolbar, click  ( Test) to start testing the import 
process. 

3. On the Import Progress Test dialog box, which opens automatically, view the expected 
import process results. 
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 The test results are inaccurate when you import data in a group of links of which some links 
are related as in the example: cable, cable set, and wire.  Also, the test results are inaccurate 
when you import one or more source tables containing multiple prime values. 
 
 

Run an Import Session from the User Interface 
 

 We recommend proceeding cautiously with the import process, as some of the Import Utility 
features change the structure and contents of the target database. 

 The import process is irreversible: once you carry out the import process, you cannot undo the 
changes import made to the target database.  We therefore recommend that you first use the 
test mode to check the import process before carrying out the actual data transfer.  The test 
results provide you with information about the expected outcome of the actual import 
process.  For details, see Test the Import Process (on page 82). 

 
 Before importing data, familiarize yourself with import prerequisites.  For details, see General 

Import Prerequisites (see "Data Import Prerequisites" on page 80).  Also, if you intend to 
import a large number of records (more than 400 records) in one import session, you must 
create a new section in the Intools.ini file called [Rules] and add the following parameter: 
disable=y. 

 If you are importing from SmartPlant P&ID, SmartPlant P&ID must be closed before starting 
the import session, to ensure that any modifications made to the drawings are properly 
imported to SmartPlant Instrumentation.   

1. Select the import method, which can be either Module (multiple tables) or Single table. 
2. Select the target SmartPlant Instrumentation table or module for the import. 

 When importing data to tables, the order of the import is important.  You should 
first import data into a table that the next table refers to.  For example, before importing data 
into the COMPONENT table, you should import data into the COMPONENT_LOCATION 
table, if you want to import both instrument locations and instrument tag numbers. 

3. Define the import link properties as you require, using the Link Properties dialog box 
options.  For details, see Defining Import Link Properties Common Tasks (on page 24). 

4. Establish a link between the source and the target data.  You can do one of the following: 
 Use an existing link that was saved previously 
 Build a new link and save it (see step 5). 

5. To build a new link, do the following: 
6. Set the appropriate parameters for the import. 
7. Where appropriate, define the structure of the import link. 
8. Define the link mapping between the source and the target table columns. 

 
 You can modify the source definition after creating the link to insure that all required data 

exists in your source database.  Use the SmartPlant Instrumentation Data Dictionary to 
help you identify target SmartPlant Instrumentation tables. 

 If required, you can reset the import order as well as select the reference tables to 
import.  To learn how to control the import order, see Target Table Definition (on 
page 43). 

9. Run an import test (recommended)  For details, see Test the Import Process (on page 82). 

10. Perform the import process by clicking  in the Import Link window. 
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11. On the Import Progress dialog box, review the following information: 

Data Field Description  

Source Table Rows: Total / 
Current 

The total number of rows and number of rows 
currently imported in the currently selected source 
table.  

Target Table Rows The number of rows of the current table that have 
already been processed by the Import Utility during 
the current import session, according to their status: 
Inserted, Updated, Deleted, or Rejected.  

Tables / Rows in current 
table (progress bars) 

The percentage of data which has already been 
processed for an import link assigned to the Module 
(multiple tables) method for the entire module and 
for the table currently being processed.  

Progress bar The percentage of data which has already been 
processed for an import link assigned to the Single 
table method.  

Cancel Stop the import process during execution.  

Report View the report on rejected rows.  This button is 
available only if any rejected rows occurred and if 
you selected the Rejected data report check box on 
the Link Properties dialog box.  This option allows 
you also to generate a hard copy of the current 
report.  This button becomes active only after the 
import process was stopped or was completed.  

Information View the import process information: the target table 
name and the row count before and after 
import.  This button becomes active only after the 
import process was stopped or was completed.  

 
 

Run an Import Session from the Command Line 
  If you are importing from SmartPlant P&ID, SmartPlant P&ID must be closed before 

starting the import session, to ensure that any modifications made to the drawings are properly 
imported to SmartPlant Instrumentation.  
1. On the Windows Start menu, click Run. 
2. On the Run dialog box, type the following string on the same line: 

<home folder>\import <user name>,<password>,<domain>, <plant>, <intermediate plant 
hierarchy item 1>/<intermediate plant hierarchy item 2>/<intermediate plant hierarchy item 
3>...,<unit>,<link> – or – @<link group>,<project> 
The string segments in chevrons stand for the following parameters: 
 home folder — The SmartPlant Instrumentation home folder. 
 user name, password — The Domain Administrator's username and password. 
 domain — The name of the target domain. 
 plant — The name of the plant or equivalent highest level item in the plant hierarchy. 
 intermediate plant hierarchy item 1/ intermediate plant hierarchy item 2/ 

intermediate plant hierarchy item 3... — when you want to import source data from 
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multiple plant hierarchies into the target plant hierarchy and the intermediate plant 
hierarchy has two or more levels, use the character defined in the Administration module 
as the plant hierarchy separator for the domain, for example, /.  If no separator is defined 
in the Administration module, use / as the default. 

 unit — The name of the unit or equivalent lowest level item in the plant hierarchy. 
 import link — The name of the import link you want to execute in the current import 

session. 
 link group — The name of the group whose links you want to execute in the current 

import session.  When used, this parameter is always preceded by a commercial sign @. 
 project — The name of the target project when working in an owner operator domain. 

Examples  
The following are two examples of using the command line syntax. 
a. Importing data to the demonstration domain by executing a link named Flow in an owner 

operator domain: 
import DBA,DBA,Demo Domain, Plant 1 – DEMO, Main Building/North/Room 
1, Unit 3, Flow, Demo Project. 

b. Importing data to the demonstration domain by executing all the links in a group named 
Process Data in an engineering company (EPC) domain: 
import DBA, DBA, Demo Domain, Plant 1 – DEMO, Main Building/North/Room 
1, Unit 3, @ Process Data. 

 
 The parameter strings must be typed on the same line. 
 Plant hierarchy item names into which you intend to import data must not contain slash / 

characters because the software interprets these characters as separators between 
successive hierarchy levels. 

3. Press Enter. 
You see the links that you specified in the statement being carried out. 

 
 

Disable Test Mode 
  We do not recommend that you disable the test mode unless absolutely 

necessary.  Disabling the test mode results in actual data import when trying to test an import 
process. 
1. Open the Intools.ini file. 

 The default location for the Intools.ini file is the SmartPlant Instrumentation home folder. 
2. In the [Database] section, change AutoCommit=0 to AutoCommit=1. 
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Importing Data into Multiple Plant Hierarchy Items or 
Projects 

You use the Import Level tab options when you need to import source data to a domain with 
multiple plant hierarchy items or to an owner operator domain that has As-Built and multiple 
projects.  In your import source, you need to define the projects names and the plant hierarchy 
items exactly as they appear in your target domain.  In an owner operator domain, projects are 
always implemented per <plant>.  Several projects can be associated with the same <plant> and 
even share the same hierarchy levels or belong to different plants in the domain. 
When importing data that includes more than one plant hierarchy item, some of the source rows 
may recur (due to the existence of several plant hierarchy items).  In this case, you can instruct 
the Import Utility to differentiate rows of different plant hierarchy items during the import process, 
thus importing data into the appropriate plant hierarchy items.  When you select to import data 
into multiple plant hierarchy items, you can also specify the level of import, for the Import Utility to 
differentiate rows per <plant>, per <area> or per <unit>. 
If you select to import data per <plant> or per <area>, the Import Utility rejects rows defined per 
<unit>.  If you do not specify a plant hierarchy level, the Import Utility rejects all recurring source 
rows during the import process.  In this case, the Import Utility does not differentiate between 
rows of different plant hierarchy items.  After you select the level for which the Import Utility 
distinguishes unique data during the import process, you need to select the naming convention to 
be used during the import process. 
In SmartPlant Instrumentation, database tables are defined per plant hierarchy item.  When a 
table is defined at a specified level, it contains data which is unique at that level. 

Data Import at the Highest Level 
If you select to import data per <plant>, the Import Utility distinguishes only rows of different 
<plants> during the import process.  The Import Utility rejects rows of different <areas> and 
<units> if a plant contains more than one <area> and <unit>.  For example, the CABLE table is 
defined per <plant>.  Therefore the CABLE table contains data which is unique only at the plant 
level. 

Data Import at the Intermediate Level 
If you select to import data per <area>, the Import Utility distinguishes only rows of different areas 
during the import process.  The Import Utility rejects rows of different <units> if an <area> 
contains more than one <unit>. 

Data Import at the Lowest Level 
The target table is CHANNEL (a table defined per <plant>) and you select on the Import Level tab 
the <unit> level.  In this case the AREA_ID and UNIT_ID table columns become Foreign Key 
columns in the CHANNEL Table. 

Primary Key and the Foreign Key Column Definitions 
The Import Utility defines the Primary Key and the Foreign Key columns of the target table, which 
you selected on the Link Definitions dialog box, in three possible ways: 
You select the same import level as the level of the target table (this is the default option): in this 
case only the table columns regarding this level (for example, UNIT_ID, AREA_ID, and so forth) is 
automatically defined by the Import Utility as a Primary Key in the target table. 
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For example: 
The target table is COMPONENT (a table defined per <unit>) and you select on the Import 
Level tab the <unit> level: the UNIT_ID table column is also defined as a Primary Key column 
in the target table. 

You select a higher import level than the level of the target table: in this case all the table columns 
regarding the level of the target table and the levels above (for example, PLANT_ID, AREA_ID) 
will be automatically defined as Primary Key columns in the target table. 

For example: 
The target table is COMPONENT (a table defined per <unit>) and you select on the Import 
Level tab the <area> level.  In this case both the AREA_ID table column and the UNIT_ID 
table column become Primary Key columns in the COMPONENT Table. 

You select a lower import level than the level of the target table: In this case all the table columns 
regarding the level you select and the levels below will be automatically defined as Foreign Key 
columns in the target table. 
 
 

Importing Data into Multiple Plant Hierarchy Items or 
Projects Common Tasks 

The following tasks are used when you import data into multiple plant hierarchy items or projects. 

Import Data Into Multiple Plant Hierarchy Items 
This procedure shows you how to import data into multiple plant hierarchy items or projects.  For 
more information, see Import Data Into Multiple Plant Hierarchy Items (on page 87). 

Import Data into Several Projects 
This procedure shows you how to import data into several projects.  For more information, see 
Import Data into Several Projects (on page 88). 

See Also 
Run an Import Session from the Command Line (on page 84) 
 

Import Data Into Multiple Plant Hierarchy Items 
1. In your import source, do the following: 

a. Define the plant hierarchy items if you use more than one plant hierarchy in your projects. 
b. For each plant hierarchy item, define data you want to import. 

  Make sure the plant hierarchy item names or <unit numbers> are exactly the same 
as in the target domain. 

2. In the Import Utility, create the import link for the import source containing your target plant 
hierarchy item definitions. 

3. On the Link Properties dialog box, click the Import Level tab, and then, do the following: 
a. Under Hierarchy levels, select the desired plant hierarchy level. 
b. If you want to import data to several <units> in your plant, under Import unit data using, 

select Unit name or Unit number, depending on the definitions in your import source. 
c. Click OK to close the Link Properties dialog box. 

4. Open the link in the Import Link window and make your link definitions as you require. 
5. Test and import data to the target projects. 
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Import Data into Several Projects 
1. In your import source, do the following: 

a. Define the project names exactly as they appear in your target domain. 
b. Define the plant hierarchy items if you use more than one plant hierarchy in your projects. 
c. For each project, define data you want to import. 

  You can also include As- Built in the import source.  Make sure the name As- Built 
in the import source appears exactly as in SmartPlant Instrumentation. 

2. In the Import Utility, create the import link for the import source containing your target project 
definitions. 

3. On the Link Properties dialog box, click the Import Level tab, and then, do the following: 
a. Under Hierarchy levels, select the desired plant hierarchy level that the target projects 

contain. 
b. If the lowest plant hierarchy item in your projects is not the same, under Import unit data 

using, select Unit name or Unit number, depending on the definitions in your import 
source. 

c. Select Specify target projects in link. 
d. Clock OK to close the Link Properties dialog box. 

4. Open the link in the Import Link window, and, depending on the import method, do one of the 
following: 
 If the import method is Single table, link your source project table definition to the 

ENGINEER NAME/ENG PROJ ID field in the Target Name column. 
 If the import method is Module (multiple tables), link your source project table definition 

to the Engineering Project Name field in the Target Name column. 
5. Complete making the import link definitions as you require. 
6. Test and import data to the target projects. 

 When importing a satellite project back to the host project, changes made to reference data 
(redlining, drawing item positions, certain supporting tables and so-forth) on Enhanced Report 
Utility drawings are not imported back to the host project. 
 
 

Importing Instrument Index Data Common Tasks 
The following tasks are used when importing instrument tags and loops. 

Enable Creation of Complementary Elements for Instrument Index 
If on the Link Definitions dialog box, under Import method, the Instrument Index module or 
instrument index-related table is selected as the import target, the General tab of the Link 
Properties dialog box displays an additional section called Create complementary 
elements.  The options in this section allow you to set the software to import instrument tags 
according to the instrument type profile definitions.  You can enable the following elements for 
instrument index import: 
 A device panel and a cable for an instrument whose instrument type profile includes wiring, 

and which has the following default elements: panel, cable, and connection type. 
 A document number row and a default revision row (which is initially empty) in the DRAWING 

table for a specification, process data sheet and calculation sheet. 
 Instrument associations with the appropriate I/O type, locations and hook-ups. 
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For more information, see Enable Creation of Complementary Elements for Instrument Index (on 
page 91). 

Set Source Fields as Instrument Type Fields 
This procedure is useful if your import source does not contain instrument types or instrument type 
descriptions and you want to create new instrument types and descriptions in SmartPlant 
Instrumentation when importing tag numbers.  This procedure allows you to define one or more 
source columns as columns for importing instrument type abbreviations and descriptions.  To 
each field in the source column, you must assign a process function.  After that, when you open 
the Import Link window, you do not have to define mapping for the process function and 
instrument type fields.  The process function macro @PROC_FUNC_NAME appears in the 
Source Name column mapped to the PROC_FUNC_NAME column.  When importing tag 
numbers, the software runs the macro to import the instrument type abbreviations and 
descriptions using the fields you set as the instrument type fields and associate the imported tag 
numbers with the appropriate instrument types. 
In SmartPlant Instrumentation, the instrument type of a tag is abbreviated and therefore needs to 
be associated with a description that provides more information about that instrument type, for 
example, the default instrument type FV description is Flow Valve.  An instrument type 
abbreviation does not have to be unique.  For example, in SmartPlant Instrumentation, FE stands 
for either Flow Element or Mass Flow Sensor.  The combination of the instrument type 
abbreviation and description provides a unique identifier for a tag instrument type.  For more 
information, see Set Source Fields as Instrument Type Fields (on page 91). 

Associate Source Fields with Existing Instrument Types 
This procedure is useful if your import source does not contain instrument types or instrument type 
descriptions and all the instrument types and descriptions that you require already exist in 
SmartPlant Instrumentation.  This procedure allows you to set one or more source columns as 
columns containing instrument type fields and associate each field with a combination of 
instrument type abbreviation, description, and process function that exists in SmartPlant 
Instrumentation.  After that, when you open the Import Link window, you do not have to define 
mapping for the process function and instrument type fields.  The process function macro 
@PROC_FUNC_NAME appears in the Source Name column mapped to the 
PROC_FUNC_NAME column.  When importing tag numbers, the software runs the macro and 
the imported the tag numbers are associated automatically with the appropriate instrument 
types.  For more information, see Associate Source Fields with Existing Instrument Types (on 
page 92). 

Associate Tag Numbers with Correct Instrument Type Descriptions 
The instrument type of a tag is an important part of the initial information for building a tag.  This is 
true both when working with SmartPlant Instrumentation as an application as well as when 
entering tags using the Import Utility.  The instrument type information is designated in the 
function part of the instrument tag (for example, 100- FY400).  Sometimes the source data lacks 
an instrument type description, for instance, there is an FY function type name that is an I/P 
Converter and also a Solenoid Valve.  This procedure enables you to specify that each that that 
you import is automatically associated with the instrument type description that you require. 

Import Instrument Index 
Use this procedure to import instrument tags into SmartPlant Instrumentation using the Module 
(multiple table) import method.  This procedure is useful if you have not yet defined your 
instrument index in SmartPlant Instrumentation.  For more information, see Import Instrument 
Index (on page 93). 
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Import Instrument Properties 
Use this procedure to import one or more properties of instrument tag numbers.  In this 
procedure, you use the Single table import method and select the COMPONENT table as the 
target table for data import.  This procedure is useful if you have already created instrument index 
in SmartPlant Instrumentation and only need to assign certain properties to a large number of 
existing tag numbers.  These properties can be custom field values, supporting table values, or 
text string properties, such as Service, Note, and so forth.  For more information, see Import 
Instrument Properties (on page 94). 
 
 

Prerequisite for Importing Instrument Types 
The current prerequisite only applies if you want to define instrument types in your source and do 
not want to map them to instrument types shipped with SmartPlant Instrumentation.  Before 
defining source table columns as data fields holding instrument type abbreviations and instrument 
type descriptions, you must ensure that the values in the source table columns comply with the 
conventions used in SmartPlant Instrumentation. 
After you select the source table columns to be used as the instrument type name (abbreviation) 
and description, when importing data, the Import Utility creates in SmartPlant Instrumentation new 
instrument types and instrument type descriptions according to the existing conventions.  For 
example, when importing instrument type abbreviation, all characters exceeding the first six 
characters are truncated.  To carry out a successful import, you need to select the source table 
columns which are most compatible with the SmartPlant Instrumentation instrument type, 
instrument type description, and process function conventions. 
Use the following table as guidelines when selecting source table columns and setting them as 
instrument type abbreviation fields and instrument type description fields: 

Instrument Type 
Parameter 

SmartPlant Instrumentation 
Conventions 

Abbreviation maximum 
length 

6 characters 

Abbreviation typeface Upper case (for example, FY – not 
– fy or Fy) 

Description maximum 
length 

40 characters 

  Both instrument type abbreviation and description are required parameters.  A 
combination of instrument type abbreviation and description must be unique. 

See Also 
Import Instrument Index (on page 93) 
Import Instrument Properties (on page 94) 
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Enable Creation of Complementary Elements for Instrument 
Index 

Prerequisite 
 Make sure that the appropriate instrument type profile definitions exist in target domain. 

1. On the Link Definitions dialog box, in the Link box, type a unique link name. 
2. Under Import method select one of the following: 

 Select Module (multiple tables), and then, under Name of module or table, select 
Instrument Index. 

 Select Single table, and then, under Name of module or table, select COMPONENT or 
any other instrument index-related table. 

3. Complete the import link creation. 
4. Open the Link Properties dialog box, and click the General tab. 
5. Under Create complementary elements, select check boxes for the elements that you want 

to create.  You can create any of the following elements: 
 A device panel and a cable for an instrument whose instrument type profile includes 

wiring, and which has the following default elements: panel, cable, and connection type. 
 A document number row and a default revision row (which is initially empty) in the 

DRAWING table for a specification, process data sheet and calculation sheet. 
 Instrument associations with an existing I/O type, location, and hook-up. 

See Also 
Import Links (on page 15) 
Link Properties (see "Import Link Properties" on page 24) 
 

Set Source Fields as Instrument Type Fields 
1. On the Link Properties dialog box, click the Source tab. 
2. Under Process Function, click Define. 
3. If this is the first time you are running the link, on the Define Instrument Type Fields dialog 

box, which opens automatically, do the following: 
a. From the Source pane, drag one or more source table columns to the Instrument type 

name pane.  The values in the source column fields become instrument type abbreviation 
fields after data import. 

b. From the Source pane, drag one or more source table columns to the Instrument type 
description pane.  The values in the source column fields become instrument type 
description fields after data import. 

 
 You can use concatenated sources.  For details, see Example of Concatenated Sources 

(on page 95). 
 Instrument type abbreviation characters that exceed six characters are truncated.  For 

details about instrument type conventions that exist in SmartPlant Instrumentation, see 
Prerequisite for Importing Instrument Types (on page 90). 

4. Click OK to close the Define Instrument Type Fields dialog box. 
5. On the Process Function Mapping dialog box, for each instrument type in the left section, 

drag the appropriate process function from the right section to either a light-blue field 
(unassigned process function) or a white field (previously assigned process function) in the 
Process function column next to the appropriate instrument type. 
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6. To filter the instrument type fields displayed in the left pane, under Display process function 
assignments, do one of the following: 
 Select All to display assigned and unassigned instrument types. 
 Select Unassigned only to display only instrument types which are not assigned yet with 

process functions. 
 Select Assigned only to display only instrument types which are assigned with process 

functions. 

 
 If you previously imported instrument types using the current link, some of the instrument 

types are already assigned to process functions and exist in SmartPlant 
Instrumentation.  These instrument types are displayed in a gray background, and you 
cannot reassign the process functions for them. 

 The Process Function Mapping dialog box displays all the source fields that belong to 
the source table columns you set as instrument type and description columns on the 
Define Instrument Type Fields dialog box. 

7. When done, click OK to return to the Source tab. 
8. On the Source tab, under Process function, select Assign. 
9. Click OK. 

  When you open the Import Link window, the process function macro 
@PROC_FUNC_NAME appears in the Source Name column mapped to the 
PROC_FUNC_NAME column.  You do not need to define any manual mapping for the process 
function and instrument type fields.  When importing data, the software uses the source fields that 
you set as the instrument type fields. 

See Also 
Formulas and Arithmetic Functions in Import Links (on page 66) 
 

Associate Source Fields with Existing Instrument Types 
1. On the Link Properties dialog box, click the Source tab. 
2. Under Process Function, click Define. 
3. If this is the first time you are running the link, on the Define Instrument Type Fields dialog 

box, which opens automatically, do the following: 
a. From the Source pane, drag one or more source table columns to the Instrument type 

name pane.  The values in the source columns become instrument type abbreviation 
fields after data import. 

b. From the Source pane, drag one or more source table columns to the Instrument type 
description pane.  The values in the source columns become instrument type 
description fields after data import. 

 
 You can use concatenated sources.  For details, see Example of Concatenated Sources 

(on page 95). 
 Instrument type abbreviation characters that exceed six characters are truncated.  For 

details about instrument type conventions that exist in SmartPlant Instrumentation, see 
Prerequisite for Importing Instrument Types (on page 90). 

4. Click OK to close the Define Instrument Type Fields dialog box. 
5. On the Process Function Mapping dialog box, click Instrument Type to open the 

Instrument Type Mapping dialog box. 
6. From the Instrument types pane, drag an instrument type to each field displayed in the 

Instrument type mapping to source pane. 
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7. Click OK to return to return to the Process Function Mapping dialog box. 
8. On the Process Function Mapping dialog box, click OK. 
9. On the Source tab, under Process function, select Assign. 
10. Click OK. 

  When you open the Import Link window, the process function macro 
@PROC_FUNC_NAME appears in the Source Name column mapped to the 
PROC_FUNC_NAME column.  You do not need to define any manual mapping for the process 
function and instrument type fields.  When importing instrument tags, the software uses the 
source fields that you set as the instrument type field to automatically associate the tags with the 
appropriate instrument types. 

See Also 
Formulas and Arithmetic Functions in Import Links (on page 66) 
 

Import Instrument Index 

Prerequisites 
 Make sure that the tag numbers or tag number segments in the import source are compatible 

with the naming convention that is defined in the target <unit> of SmartPlant Instrumentation. 
 Make sure that the import source contains instrument type name, description, and process 

function definitions.  For details about process function codes that exist in SmartPlant 
Instrumentation, see Process Function Mapping Codes for Instrument Index Import (on 
page 69). 

1. On the Link Definitions dialog box, create an import link as follows: 
a. In the Link box, type a unique link name. 
b. Under Import method, select Module (multiple tables). 
c. Under Name of module or table, select Instrument Index. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and do the following: 
a. If you want to import instruments that exist into more than one <unit>, on the Import Level 

tab, under Hierarchy levels, select Apply and also select the lowest plant hierarchy 
level.  For details, see Import Data Into Multiple Plant Hierarchy Items (on page 87). 

b. If needed, on the General tab, enable creation of complementary elements according to 
instrument type profiles of the source tags.  For details, see Enable Creation of 
Complementary Elements for Instrument Index (on page 91). 

c. On the General tab, make sure that Import to supporting tables only is cleared.  If you 
select this check box, you cannot import tag numbers using this import link but only 
supporting table data. 

d. If you do not want to create any loop numbers, on the Tag/Loop tab, clear the Use loop 
reference data check box. 

3. In the Import Link window, open the import link. 
4. In the Target pane, define the import mapping as follows: 

a. If you have instruments belonging to more than one tag class, define a mapping value for 
the Tag Class (CMPNT_CAT_ID) column.  For details, see Tag Class Mapping Codes 
for Instrument Index Import (on page 68). 

b. Select the Tag No field, and then, from the Source pane, drag the column containing the 
tag numbers. 
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c. If you want to import data into instrument index supporting tables, define mapping for the 
supporting table names (indicated by bold blue font in the Target pane), and then map the 
fields that you need. 

d. Map the process function column PROC_FUNC_NAME, instrument type abbreviation 
column CMPNT_FUNC_TYPE_NAME and instrument type description column 
CMPNT_FUNC_TYPE_DESC. 
  You can set the software to use the @PROC_FUNC_NAME macro instead of mapping 

the process function and instrument type fields.  The software runs this macro if you have 
assigned process functions to instrument type fields using the Source tab options of Link 
Properties dialog box.  The macro appears in the Import Link window mapped 
automatically to the PROC_FUNC_NAME column.  For details, see Set Source Fields as 
Instrument Type Fields (on page 91). 

5. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

  If you want to import line P&ID drawing references and assign them to the imported tag 
numbers, you must map the same source P&ID column to the following columns in the Target 
pane: P&ID (DWG_NAME) and LineP&ID (DWG_NAME).  This is because the Import Utility 
does not support automatic association of line P&ID drawing references with tag numbers. 

6. Import the data. 
  After importing supporting table data, the imported values appear in SmartPlant 

Instrumentation in two places: Tag Number Properties dialog box and the appropriate supporting 
table dialog boxes.  This is because primary key columns of supporting tables (those with the _ID 
suffix) have reference foreign key columns in the COMPONENT table, which holds tag numbers in 
the CMPNT_ID column. 

See Also 
Defining Import Link Properties Common Tasks (on page 24) 
Set Column Display for the Module Import Method (on page 30) 
Example of Concatenated Sources (on page 95) 
Matching Naming Conventions (on page 81) 
 

Import Instrument Properties 

Prerequisite 
If you want to import an instrument property and this property is a supporting table value, make 
sure that this value already exists in the appropriate supporting table in SmartPlant 
Instrumentation.  For example, if you want to assign a Field location to a number of instruments, 
make sure that Field is defined in the Instrument Locations supporting table.  If, however, you 
want to import a new instrument property and also insert it into a supporting table, you need to use 
another procedure.  For details, see Import Instrument Index (on page 93). 
1. On the Link Definitions dialog box, create an import link as follows: 

a. In the Link box, type a unique link name. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select COMPONENT. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and do the following: 
a. If you want to import data to instruments that exist in more than one <unit>, on the Import 

Level tab, under Hierarchy levels, select Apply and also select the lowest plant 
hierarchy level.  For details, see Import Data Into Multiple Plant Hierarchy Items (on 
page 87). 
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b. On the Tag/Loop tab, clear the Use loop reference data check box if you do not want to 
import loop properties. 

3. In the Import Link window, open the import link. 
4. In the Target pane, define the import mapping as follows: 

a. If you have instruments belonging to more than one tag class, define a mapping value for 
the Tag Class ( CMPNT_CAT_ID) column.  For details, see Tag Class Mapping Codes 
for Instrument Index Import (on page 68). 

b. Select the Tag No field, and then, from the Source pane, drag the column containing the 
tag numbers. 

c. Define mapping for the instrument properties that you want to insert into the 
COMPONENT table for the mapped tag numbers. 
  If you want to associate the source tag numbers with lines that exist in SmartPlant 

Instrumentation, note that the Import Utility does not associate P&ID drawing references of 
lines with tag numbers automatically.  If you want to assign line P&ID drawing references to 
the source tag numbers, you must define mapping for both LINE_NUM/LINE_ID and 
DWG_NAME/DWG_ID columns in the Target pane. 

5. Import the data. 
  After importing supporting table data, the imported values appear as assigned to the 

appropriate instruments in the Tag Number Properties dialog box. 

See Also 
Defining Import Link Properties Common Tasks (on page 24) 
 

Example of Concatenated Sources 
The following example refers to the use of concatenated sources on the Define Instrument Type 
Fields dialog box, where you set source fields as instrument type fields.  You can also use 
concatenated sources in any field in the Import Link window, when mapping source and target 
columns. 
Suppose that your data source contains the following columns: cmpnt_func_type_name column 
holding source instrument type names and cmpnt_func_type_desc column holding source 
instrument type descriptions.  On the Define Instrument Type Fields dialog box, you can move 
both columns to the Instrument type description pane and specify sub-string parameters as 
follows: 
cmpn_func + cmpnt_name(2,5) 
The imported instrument type description is made up of the source instrument type plus five 
characters of the source description starting from the second character. 
Now, suppose that you specify the following concatenated string: 
cmpn_func + cmpnt_name(2) 
The imported instrument type description is made up of the source instrument type plus all the 
characters of the source description starting from the second character. 
 
 
 

Creating Specifications by Data Import Common Tasks 
The following tasks are used when creating specifications in SmartPlant Instrumentation by 
importing data from a predefined source. 
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Create Specs Using the Module Import Method 
Use this procedure if you want to create instrument specs based on the same spec form and all of 
your source instrument tags belong to the same process function as the target spec form.  You 
can also import revisions from the source and create process data sheets.  For more information, 
see Create Specs Using the Module Import Method (on page 96). 

Create Specs Using the Single Table Import Method 
This procedure is useful if you want to create specs based on various spec forms for a specific 
item type, for example, instrument specs, cable specs, panel specs, and so forth.  For more 
information, see Create Specs Using the Single Table Import Method (on page 98). 

Create a Multi-Tag Spec by Data Import 
Use this procedure if you want to create a multi-tag spec with SEE LIST columns in SmartPlant 
Instrumentation.  For more information, see Create a Multi-Tag Spec by Data Import (on 
page 99). 
 
 

Create Specs Using the Module Import Method 

Prerequisites 
 In SmartPlant Instrumentation, create a target spec form with the appropriate process 

function. 
 Make sure that the instrument tags in your source already exist in SmartPlant Instrumentation. 
 Make sure that all the source tags have the same process function as the target spec 

form.  Tags that do not have the same process function are rejected by the Import Utility and 
you cannot import data from your source. 

1. On the Link Definitions dialog box, create an import link as follows: 
a. In the Link box, type a unique link name. 
b. Under Import method, select Module (multiple tables). 
c. Under Name of module or table, select Specifications. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and click the Specs tab. 
3. Under Specifications module, do the following: 

a. From the Specification form list, select the target spec form. 
b. Clear Import to multiple- item specification sheets. 

4. Under Specification sheet options, to define the target spec document numbers, do one of 
the following: 
 Select Use custom drawing name to import spec document numbers from the 

source.  You can then map the Spec Drawing Name field in the Import Link window. 
 Clear Use custom drawing name to set the Import Utility to create specs with default 

document numbers. 
 Document numbers in the import source must be unique for each instrument. 

5. Select Include revisions in import to import spec revisions from the source.  You can then 
map the Spec Revision No field in the Import Link window. 

 If you clear this check box, you cannot import any specification revision data using the 
current import link. 
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6. Select Use custom drawing name for process data to import source document numbers 
for process data sheets.  You can then map the Process Data Drawing Name field in the 
Import Link window. 

 
 Even if the target spec form does not contain fields from process data tables and you do 

not import any process data value with the spec, after you map the document numbers for 
process data sheets and run the import process, the Import Utility creates an empty 
process data sheet in SmartPlant Instrumentation and associates it with the instrument for 
which you created the spec. 

 If you clear this check box, if you import any process data value, when creating a spec, the 
Import Utility also creates a process data sheet and assigns a default document number 
to the process data sheet. 

 Document numbers in the import source must be unique for each instrument. 
7. In the Import Link window, open the import link. 
8. In the Target pane, define the import mapping as follows: 

a. If the source tag does not have process data cases, in the CASE_NAME field, type '' (or '*' 
if the database platform is SQL Server). 

b. Select the Tag No field, and then, from the Source pane, drag the column containing the 
tag numbers. 

c. Depending on the link properties, define mapping for the Spec Drawing Name, Spec 
Revision No, and Process Data Drawing Name fields. 

d. If you define mapping process data fields belonging to the PD_GENERAL table, map the 
Upstream Condition field, which is actually the Fluid State field.  For details, see Fluid 
State Mapping Codes for Process Data Import (on page 69). 

9. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

10. Import the data. 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
Process Function Mapping Codes for Instrument Index Import (on page 69) 
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Create Specs Using the Single Table Import Method 

Prerequisites 
 In SmartPlant Instrumentation, create the target spec forms. 
 Make sure that the spec form numbers in your source match the target spec forms in 

SmartPlant Instrumentation. 
 Make sure that the items in your source already exist in SmartPlant Instrumentation, for 

example, instrument, cables, panels, and so forth. 
 If you want to create instrument specs, make sure that the process functions of the source 

tags match the process functions of the target form.  Tags that do not have the same process 
function will be rejected by the Import Utility and you will not be able to perform data import 
from your source. 

  When creating specs using the Single table method, the Import Utility does not 
validate whether the process function of source tags matches the process function of the target 
form.  Therefore, to prevent database problems in SmartPlant Instrumentation after data import, 
you must exercise extreme caution when defining tag process functions in the source columns. 
1. On the Link Definitions dialog box, create an import link as follows: 

a. In the Link box, type a unique link name. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select SPEC_SHEET_DATA. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and then, on the General tab, under Create 
complementary elements do one of the following: 
 Select the Create check box beside Drawing & Revision to create automatically a 

default document number for each spec and insert a zero revision row for each spec 
(invisible the SmartPlant Instrumentation interface). 

 Clear the Create check box beside Drawing & Revision if you want to map the document 
numbers and revisions from the source or if you do not want to create any document 
numbers or revisions for specs during the import process. 

3. Click the Specs tab, and then, from the Specification item type list, select the item type for 
which you want to create specs. 

4. In the Import Link window, open the import link. 
5. In the Target pane, define the import mapping as follows: 

a. If the selected item type is Instrument but the source tags do not have process data 
cases, in the CASE_NAME/CASE ID field, type '' (or '*' if the database platform is SQL 
Server). 

b. Select the item type field (the Tag Number field if you want to create instrument specs), 
and then, from the Source pane, drag the column containing the source items. 

c. Map the SPEC FORM CNUM/SPEC FORM ID column to match the source and target 
form numbers. 

d. If you want to import document numbers and revisions from the source, map the DWG 
NAME/DWG ID column to import the document numbers from the source and also map 
the REV NO/REV ID column to import the source revisions. 

6. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

7. Import the data. 
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Create a Multi-Tag Spec by Data Import 

Prerequisites 
 Make sure that the instrument tags that you want to include in a multi-item spec exist in 

SmartPlant Instrumentation. 
 In SmartPlant Instrumentation, create a target spec form and generate a format with SEE LIST 

fields. 
 In your import source, define all the instrument tags you want to include in the multi-tag 

spec.  The first tag in your source column becomes the master tag in the created spec.  In the 
same import source, define the target columns and column values. 

1. On the Link Definitions dialog box, create an import link as follows: 
a. In the Link box, type a unique link name. 
b. Under Import method, select Module (multiple tables). 
c. Under Name of module or table, select Specifications. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and click the Specs tab. 
3. From the Specification item type list, select Instrument. 
4. Under Specifications module, do the following: 

a. From the Specification form list, select the target spec form for which you defined a 
multi-tag list format. 

b. Select Import to multiple- item specification sheets. 
c. From the Specification format list, select the target format. 

  The Use custom drawing name check box is selected automatically because you 
must define manually one document number for all the instrument tags when mapping the 
source and target table columns in the Import Link window. 

5. In the Import Link window, open the import link. 
6. In the Target pane, define the import mapping as follows: 

a. If the source tags do not have process data cases, in the CASE_NAME field, type '' (or '*' 
if the database platform is SQL Server). 

b. Select the Tag No field, and then, from the Source pane, drag the column containing the 
tag numbers. 

c. In the Spec Drawing Name field, type one alpha-numeric value for the multi-tag spec 
document number you want to create. 

7. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

8. Import the data. 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
Fluid State Mapping Codes for Process Data Import (on page 69) 
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Importing Revisions 
The Import Utility allows you to import revision data into any document that has a document 
number.  Therefore, your import source must contain a column with document numbers that 
already exist in SmartPlant Instrumentation.  When importing data, the Import Utility matches the 
source and target document numbers and imports the revision data into the appropriate 
document, be it a calculation or process data sheet, a spec, or any other document for which it is 
possible to define revisions in SmartPlant Instrumentation. 
In the database, revision data is stored in the REVISION table columns.  There are two types of 
revision data fields: custom fields (REV_UDF columns) and non-custom (other than 
REV_UDF).  Non-custom fields appear in SmartPlant Instrumentation on the Revisions dialog 
box and in document title block fields.  You can import data to any of these fields.  Custom fields 
do not appear in the SmartPlant Instrumentation interface by default.  You can add custom fields 
as additional revision fields when customizing title blocks in InfoMaker.  You cannot import data 
into the REV_UDF fields.  The required columns for import mapping are DWG_NAME (document 
number) and REV_NO (revision number). 
If you assign an import link to the Single table import method and select the REVISION table, you 
can import revision data to any SmartPlant Instrumentation document, provided that the target 
document and the import source have the same document number.  If you assign an import link to 
the Module (multiple tables) import method, and select the Process Data or Specifications 
module, you need to define revision import options on the Link Properties dialog box ( General 
tab options for importing process data or calculation sheet revisions, or Specs tab for importing 
specification revisions). 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
Map Source and Target Fields Common Tasks (on page 61) 
 

Import Revisions into the Revision Table 
Use this procedure to import revisions to any document in SmartPlant Instrumentation. 

 The following are prerequisites before importing revisions into the Revisions table: 
 Make sure that the documents for which you want to import revisions already exist in 

SmartPlant Instrumentation. 
 Make sure that the document numbers are defined both in the import source and in the 

target documents. 
1. On the Link Definitions dialog box, create an import link as follows: 

a. In the Link box, type a unique link name. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select REVISION. 
d. Complete the import link creation. 

2. On the Link Properties dialog box, define the import link properties as you require. 
3. In the Import Link window, open the import link. 
4. In the Target pane, define the import mapping as follows: 

a. Select the DWG NAME/DWG ID field, and then, from the Source pane, drag the column 
containing the source document numbers. 

b. Select the REV NO field, and then, from the Source pane, drag the column containing the 
source revision numbers. 

5. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 
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  You cannot import data into the REV UDF fields.  These fields are custom fields that 
you can add as additional revision fields when customizing title blocks in InfoMaker.  You can 
import revision values to any non-custom fields (other than REV UDF).  The display names of 
these fields are shown on the Revisions dialog box in SmartPlant Instrumentation. 

6. Import the data. 

See Also 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
Map Source and Target Fields Common Tasks (on page 61) 
 

Import Process Data and Calculation Sheet Revisions 
Use this procedure if you only want to import process data revisions.  You can also set the 
software to create a calculation sheet and import calculation sheet revisions when importing 
process data revisions. 

 Before importing process data and calculation sheet revision, make sure that the tag 
numbers for which you want to import process data or calculation sheet revisions already exist in 
SmartPlant Instrumentation. 
1. On the Link Definitions dialog box, create an import link as follows: 

a. In the Link box, type a unique link name. 
b. Under Import method, select Module (multiple tables). 
c. Under Name of module or table, select Process Data. 
d. Complete the import link creation. 

2. On the General tab of the Link Properties dialog box, select a combination of the following 
check boxes: Import revisions, Use custom drawing names, and Create calculation 
sheet.  Use the following table as a guide to the check box selection combinations you can 
use and the data for which you need to define the links: 

Data to Link Import revisions  Use custom drawing 
names 

Create calculation sheet  

Process data revisions Select Clear Clear 

Process data sheet 
document numbers 

Clear Select Clear 

Process data sheet 
document numbers and 
revisions 

Select Select Clear 

Calculation data Clear Clear Select 

Calculation and process 
data sheet revisions 

Select Clear Select 

Calculation and process 
data sheet document 
numbers 

Clear Select Select 

Calculation and process 
data sheet document 
numbers and revisions 

Select Select Select 

3. Define other properties for the link as you require. 
4. In the Import Link window, open the import link. 
5. In the Target pane, define the import mapping as follows: 
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a. Map the Tag Number and Case Name fields by dragging the appropriate column names 
from the Source pane. 

b. Map the appropriate revision and document number (drawing name) fields by dragging 
the appropriate column names from the Source pane. 

 If the source tags do not have process data cases, in the Case Name field, type '' (or '*' 
if the database platform is SQL Server). 

6. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

7. Import the data. 
 

Importing Wiring Data 
You can use the Import Utility to create wiring data in SmartPlant Instrumentation.  Wiring data 
import includes wiring items such as panels, cable, wires, and so forth, and also includes various 
wiring connections, signal propagation, and I/O assignments.  In the SmartPlant Instrumentation 
database, wiring data is defined at a <plant> level.  This means that you do not have to specify the 
import level when defining import link properties because the default import level is <plant>.  In 
the SmartPlant Instrumentation Domain Explorer, wiring items that you import appear in the 
appropriate wiring item category folders displayed at a <plant> level.  It is possible, however, to 
import wiring items at a <unit> level if needed.  For example, if you want device panels and device 
cables to appear in the <unit> to which the associated instrument tags belong, you need to import 
the device panels and device cables items at a <unit> level.  In the Domain Explorer, you can 
then filter the imported panels and cables per <unit>. 
SmartPlant Instrumentation allows you to use non-unique wiring item names.  This is, however, 
not possible in the Import Utility because the default table definitions used in import links require 
name uniqueness.  If you are an advanced user, you can define a new table definition to enable 
the software to import items with non-unique names. 
SmartPlant Instrumentation allows you to import complex wiring item hierarchies. 
If you imported data incorrectly into your <plant>, you might have to delete your plant or spend a 
lot of time fining the problems manually.  Since wiring data import involves data insertion into so 
many tables and because wiring data import links are likely to be complex due to a large number 
of mapped columns in various tables, we recommend that you create a special domain where you 
can check the import results.  After you are satisfied with the results, you can export the import 
links and then import them into the domain into which you want import wiring data.  For details, 
see Moving Links Between Databases or Domains (on page 16). 
You can either import wiring data using the Single table import method or Single table import 
method + reference tables.  Selecting the method for wiring data import largely depends on your 
import source.  If your import source includes several files with wiring item definitions, for each 
file, you can create an individual single-table import link as you require.  Single-table links are 
easy to manage and troubleshoot.  If your import source is complex and contains, for example, 
panels with corresponding cables for each panel, you can include reference tables into the link. 
A link whose properties include data insertion into reference tables allows you to import wiring 
data into a specific table that you selected when creating the link and also import data into any 
related table depending on your import source.  Note, however, that such a link opens more 
slowly than a single-table link due to a large number of reference tables that a given wiring table 
has.  Also, when running such a link, you are more likely to come across various errors due to the 
mapping complexity.  Troubleshooting these errors may be time consuming.  In any case, before 
importing wiring data, familiarize yourself with the structure of wiring items in the SmartPlant 
Instrumentation Demonstration database (IN_DEMO.db). 
You can actually import most of your wiring data by running just three complex links created for the 
following tables: PANEL_STRIP_TERM, WIRE, and WIRE_TERMINAL.  When importing data 
into the PANEL_STRIP_TERM table and its reference tables, you can import all related panel 
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information such as panels, terminal strips, terminals, and so forth.  When importing data into the 
WIRE table and its reference tables, you can import all the related cable information such as cable 
sets, wires, wire colors, and so forth.  When importing data into the WIRE_TERMINAL table and 
its reference tables, you can import all the connections between panels and cables.  You can 
create a link group with these links and import all your panels, cables and connections in batch 
mode. 

  The Wiring module is unavailable for assigning to an import link. 
 
 

Importing Wiring Data Common Tasks 
The following tasks are used when importing instrument tags and loops. 

Import Cables, Cable Sets, and Wires 
Use this procedure to import cables and their child items.  The hierarchy of cables and their child 
items is rigid: cables, cable sets, and wires.  Depending on the DEF_FLG flag mapping in the 
Import Link window, in SmartPlant Instrumentation, imported cables appear either in the 
Reference Explorer as reference cables, or in the Domain Explorer as actual <plant> cables or 
<plant> cross cables.  You can import cables and their child items in one of the following ways: 
 Defining one import link for the WIRE table and enabling the software to insert data into the 

reference tables 
 Defining individual import links for the CABLE, CABLE_SET, and WIRE tables and then 

running them in the following order: cables, cable sets, wires. 
For more information, see Import Cables, Cable Sets, and Wires (on page 110). 

Import Panels 
Use this procedure to import panels.  In the SmartPlant Instrumentation database, all panels, 
regardless of the panel category, are stored in the PANEL table; therefore, to distinguish between 
various panel categories, in the Import Link window, you must specify correct mapping for the 
panel category you want to import and also map the panel sub- category.  Note that wiring 
equipment is stored in the APPARATUS table, whereas, apparatuses appear in the CHANNEL 
table.  Table names of other panel constituents are easy to recognize because they include the 
actual item names in SmartPlant Instrumentation; for example, columns of the 
PANEL_STRIP_TERM table hold all terminals.  For more information, see Import Panels (on 
page 104). 

Import Device Panels as Cabinet Child Items 
This scenario enables you to import device panels so that they appear under cabinets in the 
Domain Explorer in SmartPlant Instrumentation.  In this scenario, you must create a new table 
definition and add an appropriate foreign key for the PANEL table.  If you are an advanced user 
having in- depth knowledge of the SmartPlant Instrumentation database, you can use this 
scenario as a basis for importing panels and their constituents in any way you need.  For more 
information, see Import Device Panels as Cabinet Child Items (on page 106). 

Import Terminal Strips and Terminals 
Use this procedure to import terminal strips and terminals.  In the SmartPlant Instrumentation 
database, the PANEL_STRIP table holds terminal strips and the PANEL_STRIP_TERM table 
holds terminals.  For more information, see Import Terminal Strips and Terminals (on page 109). 
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Import Wiring Equipment 
Use this procedure to import wiring equipment.  In the SmartPlant Instrumentation database, 
wiring equipment appears in the APPARATUS table.  Note, however,  that apparatuses appear 
in the CHANNEL table.  For more information, see Import Terminal Strips and Terminals (on 
page 109). 

Import Cables, Cable Sets, and Wires 
Use this procedure to import cables and their child items.  The hierarchy of cables and their child 
items is rigid: cables, cable sets, and wires.  Depending on the DEF_FLG flag mapping in the 
Import Link window, in SmartPlant Instrumentation, imported cables appear either in the 
Reference Explorer as reference cables, or in the Domain Explorer as actual <plant> cables or 
<plant> cross cables.  You can import cables and their child items in one of the following ways: 
 Defining one import link for the WIRE table and enabling the software to insert data into the 

reference tables 
 Defining individual import links for the CABLE, CABLE_SET, and WIRE tables and then 

running them in the following order: cables, cable sets, wires. 
For more information, see Import Cables, Cable Sets, and Wires (on page 110). 

Import Wiring Connection Data 
Use this procedure to import wiring connections with or without signal propagation.  For more 
information, see Import Wiring Connection Data (on page 111). 
 
 

Import Panels 
1. Create a link group for placing the link you are going to create and also links defined for panel 

constituents, for example, wiring equipment, terminal strips, and terminals. 
2. On the Link Definitions dialog box, create an import link for panels as follows: 

a. In the Link box, type a unique link name, for example Panels. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select PANEL. 
d. Complete the import link creation. 

3. Open the Link Properties dialog box, and, on the General tab, do the following: 
a. Make sure that Import to supporting tables is cleared. 
b. Under Undefined NOT NULL fields, select Reject rows. 

 Selecting Reject rows is recommended to set the software to reject all source values 
that do not match foreign key values in the PANEL table.  For example, if a panel 
manufacturer in your source does not match the manufacturer that already exists in 
SmartPlant Instrumentation, the software indicates that this manufacturer does not exist.  If 
you select the Use default value, in the PANEL table, the Import Utility will enter 0 (zero) 
values in all the columns whose values do not match the values in the import source. 

4. If your import source contains device panels, and you need to associate them with 
instruments that exist in various <units> in SmartPlant Instrumentation, on the Import Level 
tab, under Hierarchy levels, select Apply and also select the lowest plant hierarchy 
level.  For details, see Import Data Into Multiple Plant Hierarchy Items (on page 87). 

 
 If your import source contains device panels, we recommend that the target <unit> for 

importing device panels be the same as the <unit> where the associated instrument tags 
appear. 
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 Although, <plant> is the default import level for wiring data, specifying a <unit> level for 
wiring items allows you to filter the imported wiring data per <unit> in the Domain 
Explorer. 

5. In the Import Link window, open the import link. 
6. In the Target pane, define the import mapping as follows: 

a. Click the PANEL_NAME row, and then, from the Source pane, drag the column 
containing the panel names. 

b. Depending on your source panel type, define a mapping value for the 
PANEL_CATEGORY and PANEL_SUB_CATEGORY columns.  For details, see 
Mapping Codes for Wiring Data Import (on page 70). 

c. For the DEF_FLG flag, enter N so that the in SmartPlant Instrumentation, the imported 
panels appear in the Domain Explorer. 

d. If you need to specify a panel location, for the PANEL_LOC_NAME/PANEL_LOC_ID 
column, enter the target location, for example, Building+'/'+Room 

 
In SmartPlant Instrumentation, the imported panel location hierarchy appears in the folder 
Panels by Location. 
If you define Y as a mapping value for the DEF_FLG flag, in SmartPlant Instrumentation, the 
imported items appear in the Reference Explorer. 

7. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

8. In the link group containing links defined for panels and their constituent items, prioritize the 
links so that the Panels link has the highest priority.  For details, see Prioritize Links in a Link 
Group (on page 13). 

9. Run the links in this order. 
  If you must create a single link for importing panels and their child items, you need to 

select PANEL_STRIP_TERM as the target table and also select Insert data into reference 
tables check box on the Link Properties dialog box.  Bear in mind that such a link opens more 
slowly than a single-table link due to a large number of reference tables that the 
PANEL_STRIP_TERM table has.  Also, when running such a link, you are more likely to come 
across various errors due to the mapping complexity.  Troubleshooting these errors may be time 
consuming. 
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Import Device Panels as Cabinet Child Items 
 The following are prerequisites before importing device panels as cabinet child items: 

 Make sure you first import or create all the target cabinets. 
 Make sure that your import source contains the device panels that you want to import and 

the cabinets under which you want the device panels to appear in SmartPlant 
Instrumentation. 

1. On the Link Definitions dialog box, create an import link for panels as follows: 
a. In the Link box, type a unique link name, for example Device Panels Within Cabinets. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select Panel. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and, on the General tab, do the following: 
a. Make sure that Import to supporting tables is cleared. 
b. Under Undefined NOT NULL fields, select Reject rows. 

 Selecting Reject rows is recommended to set the software to reject all source 
values that do not match foreign key values in the PANEL table.  For example, if a cabinet 
model in your source does not match the model that already exists in SmartPlant 
Instrumentation, the software indicates that this model does not exist.  If you select the 
Use default value, in the PANEL table, the Import Utility will enter 0 (zero) values in all 
the columns whose values do not match the values in the import source. 

3. Since your import source contains device panels, you will need to associate them with 
instruments that exist in various <units> in SmartPlant Instrumentation.  Therefore, on the 
Import Level tab, under Hierarchy levels, select Apply and also select the lowest plant 
hierarchy level.  For details, see Import Data Into Multiple Plant Hierarchy Items (on page 87). 

 
 For an import source that contains device panels, we recommend that the target <unit> 

for importing device panels be the same as the <unit> where the associated instrument 
tags appear. 

 Although, <plant> is the default import level for wiring data, specifying a <unit> level for 
wiring items allows you to filter the imported wiring data per <unit> in the Domain 
Explorer. 

4. Click Table Definition and create a new table definition on the basis of the Default 
definition.  For details, see Create a Table Definition on the Basis of Another Definition (on 
page 48). 

5. To create a new key definition, do the following: 
a. Select Foreign Key and close the Foreign Key List pop-up window. 
b. Click Clear to clear the Key definition working area and then, from the Column 

definition pane, drag the PARENT_ID column to the Key definition working area. 



 Import Utility 
 

 

SmartPlant Instrumentation Import and Merger Utilities User's Guide 107 

c. Add the following key definition: 

 
d. In the Column definition pane, scroll right to display the Key Level column. 
e. Manually remove all the key levels from the PARENT_ID column. 
f. Save the new definition. 

 Adding the PARENT_ID foreign key into the PANEL table enables you to define cabinets 
as parent items of device panes in the same table.  The new key definition allows the Import 
Utility to find cabinet names in the PANEL_NAME column of the PANEL table and write the 
matching PANEL_ID column values into the PARENT_ID column. 

6. In the Import Link window, open the import link. 
7. In the Target pane, define the import mapping as follows: 

a. Click the PANEL_NAME row, and then, from the Source pane, drag the column 
containing the source device panel names. 

b. Click the PARENT_ID row, and then, from the Source pane, drag the column containing 
the cabinets within which you want the device panels to appear. 

c. For the PANEL_CATEGORY column, type 4 as the mapping value. 
d. For the PANEL_SUB_CATEGORY column, type 410 as the mapping value.  For details 

of various panel category mapping values, see Mapping Codes for Wiring Data Import (on 
page 70). 

e. For the DEF_FLG flag, enter N so that the in SmartPlant Instrumentation, the imported 
panels appear in the Domain Explorer. 
 If you define Y as a mapping value for the DEF_FLG flag, in SmartPlant Instrumentation, 

the imported items appear in the Reference Explorer. 
8. If needed, complete the import mapping by dragging the appropriate column names from the 

Source pane or by entering strings or values in the fields in the Target pane. 
9. Run the import link. 
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Import Wiring Equipment 
 Before importing wiring equipment, make sure you first import or create all the target 

panels.  In SmartPlant Instrumentation, wiring equipment is a child item of a panel. 
1. Create a link group for placing the link you are going to create and also links defined for panels 

and their constituents, such as terminal strips and terminals. 
2. On the Link Definitions dialog box, create an import link for panels as follows: 

a. In the Link box, type a unique link name, for example Wiring Equipment. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select APPARATUS. 
d. Complete the import link creation. 

3. Open the Link Properties dialog box, and, on the General tab, do the following: 
a. Make sure that Import to supporting tables is cleared. 
b. Under Undefined NOT NULL fields, select Reject rows. 

 Selecting Reject rows is recommended to set the software to reject all source values 
that do not match foreign key values in the APPARATUS table.  For example, if a wiring 
equipment model in your source does not match the model that already exists in SmartPlant 
Instrumentation, the software indicates that this model does not exist.  If you select the Use 
default value, in the APPARATUS table, the Import Utility will enter 0 (zero) values in all the 
columns whose values do not match the values in the import source. 

4. On the Link Properties dialog box, click Table Definition and do the following: 
a. On the Table Definition dialog box, click Definition. 
b. On the Table Definition Name dialog box, select the definition that you require. 

 If you do not find the definition that you require, you can create a new definition on the 
basis of the Default definition.  For details, see Create a Table Definition on the Basis of 
Another Definition (on page 48). 

5. In the Import Link window, open the import link. 
6. In the Target pane, define the import mapping as follows: 

a. Click the APPAR_NAME row, and then, from the Source pane, drag the column 
containing the wiring equipment names. 

b. Depending on your table definition, map the remaining required columns marked in red 
bold. 

c. Depending on your source wiring equipment type, define a mapping value for the 
CATEGORY NAME/APPAR_CAT_ID column.  For details, see Mapping Codes for 
Wiring Data Import (on page 70). 

d. For the DEF_FLG flag, enter N so that the in SmartPlant Instrumentation, the imported 
panels appear in the Domain Explorer. 
 If you define Y as a mapping value for the DEF_FLG flag, in SmartPlant Instrumentation, 

the imported items appear in the Reference Explorer. 
7. If needed, complete the import mapping by dragging the appropriate column names from the 

Source pane or by entering strings or values in the fields in the Target pane. 
8. If you have not imported panels yet, do the following: 

a. Add the created Wiring Equipment link into the group containing the link defined for 
importing panels. 

b. Prioritize the links so the Wiring Equipment link appears under the links defined for 
panels.  For details, see Prioritize Links in a Link Group (on page 13). 

c. Run the links in this order. 
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See Also 
Create a Link Group (on page 11) 
Defining Import Link Properties Common Tasks (on page 24) 
Mapping Codes for Wiring Data Import (on page 70) 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
 

Import Terminal Strips and Terminals 
 Before importing terminal strips and terminals, make sure you first import or create all 

the target panels. 
1. On the Link Definitions dialog box, create an import link for panels as follows: 

a. In the Link box, type a unique link name, for example Terminal Strips. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select PANEL_STRIP. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and, on the General tab, do the following: 
a. Make sure that Import to supporting tables is cleared. 
b. Under Undefined NOT NULL fields, select Reject rows. 

 Selecting Reject rows is recommended to set the software to reject all source values 
that do not match foreign key values in the PANEL_STRIP table.  For example, if a panel strip 
manufacturer in your source does not match the manufacturer that already exists in 
SmartPlant Instrumentation, the software indicates that this manufacturer does not exist.  If 
you select the Use default value, in the PANEL_STRIP table, the Import Utility will enter 0 
(zero) values in all the columns whose values do not match the values in the import source. 

3. On the Link Properties dialog box, click Table Definition and do the following:  
a. On the Table Definition dialog box, click Definition.  
b. On the Table Definition Name dialog box, select the definition that you require.  

 
 The Default definition is only suitable for importing terminal strips of DCS or PLC panels.  
 If you want to import terminal strips that do not have names, select the Panel Strip (by 

seq) definition.  
 If you want to import terminal strips of junction boxes, cabinets, device panels, or 

marshaling racks, select the Panel-Strip definition.  
 If you want to import terminal strips of wiring equipment, select the 

Panel-Apparatus-Strip definition, or a more complex definition, depending on the 
hierarchy of you wiring items.  

 If you do not find the definition that you require, you can create a new definition on the 
basis of the Default definition. For details, see Create a Table Definition on the Basis of 
Another Definition (on page 48). 

4. In the Import Link window, open the import link.  
5. In the Target pane, define the import mapping as follows:  

a. Click the STRIP_NAME row, and then, from the Source pane, drag the column containing 
the terminal strip names.  

b. Depending on your table definition, map the remaining required columns marked in red 
bold.  

c. Define a mapping value for the STRIP_CATEGORY column. For details, see Mapping 
Codes for Wiring Data Import (on page 70). 
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d. For the DEF_FLG flag, enter N so that the in SmartPlant Instrumentation, the imported 
panels appear in the Domain Explorer. 
 If you define Y as a mapping value for the DEF_FLG flag, in SmartPlant Instrumentation, 

the imported items appear in the Reference Explorer. 
6. If needed, complete the import mapping by dragging the appropriate column names from the 

Source pane or by entering strings or values in the fields in the Target pane.  
7. Repeat Steps 1-7 for creating a Terminals link for wires by selecting PANEL_STRIP_TERM 

as the target table and make sure you map all the required columns.  
8. If you have not imported panels and wiring equipment yet, do the following:  

a. Add the created links into the group containing links defined for panels and their 
constituent items.  

b. Prioritize the links so that the Terminal Strips link appears under the links defined for 
panels and wiring equipment and the Terminals link appears under Terminal Strips. For 
details, see Prioritize Links in a Link Group.  

c. Run the links in this order. 
 If you must create a single link for importing panels and their child items, you need to select 

PANEL_STRIP_TERM as the target table and also select Insert data into reference tables 
check box on the Link Properties dialog box. Bear in mind that such a link opens more slowly 
than a single-table link due to a large number of reference tables that the PANEL_STRIP_TERM 
table has. Also, when running such a link, you are more likely to come across various errors due to 
the mapping complexity. Troubleshooting these errors may be time consuming. 
 

Import Cables, Cable Sets, and Wires 
1. Create a link group for placing the links you are going to create. 
2. On the Link Definitions dialog box, create an import link for cables as follows: 

a. In the Link box, type a unique link name, for example Cables. 
b. Under Import method, select Single table. 
c. Under Name of module or table, select CABLE. 
d. Complete the import link creation. 

3. Open the Link Properties dialog box, and, on the General tab, do the following: 
a. Make sure that Import to supporting tables is cleared. 
b. Under Undefined NOT NULL fields, select Reject rows. 

 Selecting Reject rows is recommended to set the software to reject all source values 
that do not match foreign key values in the CABLE table.  For example, if a cable 
manufacturer in your source does not match the manufacturer that already exists in 
SmartPlant Instrumentation, the software indicates that this manufacturer does not exist.  If 
you select the Use default value, in the CABLE table, the Import Utility will enter 0 (zero) 
values in all the columns whose values do not match the values in the import source. 

4. If your import source contains device cables, and you need to associate them with 
instruments that exist in various <units> in SmartPlant Instrumentation, on the Import Level 
tab, under Hierarchy levels, select Apply and also select the lowest plant hierarchy 
level.  For details, see Import Data Into Multiple Plant Hierarchy Items (on page 87). 

 
 If your import source contains device cables, we recommend that the target <unit> for 

importing device cables be the same as the <unit> where the associated instrument tags 
appear. 
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 Although, <plant> is the default import level for wiring data, specifying a <unit> level for 
wiring items allows you to filter the imported wiring data per <unit> in the Domain 
Explorer. 

5. In the Import Link window, open the import link. 
6. In the Target pane, define the import mapping as follows: 

a. Click the CABLE_NUM row, and then, from the Source pane, drag the column containing 
the cable names. 

b. Depending on your source cable type, define a mapping value for the 
CABLE_CATEGORY column.  For details, see Mapping Codes for Wiring Data Import 
(on page 70). 

7. To determine whether to create imported items as cables or cross cables do one of the 
following: 
 For the DEF_FLG flag, enter N so that the in SmartPlant Instrumentation, the imported 

cables appear in the Domain Explorer in the Cables folder. 
 For the DEF_FLG flag, enter C so that the in SmartPlant Instrumentation, the imported 

cables appear in the Domain Explorer in the Cross Cables folder. 
  If you define Y as a mapping value for the DEF_FLG flag, in SmartPlant 

Instrumentation, the imported items appear in the Reference Explorer. 
8. If needed, complete the import mapping by dragging the appropriate column names from the 

Source pane or by entering strings or values in the fields in the Target pane. 
9. Repeat Steps 1-8 for creating a Cable Sets link for sable sets by selecting CABLE_SET as 

the target table and make sure you map all the required columns, which are shown in red bold. 
10. Repeat Steps 1-8 for creating a Wires link for wires by selecting WIRE as the target table and 

make sure you map all the required columns. 
11. In the link group, prioritize the links so that the Cables link appears at the top, Cable Sets in 

the middle and Wires at the bottom.  For details, see Prioritize Links in a Link Group (on 
page 13). 

12. Run the links in this order. 
  If you must create a single link for importing cables and their child items, you need to 

select WIRE as the target table and also select Insert data into reference tables check box 
on the Link Properties dialog box.  Bear in mind that such a link opens more slowly than a 
single-table link due to a large number of reference tables that the WIRE table has.  Also, 
when running such a link, you are more likely to come across various errors due to the 
mapping complexity.  Troubleshooting these errors may be time consuming. 

See Also 
Create a Link Group (on page 11) 
Defining Import Link Properties Common Tasks (on page 24) 
Mapping Codes for Wiring Data Import (on page 70) 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
 

Import Wiring Connection Data 
 Before importing wiring data, make sure you first import or create all the target cables, 

cable sets, and wires, panels, terminal strips, and terminals.  In SmartPlant Instrumentation, only 
terminal strips have terminals and you can only make wiring connections by connecting wires to 
terminals. 
1. On the Link Definitions dialog box, create an import link for cables as follows: 

a. In the Link box, type a unique link name, for example Connections. 
b. Under Import method, select Single table. 



Import Utility 
 

 
112 SmartPlant Instrumentation Import and Merger Utilities User's Guide 

c. Under Name of module or table, select WIRE_TERMINAL. 
d. Complete the import link creation. 

2. Open the Link Properties dialog box, and do the following: 
a. On the General tab, make sure that Import to supporting tables is cleared. 
b. Under Create complementary elements, select a check box beside Wire_group if you 

want the software to propagate existing signals automatically. 
c. Click Table Definition and create a new definition in accordance with the definition you 

specified when creating a link the PANEL_STRIP table.  For details, see Modify a Table 
Definition (on page 49). 

 The Default column definition for the WIRE_TERMINAL table only allows you to 
connect terminals of strips that appear directly under panels, for example, under DCS or PLC 
panels.  The Default definition is not suitable for importing connection data for any other 
panel type or wiring equipment because it does not contain any primary key from the 
APPARATUS table for mapping in the Import Link window.  Since terminal strips that belong 
to wiring equipment may not have unique names under the same panel, the new column 
definition for WIRE_TERMINAL table must also include a primary key from the APPARATUS 
table. 

3. In the Import Link window, open the import link. 
4. In the Target pane, map the following required columns: 

 CABLE_NUM/CABLE_ID — Target cable 
 CABLE_SET_NAME/CABLE_SET_ID — Target cable set 
 PANEL_NAME/PANEL_ID — Target panel 
 SET_LEVEL/WIRE_ID — Target wire level 
 STRIP_NAME/STRIP_ID — Target terminal strip 
 TERM_SEQ/TERM_ID — Target terminal sequence number 

 The list of the required columns appear in the Default table definition.  If you assigned a 
new table column definition to the WIRE_TERMINAL table, map the other required columns 
as appropriate. 

5. If you did not include automatic signal propagation in the link properties, you can import 
signals manually by map the following columns: 
 GROUP_NAME/WIRE_GROUP_ID — Signal name 
 GROUP_SEQ — Signal sequence 
 WIRE_GRP_LEVEL — Signal level 

 You can propagate signals either when a wire on one side of the target cable 
already carries a signal in SmartPlant Instrumentation or when the target terminal already has 
a signal, as in a device panel created according to an instrument type profile. 

6. If needed, complete the import mapping by dragging the appropriate column names from the 
Source pane or by entering strings or values in the fields in the Target pane. 

7. Run the link. 
 If you still need to import your wiring items such as panels, cables, and so forth, and want 

to group the current Connections link together with the other single-table links defined for 
wiring data import, make sure that the Connections link has the lowest priority in the 
group.  For details, see Prioritize Links in a Link Group (on page 13). 

See Also 
Defining Import Link Properties Common Tasks (on page 24) 
Mapping Codes for Wiring Data Import (on page 70) 
Flow of Activities for Importing Data into SmartPlant Instrumentation (on page 8) 
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S E C T I O N  2  

Import Utility Supplementary Information Tables 
The following section contains supplementary information tables for the Import utility. 

In This Section 
Common Error Messages .............................................................. 113 
System Codes Table ..................................................................... 116 
Unit of Measure Codes Table ........................................................ 125 
 
 

Common Error Messages 
This table describes some of the most common error messages which appear in both the Import 
Report and the log file after an import process takes place.  Also included in this table are possible 
causes and suggested solutions for each case. 

Message Possible Cause Suggested Solution 

Empty Component 
Number of Tag Number 

The loop identifier segment of the 
imported tag is empty. 

Modify the source data. 
Modify the import naming 
conventions. 

Empty Loop Number of 
Loop Number 

The loop identifier segment of the 
imported loop is empty. 

Modify the source data. 
Modify the import naming 
conventions. 

Illegal Instrument Type of 
Tag Number 

The instrument type you want to 
import does not exist in the target 
domain (see Note 1 below). 

Modify the source data. 
Import instrument type data into the 
COMPONENT_FUNCTION_TYPE 
table first. 
Clear the Validate tag and loop 
segments check box (see Note 3 
below). 

Illegal Equipment Name 
of Tag Number 

The imported tag equipment name 
does not exist in the target domain 
(see Note 1 below). 

Modify the source data. 
Import data into the EQUIPMENT 
table first (see Note 3 below). 

Illegal Equipment Name 
of Loop Number 

The imported loop equipment name 
does not exist in the target domain 
(see Note 1 below). 

Modify the source data. 
Import data into the EQUIPMENT 
table first (see Note 3 below). 

Illegal Loop Function of 
Loop Number 

The imported loop function 
segment value does not exist in the 
target domain. 

Modify the source data. 
Import loop function data into the 
LOOP_PROC table first (see Note 3 
below). 

Illegal Measured Variable 
of Loop Number 

The imported loop measured 
variable segment value does not 
exist in the target domain. 

Modify the source data. 
Import loop function data into the 
LOOP_PROC table first (see Note 3 
below). 
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Message Possible Cause Suggested Solution 

Illegal <Unit> Number in 
Tag Number 

The imported <unit> number is 
different from the target <unit> 
number (see Notes 1, 2 below). 

When importing more than one plant 
hierarchy item, make sure that you 
have specified the data import level 
and selected Apply on the Import 
Level tab of the Link Properties 
dialog box. 
Modify the source data. 
Modify the import naming 
conventions. 

Illegal <Unit> Name in 
Tag Number 

The imported <unit> name is 
different than the target <unit> 
name (see Notes 1, 2 below). 

When importing more than one plant 
hierarchy item, make sure that you 
have specified the data import level 
and selected Apply on the Import 
Level tab of the Link Properties 
dialog box. 
Modify the source data. 
Modify the import naming 
conventions. 

Illegal Area Number in 
Tag Number 

The imported area number is 
different than the target area 
number (see Notes 1, 2 below). 

When importing more than one plant 
hierarchy item, make sure that you 
have specified the data import level 
and selected Apply on the Import 
Level tab of the Link Properties 
dialog box. 
Modify the source data. 
Modify the import naming 
conventions. 

Illegal Plant Number in 
Tag Number 

The imported plant number is 
different than the target plant 
number (see Notes 1, 2 below). 

When importing more than one plant, 
make sure that you have specified 
the data import level and selected 
Apply on the Import Level tab of the 
Link Properties dialog box. 
Modify the source data. 
Modify the import naming 
conventions. 

The Process Function is 
not found 

The imported process function 
name is different than the target 
(note that this variable is case 
sensitive and that this value is 
usually capitalized). 
The process function name in the 
COMPONENT or 
COMPONENT_FUNCTION_TYPE 
table is different than the process 
function name value in the 
PROCESS_FUNCTION table (see 
Note 1 below). 

Modify the import source and define 
correct mapping codes for instrument 
process function assignment.  For 
details, see Process Function 
Mapping Codes for Instrument Index 
Import (on page 69). 

The Instrument Type is In the COMPONENT table, the Modify the link settings or the source 
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Message Possible Cause Suggested Solution 
not found CMPNT_FUNC_TYPE_ID column 

value contains an invalid reference 
to the 
COMPONENT_FUNCTION_TYPE 
table. 

data, or clear the Validate tag and 
loop segments check box. 

The Instrument Type does 
not match the Tag 
Number 

In the COMPONENT table, the 
instrument type value in the 
COMPONENT_NAME column (tag 
number) is different than the value 
in the CMPNT_FUNC_TYPE_ID 
column. 

Modify the link settings or the source 
data, or clear the Validate tag and 
loop segments check box. 

The Instrument Type does 
not match the Process 
Function 

The process function of the tag 
number does not comply with the 
process function type, for example, 
Flow, Temperature, and so forth. 

Modify the link settings or the source 
data, or clear the Validate tag and 
loop segments check box. 

User has selected to 
reject row on data 
mismatch 

The Import Utility rejected a 
mismatched source row (see Note 
4 below). 

Modify the link properties on the 
Import Mode tab of the Link 
Properties dialog box. 

User has selected to 
disallow overwrite 

The Import Utility has rejected a 
source row which is identical to an 
existing target row (see Note 4 
below). 

Modify the link properties on the 
Import Mode tab of the Link 
Properties dialog box. 

User has selected to 
disallow insertion 

The Import Utility rejected a source 
new row (for example, the Import 
Utility is only updating the target 
data) (see Note 5 below). 

Modify the link properties on the 
Import Mode tab of the Link 
Properties dialog box. 

Unique value not found The imported table primary key 
value does not match the primary 
key value in the table from which it 
is derived (see Note 6 below). 

Make sure the table which provides 
the value for the primary key is 
selected for import. 

This is not a numeric 
value 

An attempt has been made to 
import a non- numeric field to a 
numeric field. 

Make sure you selected the 
appropriate links in the Link 
Explorer. 

Invalid data Inappropriate symbols were used in 
one or more imported fields. An 
incorrect comparison criteria was 
applied in the current import 
process (see Note 7 below). 

Select the Use reserved symbols 
with import on the General tab of 
the Link Properties dialog 
box.  Make sure you have correct 
comparison criteria settings.  See 
Target Table Definition (on page 43) 
for more information about this 
option. 

Data is empty The Import Utility has imported a 
Zero-ID row (see Note 8 below). 

This message does not indicate an 
error. 

 
The following notes apply to this table: 
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1. This message is specific for the case in which you select the Validate tag and loop 
segments check box on the Tag/Loop tab of the Link Properties dialog box.  See Set the 
Tag/Loop Parameters (on page 29) for more information. 

2. By default, the target <unit> is the one you selected when you started the current import 
session.  If you selected during the import setup process to import data into additional 
<units>, the target <unit> would be any of these <units> which data will be imported into 
during the import process.  See Importing Data into Multiple Plant Hierarchy Items or Projects 
(on page 86) for further information about importing data into additional target <units>. 

3. As a rule of thumb, always import data into reference tables before importing data into the 
tables they refer to.  When importing data using the Module (multiple tables) import method, 
make sure that all appropriate reference tables have been selected for import.  The 
corresponding message in the table varies according to the relevant reference table. 

4. This message is typical for the case in which you select the Insert option on the Import Mode 
tab of the Link Properties dialog box. 

5. This message is typical for the case in which you select the Reject rows on the General tab 
of the Link Properties dialog box.  See Set Properties for Handling Mismatched Data (on 
page 26) to learn how to handle mismatched data. 

6. This message is typical for the case in which you import a table whose primary key is derived 
from another table's primary key.  In this case the table the primary key belongs to must also 
be imported.  For example, the PD_GENERAL table primary key, CMPNT_ID, is derived 
from the COMPONENT table.  Therefore, the PD_GENERAL table primary key value must 
exist in the COMPONENT table. 

7. This message is reported by your SQL platform.  The name of the field the problem occurred 
in appears under Column Name in the Import Report.  In this case we highly recommend that 
you refer also to the information regarding this import attempt in your log file. 

8. Most SmartPlant Instrumentation tables contain a Zero-ID row which is used to maintain the 
linkage between the tables in the database.  During the import process this row is not 
transferred from the source data to the target data, in which case the Import Utility displays an 
appropriate message in the Import report. 

 

System Codes Table 
Process Data Property Code Description Value in Import Source 

Build-up Tendency Free Value  

(lower fluid) No N 

 Yes Y 

Coagulation Fluid Free Value  

 No N 

 Yes Y 

Coagulation Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Colored Fluid Free Value  

 No N 
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Process Data Property Code Description Value in Import Source 
 Yes Y 

Colored Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Corrosive Fluid Free Value  

 No N 

 Yes Y 

Corrosive Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Erosive Fluid Free Value  

 No N 

 Yes Y 

Erosive Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Failure Action Close Close 

 Last Last 

 Open Open 

Flag for Above/ Above Reference Line A 

Below Reference Below Reference Line B 

Line   

Flag for Built-up Absolute Pressure A 

Back Pressure Gage Pressure G 

Flag for Center C 

Center/Tangent Line Tangent T 

Flag for Constant Absolute Pressure A 

Back Pressure Gage Pressure G 

Flag for Critical Absolute Pressure A 

Pressure Gage Pressure G 

Flag for Design Absolute Pressure A 

Pressure Gage Pressure G 
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Process Data Property Code Description Value in Import Source 

Flag for Elasticity Gage Pressure G 

Module   

Flag for Fire/Non- Fire case F 

fire Case Non-fire case N 

Flag for Flow Mass flow  

 @ Operating conditions A 

 @ Base conditions B 

 @ Normal conditions N 

 @ Standard conditions S 

Flag for Flow Range Mass flow  

 @ Operating conditions A 

 @ Base conditions B 

 @ Normal conditions N 

 @ Standard conditions S 

Flag for Flow Trip/ Mass flow  

Alarm @ Operating conditions A 

 @ Base conditions B 

 @ Normal conditions N 

 @ Standard conditions S 

Flag for Lever Free Value  

 No N 

 Yes Y 

Flag for Maximum Mass flow  

Discharge @ Operating conditions O 

 @ Base conditions B 

 @ Normal conditions N 

 @ Standard conditions S 

Flag for Maximum Absolute Pressure A 

Pressure (Relief Valve) Gage Pressure G 

Flag for Maximum Free Value  

Pressure (Relief Valve) Absolute Pressure A 

 Gage Pressure G 
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Process Data Property Code Description Value in Import Source 

Flag for Pressure Free Value  

Range Absolute Pressure A 

 Gage Pressure G 

Flag for Pressure Trip/ Free Value  

Alarm Absolute Pressure A 

 Gage Pressure G 

Flag for Set Pressure Absolute Pressure A 

 Gage Pressure G 

Flag for Variable Back Absolute Pressure A 

Pressure Gage Pressure G 

Flag to enter Density Density to be imported D 

or SG Gravity to be imported G 

Flag to enter Density Density to be imported D 

or SG (lower fluid) Gravity to be imported G 

Fluid Phase Homogeneous 2-phase H 

 Non-Homogeneous 2- 
phase 

N 

 Single phase S 

Fluid State Gas/Vapor G 

 Liquid L 

 Steam S 

 Water W 

 N/A or other O 

Solid/Powder P  

Foaming up Free Value  

 No N 

 Yes Y 

Foaming up Free Value  

(lower fluid) No N 

 Yes Y 

Handwheel Free Value  

 No N 

 Yes Y 
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Process Data Property Code Description Value in Import Source 

Oxidizing Fluid Free Value  

 No N 

 Yes Y 

Pipe Material Plain Carbon Steel (SAE 
1020) 

1 

 Inconel X, Annealed 10 

 Hanel Stellite 25 (L605) 11 

 Copper (ASTM B152, 
B124, B133) 

12 

 Yellow Brass (ASTM B36, 
B134, B135) 

13 

 Alum. Bronz (ASTM B169 
A) 

14 

 Beryllium Copper 25 
(ASTM B194) 

15 

 Cuperonickel 30% 16 

 K-Monel 17 

 Nickel 18 

 Pyrex Glass 19 

 301 S.S. 2 

 Titanium 20 

 Tantalum 21 

 304 S.S. 3 

 310 S.S. 4 

 316 S.S. 5 

 330 S.S. 6 

 347 S.S. 7 

 Hastelloy B 8 

 Hastelloy C 9 

 Material Not Listed 99 

Seat Leakage ANSI I ANSI I 

 ANSI II ANSI II 

 ANSI III ANSI III 

 ANSI IV (standard) ANSI IV (standard) 



 Import Utility 
 

 

SmartPlant Instrumentation Import and Merger Utilities User's Guide 121 
 

Process Data Property Code Description Value in Import Source 
 ANSI V ANSI V 

 ANSI VI (TSO) ANSI VI (TSO) 

 BS6755A BS6755A 

 BS6755B BS6755B 

 BS6755C BS6755C 

 No Tight Shut-Off No Tight Shut-Off 

 Tight Shut-Off Tight Shut-Off 

Solidifying Fluid Free Value  

 No N 

 Yes Y 

Solidifying Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Toxic Fluid Free Value  

 No N 

 Yes Y 

Toxic Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Transparent Fluid Free Value  

 No N 

 Yes Y 

Transparent Liquid Free Value  

(lower fluid) No N 

 Yes Y 

Wiring Property Code Description Value 

Panel Category Code Junction Box 1 

 Marshaling Rack 2 

 Cabinet 3 

 Field Device 4 

 DCS 5 

 PLC 6 
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Process Data Property Code Description Value in Import Source 

Calculation Property Code Description Value 

Calc Type ISA Standard 1 

 IEC Standard 2 

Calculated Parameters Orifice Diameter 
calculation 

B 

(D,W,DP) Differential Pressure 
calculation 

D 

 Flow Rate Calculation W 

Flag for Full Scale Mass flow  

Flow @ Operating conditions O 

 @ Base conditions B 

 @ Normal conditions N 

 @ Standard conditions S 

Flag for Rupture Disk Without Rupture Disk 0 

 With Rupture Disk 1 

Flag to enter Compressibility to be 
imported 

C 

Compressibility or Density to be imported D 

Density (for Gas)   

Flag to enter Molecular Specific Gravity to be 
imported 

G 

Mass or SG (for Gas) Molecular Mass to be 
imported 

M 

Meter Sub Type Flange Tappings (Quarter 
of Circle Orifice) 

11 

 Corner Tappings (Quarter 
of Circle Orifice) 

12 

 Classical Venturi (as cast 
convergent section) 

17 

 Classical Venturi 
(machined convergent 
section) 

18 

 Classical Venturi (rough- 
welded sheet-iron conv) 

19 

 Flange Tappings (Square 
Edge Orifice) 

2 

 Universal Venturi 20 
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Process Data Property Code Description Value in Import Source 
 ISO Long Radius Nozzle 23 

 ASME Long Radius 
Nozzle 

24 

 ISA 1932 Nozzle 25 

 Venturi Nozzle 26 

 Diametrically Opposite 
Flange Tappings 
(Eccentric Orifice) 

28 

 Side Flange Tappings 
(Eccentric Orifice) 

29 

 Corner Tappings (Square 
Edge Orifice) 

3 

 Diametrically Opposite 
Vena Contract Tappings 
(Eccentric Orifice) 

30 

 Side Vena Contract 
Tappings (Eccentric 
Orifice) 

33 

 Vena Contract Tappings 
(Segmental Orifice) 

34 

 Radius Tappings (Square 
Edge Orifice) 

4 

 SBHO Meter Run with 
Corner Tappings 

5 

 SBHO Meter Run with 
Flange Tappings 

6 

 Pipe Tappings 7 

 AGA Report 3 (Flange 
Tappings) 

8 

 AGA Report 3 (Pipe 
Tappings) 

9 

Meter Type Square Edge Orifice 1 

 Quarter of Circle Orifice 2 

 Conical Entrance Orifice 3 

 Lo-Loss Tube 4 

 Venturi Tube 5 

 Nozzle 6 

 Eccentric Orifice 7 
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Process Data Property Code Description Value in Import Source 
 Segmental Orifice 8 

Orifice Material Plain Carbon Steel (SAE 
1020) 

1 

 Inconel X, Annealed 10 

 Hanel Stellite 25 (L605) 11 

 Copper (ASTM B152, 
B124, B133) 

12 

 Yellow Brass (ASTM B36, 
B134, B135) 

13 

 Alum. Bronz (ASTM B169 
A) 

14 

 Beryllium Copper 25 
(ASTM B194) 

15 

 Cuperonickel 30% 16 

 K-Monel 17 

 Nickel 18 

 Pyrex Glass 19 

 301 S.S. 2 

 Titanium 20 

 Tantalum 21 

 304 S.S. 3 

 310 S.S. 4 

 316 S.S. 5 

 330 S.S. 6 

 347 S.S. 7 

 Hastelloy B 8 

 Hastelloy C 9 

 Material Not Listed 99 

Relief Valve Style Bellows Valve B 

 Conventional Valve C 

 Pilot-operated Valve P 

Sizing Basis Blocked Flow B 

Valve Type Signal Seat Globe 1 

 Double Seat Globe 2 
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Process Data Property Code Description Value in Import Source 
 Angle 3 

 Ball 4 

 Butterfly 5 

Well Material Austenitic Steel 0 

 Ferritic Steel 1 

See Also 
Working with System Codes Common Tasks (on page 76) 
 

Unit of Measure Codes Table 
Unit of Measure Type Unit of Measure Name Value 

Area centimeter2 cm2 
 Foot2 ft2 
 Inch2 in2 
 Kilometer2 km2 
 meter2 m2 
 mile2 mile2 
 millimeter2 mm2 
 yard2 yd2 

Capacitance F F 
 nF nF 
 pF pF 

Capacitance/Length F/ft F/ft 
 F/km F/km 
 F/m F/m 
 F/ft F/ft 
 F/km F/km 
 F/m F/m 
 mF/ft mF/ft 
 mF/km mF/km 
 mF/m mF/m 
 nF/ft nF/ft 
 nF/km nF/km 
 nF/m nF/m 
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Unit of Measure Type Unit of Measure Name Value 
 pF/ft pF/ft 
 pF/km pF/km 

Capacitance/Length pF/m pF/m 

Conductivity mho/cm mho/cm 
 S/cm S/cm 
 mho/cm mho/cm 
 mmho/cm mmho/cm 
 mS/cm mS/cm 
 S/cm S/cm 

Current A A 
 mA mA 

Density gram/milliliter g/ml 
 kg/cubic meter kg/m3 
 kg/liter kg/l 
 lb/cubic foot lb/ft3 
 lb/cubic inch lb/in3 
 lb/cubic yard lb/yd3 
 lb/ U.K. gallon lb/UK gal 
 lb/U.S. gallon lb/US gal 
 oz/cubic inch oz/in3 
 oz/ U.K. gallon oz/UK gal 
 lb/U.S. gallon oz/US gal 
 slug/cubic foot slug/ft3 
 ton(long)/cubic yard tonl/yd3 
 ton(short)/cubic yard tons/yd3 

Diameter and Length 1/1000 inch MILS 
 centimeter cm 
 foot ft 
 inch in 

Diameter and Length kilometer km 
 meter m 
 mile mile 
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Unit of Measure Type Unit of Measure Name Value 
 millimeter mm 
 yard yd 

Flow CANADIAN gallon/day CN gal/d 
 CANADIAN gallon/hr CN gal/h 
 CANADIAN gallon/min. CN gal/min 
 CANADIAN gallon/sec. CN gal/s 
 Cubic centimeter/min cm3/min 
 cubic ft/day ft3/d 
 cubic ft/hr ft3/h 
 cubic ft/min. ft3/min 
 cubic ft/sec. ft3/s 
 cubic inch/day in3/d 
 cubic inch/hr in3/h 
 cubic inch/min. in3/min 
 cubic inch/sec. in3/s 
 cubic kilofoot/day kft3/d 
 cubic kilofoot/hr kft3/h 
 Cubic kilofoot/min. kft3/min 
 cubic meter/day m3/d 
 cubic meter/hr m3/h 
 cubic meter/min. m3/min 
 cubic meter/sec. m3/s 
 grain/day grain/d 
 grain/hr grain/h 
 grain/min. grain/min 

Flow grain/sec. grain/s 
 gram/day g/d 
 gram/hr g/h 
 gram/min. g/min 
 gram/sec. g/s 
 kg/day kg/d 
 kg/hr kg/h 
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Unit of Measure Type Unit of Measure Name Value 
 kg/min. kg/min 
 kg/sec. kg/s 
 klb/day klb/d 
 klb/hr klb/h 
 lb/day lb/d 
 lb/hr lb/h 
 lb/min. lb/min 
 lb/sec. lb/s 
 Mega cubic foot/day Mft3/d 
 Mega cubic foot/minute Mft3/min 
 Mega cubic meter/day Mm3/d 
 Mega cubic meter/hr Mm3/h 
 Mega lb/day Mlb/d 
 metric ton/day t/d 
 metric ton/hr t/h 
 metric ton/min. t/min 
 metric ton/sec. t/s 
 U.K. gallon/day UK gal/d 
 U.K. gallon/hr UK gal/h 
 U.K. gallon/min. UK gal/min 
 U.K. gallon/sec. UK gal/s 

Flow U.K. ton/day UK ton/d 
 U.K. ton/hr UK ton/h 
 U.K. ton/min UK ton/min 
 U.K. ton/sec UK ton/s 
 U.S. barrel/day US bbl/d 
 U.S. barrel/hr US bbl/h 
 U.S. barrel/min US bbl/min 
 U.S. barrel/sec US bbl/s 
 U.S. gallon/day US gal/d 
 U.S. gallon/hr US gal/h 
 U.S. gallon/min US gal/min 
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Unit of Measure Type Unit of Measure Name Value 
 U.S. gallon/sec US gal/s 
 U.S. kilobarrel/day US kbbl/d 
 U.S. kilobarrel/hr US kbbl/h 
 U.S. megabarrel/day US mbbl/d 

Force kilogram-force kgf 
 lb-force lbf 
 newton N 

Inductance H H 
 mH mH 

Inductance/Length H/ft H/ft 
 H/km H/km 
 H/m H/m 
 H/ft H/ft 
 H/km H/km 
 H/m H/m 
 mH/ft mH/ft 

Inductance/Length mH/Km mH/Km 
 nH/km nh/km 
 pH/ft pH/ft 

Inductance/Resistance H/ohm H/ohm 
 mH/ohm mH/ohm 

Latent Heat Btu(39)/lb Btu39/lb 
 Btu(59)/lb Btu59/lb 
 Btu(60)/lb Btu60/lb 
 Btu(IT)/lb Btu IT /lb 
 Btu(M)/lb Btu M /lb 
 Btu(th)/lb Btu th /lb 
 cal(15)/g cal15/g 
 cal(20)/g cal20/g 
 cal(IT)/g cal IT/g 
 cal(M)/g cal M /g 
 cal(th)/g cal th /g 
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Unit of Measure Type Unit of Measure Name Value 
 J/kg J/kg 
 kcal(15)/kg kcal15/kg 
 kcal(20)/kg kcal20/kg 
 kcal(IT)/kg kcal IT /kg 
 kcal(M)/kg kcal M /kg 
 kcal(th)/kg kcal th /kg 
 kJ/kg kJ/kg 

Power mW mW 
 W W 

Pressure atmosphere(standard) Atm (stand) 
 atmosphere(tech) at (tech) 
 bar bar 

Pressure centimeter of Hg (0C) cmHg 0C 
 centimeter of water cmH2O (4C) 
 dyne/cm2 dyn/cm2 
 foot of water (39.2C) ftH2O 
 gram-force/cm2 gf/cm2 
 hecto pascal hPa 
 inch of Hg(32C) inHg 
 inch of water(60C) inH2O 
 kg-force/cm2 kgf/cm2 
 kg-force/m2 kgf/m2 
 kg-force/mm2 kgf/mm2 
 kilo pascal kPa 
 Ksi Ksi 
 lb-force/ft2 lbf/ft2 
 lb-force/in2 lbf/in2 
 mega pascal MPa 
 meter water(4C) mH2O 4C 
 millibar mbar 
 millimeter of Hg (0C) mmHg 0C 
 millimeter of water mmH2O 4C 
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Unit of Measure Type Unit of Measure Name Value 
 pascal (Pa) Pa 
 psi psi 
 torr (mm Hg 0C) Torr 

Resistance Kohm Kohm 
 ohm ohm 

Resistance/Length kOhm/ft kOhm/ft 
 kOhm/km kOhm/km 

Resistance/Length kOhm/m kOhm/m 
 MOhm/m MOhm/km 
 Ohm/ft Ohm/ft 
 Ohm/km Ohm/km 
 Ohm/m Ohm/m 
 statOhm/km statOhm/km 

Specific Heat Btu(39)/(lbF) Btu39/lbF 
 Btu(59)/(lbF) Btu59/lbF 
 Btu(60)/(lbF) Btu60/lbF 
 Btu(IT)/( lbF) BtuIT / lbF 
 Btu(M)/(lbF) Btu M / lbF 
 Btu(th)/(lbF) Btuth/lbF 
 cal(15)/(gK) cal15/(gK) 
 cal(20)/ (gK) cal20/(gK) 
 cal(IT)/ (gK) calIT/(gK) 
 cal(M)/ (gK) cal M /(gK) 
 cal(th)/ (gK) calth/(gK) 
 J/(kgK) J/(kgK) 
 kcal(15)/(kgK) kcal15/kgK 
 kcal(20)/ (kgK) kcal20/kgK 
 kcal(IT)/ (kgK) kcal IT /kgK 
 kcal(M)/ (kgK) kcal M /kgK 
 kcal(th)/ (kgK) kcal th /kgK 
 kJ/(kgK) kJ/(kgK) 

Temperature Degrees Celsius C C 
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Unit of Measure Type Unit of Measure Name Value 
 Degrees Fahrenheit F F 
 Degrees Rankin R R 

Temperature Kelvin K K 

Velocity ft/h ft/h 
 ft/min ft/min 
 ft/s ft/s 
 in/s in/s 
 km/h km/h 
 m/s m/s 

Viscosity centipoise cP 
 centistokes cS 
 cm2/s cm2/s 
 ft2/sec. ft2/s 
 in2/sec. in2/s 
 lb/(fthr) lb/(fth) 
 lb/(ftsec.) lb/(fts) 
 lb-forcesec/ft2 lbfsec/ft2 
 lb-forcesec/in2 lbfsec/in2 
 m2/sec. m2/s 
 mm2/s mm2/s 
 mPas mPas 
 pascal sec. Pas 
 poise P 
 slug/(ftsec.) slug/fts 
 stokes St 

Voltage mV mV 
 V V 

Weight gram g 
 kilogram kg 

Weight metric ton ton 
 ounce oz 
 pound lb 
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Unit of Measure Type Unit of Measure Name Value 

Weight/Length kg/km kg/km 
 lbs/mft lbs/mft 

See Also 
Adapt Unit of Measure Codes (on page 78) 
Working with System Codes Common Tasks (on page 76) 
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S E C T I O N  3  

The Merger Utility provides you with the means of transferring a selected plant hierarchy item (for 
example, domain, plant, and so forth) from a source domain to the same type of plant hierarchy 
item in an existing target domain. The source and target domains can be a part of the same 
database or part of different databases. You can also merge source and target plant hierarchy 
items within the same domain. 
You run the Merger Utility in any of the following scenarios: 
 You need to transfer all the data from a source domain to a target domain.  
 You need to transfer all the data from a source plant hierarchy item to a target plant hierarchy 

item at the same level.  

 
 Only the Domain Administrator has access to the Merger Utility.  
 The source and target domains must be of the same SmartPlant Instrumentation version. If 

they are not the same version, you must upgrade the domain that belongs to the earlier 
version.  

 The Merger Utility only supports domains of type Engineering company when merging plant 
data. For configuration data, the Merger Utility supports engineering company and owner 
operator domains.  

The Merger Utility changes the contents of your target database. Therefore, we recommend that 
you backup your target database before proceeding with the merge process.  
 

Database Platform Support 
The Merger Utility provides you with inherent support of the following database platforms: 
 Oracle  
 Microsoft SQL Server  
 Sybase Adaptive Server Anywhere  

You can use any of the above database platforms after you configured that database platform to 
work with SmartPlant Instrumentation. 
You can also import data from database platforms other than those specified above. To do this, 
you need to install the appropriate drivers manually and configure the appropriate configuration 
files. 

 SmartPlant Instrumentation uses a database engine developed by Sybase for SmartPlant 
Instrumentation repository. This engine is called Sybase Adaptive Server Anywhere.  
 

Merger Utility 
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Configuring Your Environment 
When you install the software, the Merger Utility settings are automatically configured in the 
appropriate configuration files.  See your database manual to learn more about your database 
configuration. 
In a Windows XP environment, the database configuration settings are located in the following 
registry folders: 
 HKEY_CURRENT_USER\Software\ODBC\ODBC.INI 
 HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI 

 Do not change the setting in the configuration files if you are not familiar with the 
database configuration. 
 

Start the Merger Utility 
To start the Merger Utility you must comply with the following requirements: 
 You must have a previously defined source and target domains with at least one plant 

hierarchy item at the lowest level of the hierarchy (by default, this is a unit).  
 Both the source and target domains must be of the same SmartPlant Instrumentation version 

and sub-version.  
See Installation Guide, SmartPlant Instrumentation Setup Maintenance and Database 
Selection, Installing SmartPlant Instrumentation Components to learn more about 
SmartPlant Instrumentation programs and utilities. 
1. Select Merger Utility  from the Intergraph SmartPlant Instrumentation program group in the 

Windows Start menu.  
2. On the Logon Information dialog box, type the Domain Administrator name and password.  
3. On the Open dialog box, expand the hierarchy as needed by clicking and select the desired 

<unit>.  

 
 Whenever you start the Merger Utility, the software prompts you to select a target <unit>. If 

you have already started a merge process in a previous Merger Utility session, you are 
prompted to resume that merge process.  

 You need to select a single target <unit> before starting the merge process, the same way you 
do when you enter every SmartPlant Instrumentation module. You can select additional target 
plant hierarchy items as you proceed through the merge process. (For details of how to select 
additional target data, see Merging Data: An Overview .)  
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S E C T I O N  4  

Working with Log Files 
Log files allow you to keep track of all operations during a merge process. 
When you start the Merger Utility for the first time, you create a new log file.  The log file keeps 
growing as you continue merging data unless you decide to change the current log file.  The 
information in the log file describes chronologically the events which have taken place during the 
merge process.  This information includes: 
 Date and time in which the merge process started.  
 Details of the selected source and target:  

 The database platform (for example, Oracle)  
 The domain name  
 The plant hierarchy item name on the level at which data has been transferred  

 The starting ID of each table (for details of how to set the starting ID, see Setting the Merger 
Comparison Criteria ).  

 The total number of updated target rows (where the software overwrites data).  
 The total number of inserted rows (new rows that were appended in the target domain).  
 The total number of rejected source rows: source rows which were not transferred).  
 The transferring results: whether the merge process was successful if the user stopped it or if 

it stopped due to merge failure.  
If you start the merge process with no log file defined, the software prompts you to define a log file 
when you are about to start the data transfer. 

 SmartPlant Instrumentation uses Notepad to view the log file; however, Notepad is limited 
by file size that it can handle.  If your log file becomes too large for Notepad, an appropriate 
message appears.  In this case, you can view your log file using Windows Write or another 
appropriate utility. 
 

Setting the Merger Comparison Criteria 
You can control the way the Merger Utility identifies the source data as identical to the target data 
during the merge process. This is important, because when the Merger Utility encounters identical 
source and target rows, it can overwrite the target row or leave it intact, depending on the 
comparison criteria settings. You can therefore control the merge results by selecting the 
appropriate comparison criteria. 
In SmartPlant Instrumentation, the database is organized in tables, for example: CABLE, 
COMPONENT, CONTROL_VALVE, and so forth. These tables contain data arranged in columns 
that represent various item types such as tags, cables, panels, and so forth. 
For example: 
The COMPONENT table contains all the tags together with the appropriate links to other tables, 
which utilize tags, such as: COMPONENT_MFR (Manufacturers table), CABLES (Cables table), 
and so forth. 
You can use one or more columns in each table as the primary keys of this table. The value of the 
primary key of each table is unique in this table. For example, the primary key of the 
COMPONENTS Table is CMPNT_ID. This means that each row in the COMPONENT Table has a 
different value in the CMPNT_ID field. 

 Primary key columns are not accessible to you when you work in SmartPlant 
Instrumentation. The primary keys are designed only for SmartPlant Instrumentation internal use.  
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When comparing rows, the Merger Utility treats the source and target rows as identical only if both 
the source primary key and target primary key contain the same value. For example, if the 
COMPONENT table in both source and target rows contains the same values in the columns 
defined as primary keys, then the software considers both rows as being identical. In this case, the 
Merger Utility can either replace the entire target row with the source row or leave this target row 
intact, depending on the merge process settings. 
You can select the appropriate primary key of every table in the database. This way you can 
create a different comparison criterion for each table. 

 Changing the settings in the Target Definition dialog box alters the relations between 
the tables. We therefore recommend that you do not change these settings unless you find it 
necessary and only if you are familiar with the SmartPlant Instrumentation database structure. In 
most cases when you merge data, you do not have to modify the Merger Utility comparison 
criteria. If you decide to modify the comparison criteria, make sure you enter the appropriate data, 
as this feature changes the contents of the target. f the contractor, or extra information as 
required.  You can type up to 40 characters in this field. 
 

Create a New Log File 
This procedure shows you how to create a new log file. It is advisable to create a new log file each 
time you run a merging process . You should also create a new log file if your existing log file has 
become too long. 
1. Click Log > New. 
2. On the New Log File dialog box, type the name of your new log file, select the desired path, 

and click Save.  
 The Merger Utility opens a new empty log file automatically, even though you do not see it. 

 

Open an Existing Log File 
This procedure shows you how to open an existing log file. It is advisable to open a log file before 
you perform an import procedure so that you have a record of the merging process. 
1. Click Log > Open. 
2. On the Open Log File dialog box, select the name of the log file you want to open and click 

Open. 
 After you create a new log file or open an existing one, it stays open even though you do not 

see it displayed. The log file remains active until you close the Merger Utility. (For details of how to 
close the current log file manually, see Create a New Log File.) When you exit the Merger Utility, 
the log file closes automatically and reopens when you restart the Merger Utility. 
 

View a Log File 
This procedure shows you to view the current log file and to review the previous merging process 
information. 
 Do one of the following: 

 Click . 
 Click Log > View. 

 The current log file opens for viewing in Notepad. SmartPlant Instrumentation uses Notepad 
to view the log file. However, Notepad is limited by file size that it can handle. If your log file 
becomes too large for Notepad, you will get an appropriate message. In this case you can view 
your log file using Windows Write or another appropriate utility. 
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Close the Current Log File 
This procedure shows you how to close the current log file, if you to choose to merge data without 
a log file. 
 Click Log > Close. 

 The Merger Utility immediately closes the current log file. After you close the current log file 
you need to define a new log file to resume tracking the import process. 
 

Delete an Existing Log File 
This procedure shows you how to delete a log file when the information is no longer required. 

 This action permanently deletes the selected log file from your hard disk. 
1. Click Log > Delete. 
2. On the Open Log File Name dialog box, select the name of the log file you want to delete and 

click Open. 
 On clicking Open, the software deletes the specified log file from your hard disk. 
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Merging Data 
Before you can merge data, you must create a merge session, within which you select the source 
data, match the source and target data, and set the merging options. 
After selecting the source data, you match the source and the target <units>. You need to do this 
because the source and target domains may differ in the domain hierarchy. For example, there 
may be more <units> in the selected source area than in the target area. 
The next stage is to select the data to be merged. There are two ways you can select the data to 
be merged: 
 Transfer all the data of selected modules or sub-modules using the module list feature. When 

you select this option, the software transfers the entire data for the selected item types. 
 Transfer only the data that you select using the comparison list feature. With this option, you 

can generate comparison reports which help you to identify exactly which data needs to be 
merged. We recommend that you save the comparison reports as .psr files. The advantage of 
having the comparison reports in the .psr format is that you can re-use them in other Merger 
Utility sessions if needed. There are, however, some limitations: 

 .psr files reflect the situation at the time they were created. If the data has changed during 
the time between the report creation and its restoration, you cannot be certain that the 
data contained in the report is up- to-date.  

 Restore only supporting tables and reports for main item types (loops, tags, cables, 
panels, and so forth). Do not select composite tables such as tag and block relations.  

  If you want to delete data that is present in the target but not in the source, you can do 
so only through the comparison list option. 

You can manipulate, view, and print a .psr file from both InfoMaker and SmartPlant 
Instrumentation. SmartPlant Instrumentation provides the best interface to deal with the .psr files, 
as there are built-in features to filter, sort and column selection. If you edit a .psr file outside 
SmartPlant Instrumentation, the hidden columns become visible. This is a technical limitation that 
you should be aware of. 
If you intend to merge data based on saved .psr files, do not save any changes made through 
InfoMaker (you can make changes temporarily in order to adjust the layout of the printed 
document, but do not save it). 
Generate and save the comparison reports as .psr files. If there is a lot of data in the source and 
target databases, consider doing this on a per <unit> basis for the basic engineering. In this case, 
save the comparison reports in different folders. 
If you use InfoMaker, set it so it does not retrieve the data from the database when the document 
is opened. To do this, do the following: 
1. Open the .psr file in InfoMaker in design mode.  
2. Click Design > Options.  
3. Clear the Retrieve on Preview option.  
4. Make sure that the Retain Data to Design option is selected.  
In order not to run out of resources during the different comparisons, run this process in different 
sessions as recommended. 
To improve performance, make sure that the Build table list for merging data check box in the 
Compare Source-Target Data window is cleared (there is no need to build a table list for merging 
if you do not intend to use it at that time). 
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The next stage is to set the Merger Utility settings which include the general options, setting the 
date from which to start merging the data, and selecting the tag custom field data to be merged. 
When you start to merge data, you can monitor the transfer process in the Merger Progress 
window. 
The merge process includes the following major steps: 
1. Selecting the source data; that is, the plant hierarchy item.  
2. Matching the source data with the target data.  
3. Selecting the source data to be transferred to the target domain.  
4. Setting the general Merger Utility options.  
5. Setting other Merger Utility options: date, user-defined fields, and log file.  
6. Transferring the selected source data to the target data.  
 

Merger Session 
The following tasks are used when you create a merge session, for merging your data. 
 

Select the Target Plant Hierarchy Item 
When merging data, the Merger Utility treats the database identified in the current Intools.ini file as 
the target database and refers to your current plant hierarchy item as the target. This means that 
the source data will be merged data in that <unit>. SmartPlant Instrumentation connects to the 
target database when you start the Merger Utility. After the Merger Utility starts, the Open dialog 
box appears, where you can select the desired target <unit>. 
1. Click File > Select Plant Hierarchy Item for Target. 
2. On the Open dialog box, expand the hierarchy as needed by clicking  and select the 

desired <unit> . 
 

Create a New Merger Session 
This procedure shows you how to create a new merger session. 
1. Click Actions > New Session. 
2. In the text box, type a unique name for the session. 
3. Click Actions > Open Session. 
4. Make your definitions for the session as you require. 
5. When done, on the Actions menu, click Save Session. 
 

Open a Merger Session 
This procedure shows you how to open a merger session. 
1. In the Merger Session Manager window, select the session that you want to open. 
2. Do one of the following: 

 Click Actions > Open Session. 
 Right-click the session, and on the shortcut menu, click Open Session. 

3. Make any changes to the session as you require. 
4. When done, on the Actions menu, click Save Session. 
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Rename a Merger Session 
This procedure shows you how to rename a merger session. 
1. In the Merger Session Manager window, select the session that you want to rename. 
2. Do one of the following:  

 Click Actions > Rename Session. 
 Right-click the session, and on the shortcut menu, click Rename Session. 

3. In the text box, type a new name for the session. 
 

Duplicate a Merger Session 
This procedure shows you how to duplicate a merger session. 
1. In the Merger Session Manager window, select the session that you want to duplicate. 
2. Do one of the following: 

 Click Actions > Duplicate Session. 
 Right-click the session, and on the shortcut menu, click Duplicate Session. 

3. On the Duplicate Session dialog box, do one of the following:  
 Click New and type a new session name.  
 Select an existing session to overwrite it with the new session data. 

 

Delete a Merger Session 
This procedure shows you how to delete a merger session. 
1. In the Merger Session Manager window, select the session that you want to delete. 
2. Do one of the following: 

 Click Actions > Delete Session. 
 Right-click the session, and on the shortcut menu, click Delete Session. 

3. When prompted, confirm the deletion.  
 

Selecting the Source Domain 
After you have opened a session or defined a new session, the next step is to select a domain or 
any plant hierarchy item within the domain. At this stage, you can also select the appropriate 
source modules and tables. 
The source domain can be: 
 The same as the target domain  
 Different from the target domain but belonging to the same database  
 A domain from a database other than the target domain database  

 You can select multiple <units> to be merged with the target. 
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Selecting and Matching Source Domains 
The following tasks are used when you select source domains during the merge process. 
 

Select the Same Source Domain As the Target Domain 
Use this procedure to select identical source and target domains if required. 
1. Open a merger session. For details, see Open a Merger Session (on page 142). 
2. Do one of the following:  

 Expand the tree and click  Connect . 
 Click Actions > Connect to Source.  

3. On the Connect to Source dialog box, select Use target domain as source.  
 Whenever you open a new merger session, the source domain is the same as the target 

domain by default. Therefore, the details of the current target domain (the domain that you 
selected when you started this merger session) appear under Information.  

4. Click Plant Hierarchy. 
5. On the Source Plant Hierarchy dialog box, select as the source either the entire domain or 

any plant hierarchy item within the domain. For details of how to continue the merge process, 
see Match the Source Data with the Target Data (on page 146).  

 

Select a Source Domain from Another ODBC Platform 
Use this procedure to select a source domain residing in another SQL Server or Sybase Adaptive 
Server Anywhere database. You do this by selecting ODBC profile and using it for connection to 
the source database. 

Prerequisites 
 Make sure you have the proper access rights (logon name and password) required to connect 

to the source domain.  
 If you need to connect to a source domain residing in another Sybase Adaptive Server 

Anywhere database, make sure you created an ODBC profile for connection to the source 
database. You can use the Internal Setup Utility options to create ODBC profiles for Sybase 
Adaptive Server Anywhere. The ODBC profiles that you create become available for selection 
in the Merger Utility.  

 If you need to connect to a source domain residing in another SQL Server database, make 
sure you created an ODBC profile for connection to the source database. You cannot use 
existing profiles that are available for selection in the Merger Utility. When creating a new 
ODBC profile for SQL Server, make sure the new profile name is unique in the Windows 
registry of the machine where you run the Merger Utility.  

 The Merger Utility does not support source domains with the As-Built functionality. 
1. In the Merger Session Manager window, open a merger session. 
2. Do one of the following: 

 Expand the tree and click  Connect. 
 Click Actions > Connect to Source. 

3. On the Connect to Source dialog box, clear Use target domain as source. 
4. Click Connect. 
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5. On the Connect to Database dialog box, from the DBMS list, select ODBC. From the Profile 
name list, select the source database profile.  

 With ODBC being your database platform, from the Profile name list, you can either 
select a Sybase Adaptive Server Anywhere or SQL Server ODBC profile.  

6. In the Logon name and Logon password boxes, type the logon name and password for 
connection to the source database using the selected ODBC profile. 

7. Click OK to establish the connection to the source database and reopen the Connect to 
Source dialog box. 

8. On the Connect to Source dialog box, click Plant Hierarchy. 
9. On the Source Plant Hierarchy dialog box, select as the source either the entire domain or 

any plant hierarchy item within the domain. For details of how to continue the merge process, 
see Match the Source Data with the Target Data (on page 146). 

 

Select a Source Domain from Another Oracle Database 
Use this procedure to select a source domain from another Oracle database and establishing a 
connection to this domain. 

Prerequisite 
 In order to establish a connection to another Oracle database, first of all, make sure you have 

all the correct .dll files and the right settings in the appropriate .ini files and/or registry. Also, 
make sure you have the proper access rights (logon name and password) required to connect 
to the source database. 

1. In the Merger Session Manager window, open a merger session. 
2. Do one of the following: 

 Expand the tree and click  Connect.  
 Click Actions > Connect to Source.  

3. On the Connect to Source dialog box, clear Use target domain as source.  
4. Click Connect.  
5. On the Connect to Database dialog box, from the DBMS list, select the appropriate version 

of your source Oracle database.  
6. In the Server name box, type the name of the database server.  
7. From the Logon name list, select a logon name to connect to the selected source database.  
8. In the Logon password box, type the appropriate password to connect to the selected source 

database.  
9. Click OK to establish the connection and return to the Connect to Source dialog box.  
10. On the Connect to Source dialog box, click Plant Hierarchy.  
11. On the Source Plant Hierarchy dialog box, select as the source either the entire domain or 

any plant hierarchy item within the domain. For details of how to continue the merge process, 
see Match the Source Data with the Target Data (on page 146).  

 The Merger Utility does not support source databases that have the As-Built functionality. 
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Match the Source Projects to the Target Projects 
Use this procedure to match source and target projects if you have selected to merge 
configuration data and the source domain is an owner operator domain. In this way, the Merger 
Utility transfers data from the selected source projects to the selected target projects which you 
are going to link. 

 You must perform this procedure when you select the User Group or Access 
Rights options for merging the data. 
1. On the Connect to Source dialog box, click Match Projects. 
2. On the Match Projects dialog box, match each target project individually to the required 

source project by selecting in the Target (left) data window, the row that represents the 
required target project and dragging it to the required cell under Connected to Target 
Project in the Source data window. 

 
 If projects in the source and target have the same names, you can connect them 

automatically by clicking Match Names.  
 You cannot map a project onto itself.  

3. Click OK to return to the Connect to Source dialog box. 
 

Match the Source Data with the Target Data 
Use this procedure to match the source and the target <units> after connecting to a database and 
selecting the source domain or plant hierarchy item. In this way, the Merger Utility transfers data 
from the selected source <units> to the selected target <units> which you are going to link. This 
procedure applies where you have selected a source plant hierarchy item other than a <unit>. 
1. On the Connect to Source dialog box, click Match Plant Items. 

 If the Match Plant Items command button is not available, first click Plant Hierarchy to 
open the Source Plant Hierarchy dialog box where you have to select the domain, a plant, or 
an area as the source. This action automatically opens the Match Plant Hierarchy Items 
dialog box. 

2. On the Match Plant Hierarchy Items dialog box, match each target <unit> individually to the 
desired source <unit> by selecting in the Target (left) data window, the row that represents 
the required target <unit> and dragging it to the required cell under Connected To in the 
Source data window.  

 
 You can map multiple source <units> to the same target <unit>.  
 If <units> in the source and target have the same names, you can connect them 

automatically by clicking Match Names.  
 You cannot map a <unit> onto itself.  

3. Click OK to return to the Connect to Source dialog box.  
 If you need to merge the entire plant data; that is, matching all the source and target <units>, 

you should consider merging the data in several separate sessions. Merging the entire plant data 
in one session may take a long time because it increases the time required to generate the 
comparison reports. Also, a single merge session requires more client and server computer 
resources.  
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Match Source And Target Naming Conventions 
Use this procedure to match the loop and tag naming conventions for the mapped source and 
target <units>. In most cases, if the source and target <units> use the same naming convention 
type, you do not need to match the segment names. However, under certain circumstances, for 
example, if the target naming convention is the Flexible standard, you may need to match 
individual segments between the source and target or map segments automatically when the 
source and target segment names are identical. 
1. On the Connect to Source dialog box, click Match Conventions. 
2. On the Match Naming Conventions dialog box, under Target plant hierarchy, expand the 

hierarchy and navigate to the desired <unit>. 
 If a source <unit> is mapped to the selected <unit>, the plant hierarchy of the source 

<unit> appears beside the target <unit> name. 
3. Under Naming convention type, do one of the following: 

 Click Tag to map a tag naming convention. 
 Click Loop to map a loop naming convention. 

4. If required, click Clear to clear the mapping between the naming convention segments in the 
source and target <units>. This action clears all the data in the Source Segment column. 

 You can clear the loop and tag naming convention mapping for all <units> in the domain 
by clicking Clear All. 

5. Do one of the following: 
 Under Source naming convention, select a row representing the segment you want to 

match, and drag it to the Source Segment column under Target naming convention for 
the required target segment. 

 Under Target naming convention, type in the Source Segment column for the required 
target segment the required source segment name. 

 
 If segments in the source and target have the same names, you can connect them 

automatically by clicking. 
 When you drag the source name, the software displays the number of the source segment in 

the Source Segment column instead of copying the full string. You can add a substring and 
include fixed text in the source segment name. For example: #2 (1,3) + 'DD'. This means that 
the name of the second segment in the source is used. The segment itself consists of the first 
three characters of the source segment name, and has suffix DD without the quotes. 

 After matching naming conventions, it is recommended that you run the comparison list to 
view loop and tag names before merging the data. 
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Defining Merger Utility Settings 
The following tasks are used when you defining the Merger Utility settings. 
 

Define Merger Utility Settings 
Before merging data in a session, you need to set the Merger Utility options. 
You can determine whether to do any of the following: 
 Overwrite the target rows with identical source rows.  
 Stop data merging if a source row fails to be transferred to the target.  
 Use tag names for wiring items, and use the same source and target tag and loop convention 

names. 
1. Open a Merger Utility session. 
2. Click Actions > Options. 
3. On the Options dialog box, specify your settings as desired. 

 
 The Comparison Action tab folder becomes available only after running a comparison 

list.  
 The Update Mode tab folder becomes available only after you select Update existing 

data in the General tab folder.  
 When merging configuration data items, you must select Update existing data if you 

want to merge data for the Custom Field Definitions and Custom Table Definitions 
items. These items include tables that contain a fixed number of existing rows, and for this 
reason, these rows can only be updated; it is not possible to insert new rows. 

4. After defining all the settings, proceed with the selection of the item types to merge by 
performing one of the following procedures: 
 Select the item types that you want to merge.  
 Compare the source and target data. 

 

Select the Source Modules and Module Data 
You use this option if you want to transfer all the data of selected modules or sub-modules to the 
target domain. You can select entire modules and/or expand the appropriate modules to select 
the required module data. At this stage, you can also select specific loops that you want to merge. 
For example, you can select the entire Instrument Index module or you can double click the 
Instrument Index module icon  to expand it and select the required module data (for example, 
Line, Equipment, and so forth). You can also expand any Instrument Index module data, such as 
supporting tables. 

 You cannot proceed with the merge process until you select the source module and/or 
module data. The data window in the Select Items dialog box does not contain module data with 
the caption Tags. This is because the source tags are automatically selected when you select the 
Instrument Index module. Therefore, to merge the source tags, select the source Instrument Index 
module without expanding it. 
1. Open a Merger Utility session. 
2. Click File > Preferences. 
3. Click the Item Type tab.  
4. Under Merge data for, do one of the following:  
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 Click All plant items to select all items in the plant for data merging. This option is 
available only if you have connected to an engineering company domain.  

 Click Configuration data items to select configuration data items only for merging. 
Configuration data is background data that includes default panels and cables, 
specification forms, instrument types, and various supporting table data. This option is 
available for any database connection, whether it is part of an owner operator or 
engineering company domain. This option is useful where you need to populate several 
domains with basic data from the same source.  

 
 When merging configuration data items, on the Merger Preferences dialog box, you 

must select Update existing data if you want to merge data for the Browser with 
Specification item. This ensures that the browser views open properly after merging.  

 When merging configuration data items, you must select Update existing data if you 
want to merge data for the Custom Field Definitions and Custom Table Definitions 
items. These items include tables that contain a fixed number of existing rows, and for this 
reason, these rows can only be updated; it is not possible to insert new rows.  

5. Return to the Merger Session Manager and do one of the following:  

 Expand the tree and click  Select. 
 Click Actions > Select Items. 

6. On the Select Items dialog box, select the module data that you want to transfer from the 
source domain to the target domain. 

 
 A check mark  appears beside everything that you select. 
 Using the Select all check box to select items is not the same as selecting all the items in 

the data window. If you select the Select all check box, the software selects all plant items 
and all configuration data items (excluding User Group and Access Rights), regardless 
of which items appear in the data window.  

7. To make a more precise selection of the source data by selecting the required source table 
(applies only if you selected All plant items), do the following:  
a. Click Advanced.  
b. On the Advanced Selection dialog box, select the source table to be merged to the target 

domain.  
8. Click OK to save the Merger Utility settings.  
9. When prompted, click Yes to confirm your selection of the source data.  
 

Select the Source Item Types to Merge 
You can make a more precise selection of the source data. You do this by selecting the source 
tables to be merged (for example, Manufacturers Table, Status Table, I/O Table, and so forth) in 
the Advanced Selection dialog box. 
You open the Advanced Selection dialog box by clicking Advanced in the Select Items dialog 
box. 
The Advanced Selection dialog box consists of the following sections: 
 Filter: Select the criteria that are used to filter the displayed tables. 
 Sort: Select whether to sort the tables by name or by merge order. 
 (Table data): Select the required source table to transfer to the target domain. You can also 

type additional data to append to the target domain during the transfer process. 



Merger Utility 
 

 
150 SmartPlant Instrumentation Import and Merger Utilities User's Guide 

 

 If you resume a previous merge session, you see in the Advanced Selection dialog box 
the source tables which were selected in that merge session. 
Now you can: 
 Select the source tables that you want to merge. 
 Specify data which will be appended to the target domain during the data transfer. 
 Specify an insertion condition for the required source tables. 
 View the displayed source tables according to your required filtering and sorting options. 

1. Do one of the following:  
 Under the Select column, select the check box for each table you require to include in the 

merge process. 
 Select the Select all check box to select all the available source tables. 

 
 Selected source tables are displayed in red; unselected source tables are displayed in 

black. 
 To locate a table by name, click Search and type the table name in the text box. 

2. Select the check box in the Insert Only column if you want to specify an insertion condition for 
the selected table — any updated data in the table does not get merged in this case.  

3. To merge the reference tables of any selected source table, click Reference Tables.  
 All the reference tables associated with the selected source table are automatically 

selected for merging.  
 

Select the Source Tables to Be Merged 
You can select specific item types in the source that you want to merge: 

 Wiring — All source wiring items, reference items, or plant (user- created) items. 
 Documents — All documents saved to the database or just P&ID document numbers, or 

specs, process data sheets and calculation sheets, or all documents apart from specs, 
process data sheets and calculation sheets. 

1. With the Advanced Selection dialog box open, click Data Types.  
2. On the Data Type Selection dialog box, under Wiring, select the source wiring items you 

want to merge in the target domain.  
3. To select the source documents, under the Documents select the source documents you 

want to merge in the target domain.  
 When merging P&ID document numbers, the associated source data such as 

specifications, tags, and loops, is not transferred.  
4. Click OK to close the Data Type Selection dialog box and return to the Advanced Selection 

dialog box after accepting the values.  
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Specify an Insertion Condition 
You can specify an insertion condition for every selected source table. This way you instruct the 
Merger Utility to insert every selected source row of the selected source table, which complies with 
the table’s insertion condition. Note that the insertion condition affects only the source tables 
which you have selected to be merged. 
The insertion condition can contain any combination of the following: 
 Source columns 
 Operators or functions 
 Alphanumeric values 

 The insertion condition affects only the source tables which you have selected to be 
merged. 
1. On the Advanced Selection dialog box, select the check box under the Insert Only column 

for the selected table. 

 
 Use the horizontal scroll bar to display the pertinent section of the dialog box. 
 Selecting the check box under the Insert Only column causes the Merger Utility to insert 

any source rows (of the selected source table) which comply with the condition specified 
in the adjacent Condition column. 

2. Under the Condition column, type the appropriate insertion condition. 
 Make sure you type the appropriate condition, as this will affect the merge process 

results. 
The Merger Utility provides you with the following inherent operators and functions. 

Operator / Function Descriptions  Example  

= Equal to  cpmnt_mfr = 'Shell' 

> Greater than cmpnt_name > '101' 

< Less than item_price < 100 

>= Greater or equal to num >= 10  

=< Less than or equal to item_price =< 30 

<> Not equal to prefix <> 'AA' 

AND Include the following 
expression in the filter 
combination 

name AND num <> 0 

OR Accept either the 
previous or the 
following expression in 
the filter combination 

Loop OR line = '' 

NOT Select the value 
opposite to the 
following expression 

NOT (item_price = 0) 

LIKE Select a value that is 
similar to the one in the 
‘%[value]%’ field 

cmpnt_name LIKE '%AA%' 
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Operator / Function Descriptions  Example  

IN Select a value that is 
equal to one of those 
specified in the 
parentheses 

cpmnt_name = IN ('101','103' 

BETWEEN Select a value which is 
within the following 
interval 

item_price BETWEEN 100 AND 
500 

IS NULL Equal to NULL Loop IS NULL 

IS NOT NULL Not equal to NULL line IS NOT NULL 
 The above operators and functions are those used in the WHERE string of the SQL 

statement. 
You can also use special functions which are native to the source database. 
The following table describes some of the most common functions. The source databases which 
provide each function are specified beneath the function name (in italics) in the Function column. 
The function output is described in the Example column. 

Function  Descriptions  Example 

LTRIM (<value>) dBase 
Sybase Adaptive Server 
Anywhere 10.0 Oracle 
10g SQL Server  

Remove all leading 
spaces in the field 
indicated in the 
parentheses  

LTRIM(cmpnt_mfr) cmpnt_mfr = 
'Shell' LTRIM(cmpnt_mfr)='Shell' 

RTRIM(<value>) dBase 
Sybase Adaptive Server 
Anywhere 10.0 Oracle 
10g SQL Server 

Remove all trailing 
spaces in the field 
indicated in the 
parentheses 

RTRIM(cmpnt_num) IS NULL 
cmpnt_num = '108-FT 100' 
RTRIM(cmpnt_num)='108-FT 100' 

SUBSTRING(<value>,<
begin>,<count>) dBase 
Sybase Adaptive Server 
Anywhere 10.0 Oracle 
10g 

Retrieve a part of the 
field indicated in the 
[value] data field from 
the [begin] position for 
the number of 
characters 

SUBSTRING(cmpnt_mfr,1,4) 
cmpnt_mfr = 'Shell' 
SUBSTRING(cmpnt_mfr,1,4)='She
ll' 

SUBSTR(<value>,<beg
in>,<count>) SQL 
Server 

indicated in the [count] 
field 

SUBSTR (cmpnt_mfr,1,4) 
cmpnt_mfr = 'Shell' 
SUBSTR(cmpnt_mfr,1,4)='Shel' 

UCASE(<value>) 
DBase Sybase 
Adaptive Server 
Anywhere 10.0 

The upper case format 
of the contents of the 
field 

UCASE(cpmnt_name) 
cmpnt_name = '101-aa' 
UCASE(cmpnt_name)='101-AA' 

UPPER(<value>) 
Sybase Adaptive Server 
Anywhere 10.0 Oracle 
10g SQL Server 

indicated in the [value] 
data field 

UPPER(cpmnt_name) 
cmpnt_name = '101-aa' 
UPPER(cmpnt_name)='101-AA' 
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Function  Descriptions  Example 

LCASE(<value>) dBase 
Sybase Adaptive Server 
Anywhere 10.0 

The lower case format 
of the contents of the 
field 

LCASE(Loop_name) Loop_name = 
'101-AA' 
LCASE(Loop_name)='101-aa' 

LOWER(<value>) 
Oracle 10g SQL Server 

indicated in the [value] 
data field 

LOWER(Loop_name) Loop_name 
= '101-AA' 
LOWER(Loop_name)='101-aa' 

 When a table is defined on a specified level, it contains data which is unique on that 
specified level. For example, the CABLE Table is defined per area. Therefore, the CABLE Table 
contains data which is unique only on the area level of the domain.  
 

Filter And Sort the Displayed Source Table List 
You can filter and sort the displayed source tables. You do this by selecting the options in the 
appropriate parts of this dialog box. 

 Filtering and sorting the source data in this dialog box does not affect the results of the 
merge process. 
1. To sort the table list which is displayed in the Advanced Selection dialog box, do one of the 

following: 
 Click By name to list the source tables by table name  
 Click By merger order to list the source tables by the order in which they will be merged 

during the transfer process (the merging order).  
 You cannot change the merge order because it is automatically determined by the 

Merger Utility.  
2. To filter the data which is displayed in the Advanced Selection dialog box, specify the filter 

conditions by doing one of the following:  
 Select All to display tables at all levels in the domain.  
 Select Selected to display only tables that were selected for merging.  
 Select Per domain to display only tables that relate to the domain level.  
 Select Per plant to display only tables that relate to the plant level.  
 Select Per area check box to display only tables that relate to the area level.  
 Select the Per unit check box to display only tables that relate to the unit level. 

 

Merging Browser Views 
Selecting Browsers on the Select Items dialog box enables you to merge browser view style, 
filter, and sort settings. When merging a browser view set as the default view in the source, you 
must make sure that the default view name is unique within the current domain. If the view is not 
unique, you must rename the view in the Browser module before starting the merge process. 
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Selecting Source Data Using the Comparison List 
This option enables you to compare the source and target data before you select it to be merged. 
You can select item types to be compared either in batch mode (group mode) or one by one. If you 
use group mode, the Merger Utility allows you to save the comparison list in a number of file 
formats (psr, dbf, xls, and so forth). If you do not select group mode, the Merger Utility displays the 
comparison data in a special dialog box for each item type that you select in the Compare 
Source-Target Data window. 
After running the comparison list, you should examine the comparison results carefully and select 
the desired data transfer mode and transfer parameters. For example, you can determine whether 
you want to delete target data that does not exist in the source or whether you want to delete all 
the tags associated with a deleted loop, and so forth. You can also access specific comparison 
data, such as Specs, Process Data, Cross Wiring, Signals, and so forth, depending on the item 
type you selected to compare. Furthermore, you can customize the comparison list data display 
by filtering and/or sorting the data according to your needs. 
 

Selecting Source Data Using the Comparison List 
The following tasks are used when selecting source data using the comparison list. 
 

Define Comparison List Options 
This procedure shows you how before comparing data in a session, you set the comparison list 
options. 
You can determine whether to do any of the following: 
 Include or exclude wiring data when comparing tag data. 
 Include or exclude connections when comparing wiring data. 
 Include or exclude complementary data in the comparison. 

1. With the Merger Session Manager window open, click  to display the Compare 
Source-Target Data window.  

2. Click Actions > Options.  
a. On the Merger Compare Data Options dialog box, do the following to specify how the 

Merger Utility auto-selects and merges wiring information:  
 If you selected Tag in the Compare Source-Target Data window, click one of the 

following settings under Wiring selection by tag to merge wiring data:  
 No wiring — The software includes no wiring data with the selected tags during the 

transfer: the wiring information of the target tags remains intact.  
 Instrument wiring — The software includes all the device panel and device cable data 

relevant to the selected tag be included, that is, only the field device panels and 
cables are created for the selected tags. If you select this option, make sure that you 
also select Without connections under Selection by panel/cable.  

 All wiring — The software includes the entire signal data that is relevant to the selected 
tag.  

a. If you selected the Cable, Set, Wire (Plant) and/or Panel, Strip, Terminal (Plant) options in 
the Compare Source-Target Data window, select one of the following settings to merge 
wiring data:  
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 Without connections — The software includes no connection data with the selected 
item type during the transfer, that is, when selecting panels and/or cables, only their 
structure is selected. This is useful when merging or moving cables or panels from 
one domain to another. You can access the connection information by clicking 1 Side 
in the comparison list and select the relevant rows.  

 With connections — The software includes the relevant connection data during the 
transfer, that is, when selecting cables or panels, their connections are also selected. 
This option instructs the Merger Utility to select all the relevant panels, cables, tag 
numbers, loop numbers, and all the rest of the required data. You can refine the 
selection by canceling the selected connections.  

b. Under Complementary data, beside each item, select the Select check box to merge 
complementary data (specifications, process data, hook-ups, loop module data, 
calibration data, custom field data, and other items).  

 

Define a Comparison List Style 
This procedure shows you how when displaying comparison data for an item type, you can specify 
which properties of that item type you want to appear in the comparison list by defining a style. By 
means of a style you can determine which columns are available, the order of the columns, 
column widths, column header text, and the appearance of the column header: border, 
background color, and overall height. 
1. With the Merger Session Manager window open, click  to display the Compare 

Source-Target Data window. 
2. Select an item type from the Comparison Item Tree and do one of the following: 

 Click Actions > Create Style. 
 On the toolbar, click .  
 Right-click the item type, and on the shortcut menu, click Style. 

3. Specify the comparison list layout as follows:  
 Change the column sequence by dragging the column header to the required position. 
 Change the column widths by dragging the right border between the columns to the left or 

right as needed. 
 Adjust the overall column header height by dragging the lower border of the header up or 

down. 
4. To change the header text, double-click inside the header to open the Edit Column Name 

dialog box and edit the text as required. 
5. Do one of the following: 

 Click Actions > Style Properties. 

 On the toolbar, click . 
6. On the Comparison List Style Properties dialog box, from the Border list, click the border 

type that you require for the header. 
7. Select View beside each column that you want to appear in the style.  

 To display all the columns, select View all; to display none of the columns, clear View 
all. 

8. To choose a background color for the comparison list header, click Color to open the 
Windows Color dialog box, where you can specify the color that you require. 

9. When done, click OK to accept the values and close the Comparison List Style Properties 
dialog box. 

10. Click Actions > Save to save the style for the selected item type. 
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11. Click Actions > Close to return to the Compare Source- Target Data window. 
 

Compare Source and Target Data 
This procedure shows how you can compare data between the source and the target by opening 
a comparison list for a selected item type. You can then select which data items to merge. You can 
also specify the items that you want to display and print a report for the displayed items. 
1. With the Merger Session Manager window open, click  to display the Compare 

Source-Target Data window. 
2. Select an item type from the Comparison Item Tree and do one of the following: 

 Click Actions > Compare Data. 

 On the toolbar, click . 
 Right-click the item type, and on the shortcut menu, click Compare Data. 
 Double-click the item type. 

3. In the comparison list window for the selected item type, do one of the following: 
 To filter the data records to display, click . 

 To sort the data, click . 
 To specify which data columns to display, click . 

4. To create or modify a style for viewing a comparison list that is already open, do the following: 
a. Click  to return to the Compare Source-Target Data window.  

b. Select the item type and click  to open the Style window.  
c. Modify the style as desired. 

d. In the comparison list window for the selected item type, click  to update the 
comparison list using the style properties. 

e. Select the records for merging by doing one of the following: 
Select the Select check box beside each data record that you want to merge. 
 To select all the data records, click . 
 To clear the selection of all the data records, click . 
 To select updated data records only, click . 
 To select inserted data records only, click . 
 To select deleted data records only, click . 

f. Select the data to display by doing one of the following: 
 To display all the data items, click . 
 To display modified data items only, that is, where the source and target data differs, 

click . 
 To display selected data items only, click . 

g. If a comparison list is available for a child item type, click the desired option on the 
Reports menu. 

h. To generate a comparison list report, on the Actions menu, click Report. 
i. To save the selection you made for merging, on the Actions menu, click Save.  
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Compare Data Using Group Mode 
This procedure shows you how group mode enables you to make a batch selection of item types 
for comparison and subsequent transfer of data. You save the comparison data for subsequent 
inspection and analysis in an external file in a file format of your choice. After running the 
comparison list, you can open the saved external file to examine the data so that you can 
determine how to use the comparison list data. 

 If you selected wiring item types or wiring information to be merged, do not change the 
settings you made in the Merger Compare Data Options dialog box. If you change these settings 
after selecting wiring item types in the comparison list, the new settings apply only to new 
comparison list selections. In any case, it is difficult to predict what happens when you merge data 
in this case, as sometimes there can be a relation between different item types that you select.  
1. In the Merger Session Manager window, open the desired Merger Utility session. 
2. Do one of the following: 

 Click Actions > Comparison List. 
 Right-click the session, and on the shortcut menu, click Comparison List. 

3. Click Actions > Use Group Mode. 
4. Click Actions > Group Mode Parameters  
5. On the Group Mode Parameters dialog box, select Save comparison list as report only if 

you do not want to save the comparison results to the database. This saves the generated 
comparison reports as external files only. You have to make the appropriate selections under 
the Save data in section. 

6. To automate the selection process, select the type of data to be selected under Select data: 
 All — This option selects all the existing item types (for example, instrument, loop, panel, 

cable, and so forth) This option is recommended to get all the wiring and connection 
changes. 

 Deleted — This option selects the item types that appear in the target domain only. 
 Inserted — This option selects the item types that appear in the source domain only. 
 Updated — This option selects the item types that exist both in the source and target and 

need to be updated. 
 Saved previously — This option includes previously saved comparison data. 

 It is recommended that you select the Deleted, Inserted, and Updated options. 
7. Under Additional options, select the required types of comparison reports to be generated 

based on the selections you made under Select data: 
 1 Side — This report is for cables and panels. It reports the wire and terminal 

connections.  
 Cable levels — Generate two additional reports for cables: cable sets and wires of the 

cable (not mandatory if 1 Side is selected.)  
 Panel level — Generate two additional reports for panels: panel, strips, and sets and 

wires of the cable (not mandatory if 1 Side is selected.)  
 Jumper — This report identifies the jumpers by listing the two terminals that the jumpers 

are connected to.  
 Cross Wire — This report identifies the crossed wires by listing the two terminals/strips 

and panel names that the crossed wires are connected to.  
 2 Sides — This report lists the connections on both sides of a terminal strip. Note that this 

report and the relevant comparison list data cannot be used to select connections: it is for 
your information only.  
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 Signal — This report lists the connections for the selected tag numbers. Note that this 
report and the relevant comparison list data cannot be used to select connections – it is 
for your information only.  

 Specs — This report lists the differences in specifications. This is a generic report that 
displays the changed data only. You cannot select single attributes for an update.  

 Process Data — This report lists the differences in process data. This is a generic report 
that displays the changed data only. You cannot select single attributes for an update.  

 For all data — Generate comprehensive comparison reports for selected item types 
under Additional options (recommended).  

 For selected data — Generate comparison reports based on your selections under 
Select data for the item types selected under Additional options.  

8. Click  to specify the path and format of the file in which you will save the comparison data. 
Several file formats are available, for example, .psr, .dbf, .xls. After you make your selection, 
the Group Mode Parameters dialog box displays the information in the Save data in section.  

 Make sure that you select the .psr format so that you can use the report in the 
merge process.  

9. Click OK to accept your selections and to return to the Compare Source-Target Data 
window.  

10. Make your selections in the data window by clicking the desired item type. The icon beside the 
selected item type changes to . The software automatically selects all the child item types 
belonging to a selected item type. You can select or clear individual child item types if required 
as follows:  
a. Double-click an item type to expand it. (Certain child item types may contain other child 

item types.)  
b. Click the desired item type to select or clear it. The icon beside selected item types 

changes to . If a check mark appears beside an item type, it means that the item 
type has already been used in a previous run of the comparison list.  

 To ensure correct merging of specification data, make sure that you select all the 
tag numbers associated with multi-tag specifications, especially the master tag number. If you 
do not do so, the specification information will not be updated.  

11. Click Actions > Build Item List if you want make additional source selections in the module 
list after running the comparison list. Note that selecting this option will slow down the merge 
process. Do not select this option if you do not intend to use the module list feature.  

12. Do one of the following: 
 On the menu bar, click Actions > Compare Data.  

 On the toolbar, click .  
 The comparison procedure may take some time depending on the size of the database 

tables. At the end of the comparison procedure, you can view the comparison reports by opening 
the appropriate .psr files.  
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Check for Duplicate Items 
This procedure shows you how to check for duplicated items. Sometimes, when you create data, 
you can add spaces or other characters accidentally, so that what is intended to be the same 
record with updated data is in fact viewed by the database as a separate record. You can specify 
redundant characters that you want the software to ignore, and then you can run a check for 
duplicate items based on the item names without the redundant characters. 
1. With a Merger Comparison List dialog box open, on the Actions menu, click Duplicates to 

open the Duplicate Items dialog box. 
2. Click Characters to open the Redundant Characters dialog box. Do one of the following: 

 Click Add to add a new row and type in the required character or string. 
 Select an existing character and modify it as needed. 
 Select a row and click Delete to remove that row from the list of redundant characters. 
 Click Use Default to clear all user changes and restore the default set of redundant 

characters. 
 You can type strings of up to 20 characters. 

3. Click OK to return to the Duplicate Items dialog box. 
 The Identity Name column displays the modified item name without the redundant 

characters, and selects any duplicate rows using background shading: the software selects 
the first instance using light blue shading and duplicate items using gray shading. 

4. Under View, click one of the following options: 
 All items — All the items derived from the comparison list appear. 
 Selected items — Only the items you select for merging appear. 
 Duplicate items — Only the items highlighted as duplicates appear. 

5. Do one of the following: 
 In the Select column, select the items you want to include for data merging. 
 Select the Select all check box to include all of the items or clear the check box to include 

none of the items. 
 Selecting or clearing Select all affects the displayed items only. 

 

Restore a Saved PSR File 
This procedure shows you how restoring .psr files enables you to avoid regeneration of the 
comparison list. Restore your existing .psr files if you are certain that they reflect updated data. If 
you are not sure that the .psr files contain updated data, regenerate the comparison lists either 
one at a time (not recommended) or in group mode. 
1. In the Merger Session Manager window, open a session. 
2. Define a new log file. 
3. Define the required Merger Utility settings, depending on the item types you are about to 

merge. 
4. Do one of the following:  

 Click Actions > Comparison List.  
 Right-click the session, and on the shortcut menu, click Comparison List.  

5. In the Compare Source-Target Data window, highlight the item types that you want to 
include in the comparison. 

6. Click Actions > Restore Comparison Data. 
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7. On the Select PSR File dialog box, navigate to the .psr file that you want to restore. 
8. Click Actions > Merge to start generating the comparison lists. 
 

Run the Comparison List by Making an Individual Item Type Selection 
This procedure shows how you can select individual item types for comparison. You can expand 
an item type and run the comparison list for the selected item type only. If a child item type 
contains other child item types, they will also be included in the comparison list for that item type. 
Expand the desired child item type and make your selections. 

Prerequisite 
 With the Compare Source-Target Data window open, make sure that on the Actions menu, the 

Use Group Mode menu command is not selected (there should be no check mark beside the 
command). 

1. In the Compare Source-Target Data window, expand the items in the tree so that you can 
highlight the individual item type for which you want to run a comparison list. 

2. To start running the comparison list and, at the end of this process, open the Merger 
Comparison List dialog box, do one of the following: 
 Click Actions > Compare Data. 

 On the toolbar, click . 
 Right-click the item type, and on the shortcut menu, click Compare Data. 
 Double-click the selected item type. 

3. If available, select an option on the Reports menu to display the Connection, Process Data, 
and Specifications comparison data to facilitate the selection of rows to be merged. 

 Some of these options are disabled if they are not relevant for the item type you selected 
in the Compare Source-Target Data window. 

4. To customize the displayed data in the comparison list, on the Actions menu, point to 
Display Records and click one of the following options: 
 All Records — Displays all the available records. 
 Selected — Displays only those records selected for merging. 
 Modified — Displays modified records only, where the source and target data differs. 

5. Do one of the following: 
 Under the Select column, click the check box for each row you want to select to be 

merged. 
 Make a batch selection by right-clicking in the window, pointing to Select Records and 

clicking one of the commands: All, Updated, Inserted, or Deleted to specify the rows to 
include in the merge process. 

6. Click Actions > Save. 
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Filter the Comparison List Data 
This option enables you to filter the rows displayed in the comparison list. You can specify a 
filtering condition that will filter the comparison list data. 
1. With the comparison list open, on the Actions menu, click Filter to open the Merger 

Comparison List Filter dialog box.  
2. To include a field in the filter condition, double-click the required field in the Field list and it will 

appear in the editable data window at the top of the dialog box.  
3. Enter the required filter condition by either typing it in directly in the data window or by 

selecting the appropriate operators and functions.  
4. Click OK to accept the filter condition and return to the comparison list.  

 Filtering the comparison list rows will not affect the selection and row sorting you made 
prior to filtering the comparison list data. 
 

Display Specific Data Columns in the Comparison List 
This procedure shows you how to select the data columns that you want to be displayed in the 
comparison list. 
1. With the comparison list open, on the Actions menu, click View to open the Select Columns 

for Viewing dialog box. 
2. Under Column list, drag the required columns to be displayed to Columns to view. Only the 

columns that appear under Columns to view will be displayed in the comparison list. 
 If the comparison list currently does not display all the available rows, you can select the 

check boxes Select All to display all the columns in the comparison list, or Include modified 
columns to display only those columns that contain changed data. 

3. Click OK to accept your selections and return to the comparison list. 
 

Sort the Comparison List Data 
This procedure shows you how to sort the comparison list data. You can select any number of 
columns to use for sorting the data. 
1. With the comparison list open, on the Actions menu, click Sort to open the Select Columns 

for Sorting dialog box. 
2. Under Column list, drag the required columns to be used for sorting to Sorted columns. The 

data will be sorted according to the columns that appear under Sorted columns in the order 
that they appear. 

3. To remove a column to be used for sorting, drag it from Sorted columns to Column list.  
 To change the sort order, drag all the columns to Column list, and then drag them in the 

required order under Sorted columns.  
4. Click OK to accept your selections and return to the comparison list.  
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Display the Comparison List for a Child Item Type 
This procedure shows you how to display additional detailed comparison data pertaining to a child 
item type (if available). The following table indicates the item types that contain child item types. 

Main Item Type  Available Child Item Types for Comparison 

Line  Process Data 

Tag  Signal, Process Data, Specs 

Panel  1 Side, 2 Side, Cross Wire, Jumper 

Strip  1 Side, 2 Sides 

Terminal  1 Side, 2 Sides 

Cable 1 Side 

Cable Set 1 Side 

Wire  1 Side 
 The information in the comparison list for child item types is not editable. 

1. With the comparison list for the selected item type open, on the Reports menu, click the 
appropriate command to open the Merger Comparison List dialog box for the desired child 
item type.  

2. Under View, click All or Changed data only as required to filter the data to be displayed.  
3. Click Print to print out the data.  
4. Click Close to return to the comparison list.  

 When the 2 Sides option is selected for panels, strips, or terminals, if some of the connection 
data was changed, the merge mode will be U (update), and both the previous and current values 
will appear in the same field. Fields that contain no data signify that the selected panel has no 
wiring on that side.  
 

Start the Transfer Process 
This procedure shows you how to carry out the actual data transfer, after you have selected the 
source and target data and matched one to the other. 

 It is not possible to change the Merger Utility process parameters after you start the 
data transfer.  
1. With the Merger dialog box open, click Merge to start the transfer process. 
2. At the prompt, click Yes to start the data transfer. 

 If you encounter memory problems or you want to make the data transfer process faster, 
for details of how to speed up the transfer process or free memory resources during the 
transfer process, see Perform a Preliminary Configuration (on page 163). 

3. On the Merger Progress dialog box, click Stop if required at any point during the transfer 
process to stop the current data transfer process. 

 If you stop the transfer process, the Merger Utility skips all the rows of the currently 
processed table. You can resume the transfer process in the current merge session by 
clicking Continue or in another merge session after exiting the current merge session. When 
you resume the transfer process, the Merger Utility restarts the merge of the last table from 
which you left off.  
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4. On completion or stopping of the transfer process, click OK to close the notification message.  
5. In the Merger Progress window click Cancel to return to the Merger dialog box.  
6. View the log file to examine information about the merge results of the current merge process. 

For details of how to view the log file contents, see Working with Log Files (on page 137).  
 

Perform a Preliminary Configuration 
This feature provides you with the means to control the data flow during the merge process. You 
can also use this feature to select the application to view the log file. In most cases, you do not 
need to use this feature. However, you can use it if you encounter the following problems: 
 The merge process is slow.  
 Your computer has insufficient memory resources to perform the merge process.  
 The current application which is used to view the log file cannot handle the current log file (for 

example, due to the size of the log file).  
 This procedure enables you to:  
 Speed up the transfer process.  
 Free memory resources for the transfer process. 

 We recommend that you do not configure the Merger Utility unless it is absolutely 
necessary.  
1. Click File > Preferences.  
2. Click the Data Flow tab.  
3. Do one of the following to determine how fast the software merges data:  

 Leave the contents of the fields unchanged (the default values are: 1000 rows in the 
Source rows to retrieve data field, and 500 rows in the Target rows to commit data field).  

 Type a larger number of rows than the current default values. This way you speed up the 
merge process.  

 Type a smaller number of rows than the current default values. This way you free memory 
resources but it may slow down the merge process.  
 Make sure you do not exceed your memory capacity as this may cause the merge 

process to fail during the data transfer.  
4. To see the effect of the new settings, continue with the merge process. 
 

Running the Comparison List in Multi-Sessions 
So as not to run out of computer resources, it is highly recommended that you run the comparison 
list in group mode in more than one session. Make sure that on the Actions menu, the Build Item 
List menu command is not selected (no check mark beside the command) — this speeds up the 
process. There is may be no need to create a table list for merging if you do not intend to use it at 
that time. The following table summarizes the recommendations for the multi-session procedure. 

 Session A Session B Session C Session D Session E 

Mandatory No  Yes  Yes  Yes  No 

Implementatio
n per <unit> 

No  Yes  No  No  No 

Long time for 
generation 

No  Yes  Yes  Yes  Moderate 
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 Session A Session B Session C Session D Session E 

Items for 
selection  

Wiring 
Supporting 
Tables 
Default 
Cables 
Default 
Panels Loop 
Drawings 
Module 
Hook-Ups 
Module 

Instrument Index 
Supporting 
Tables Loop Tag 
Line Equipment 
P&ID CS Tags 

Panels (Plant) Cables (Plant)  Restore Panel 
(Plant) PSR and 
run for Strip & 
Terminals 
Comparison List, 
then save 

Group mode 
options 

Select data 
— All Cable 
Levels Panel 
Levels Save 
comparison 
list as report 
only Note: 
Cable and 
panel levels 
are not 
mandatory. 

Select data — 
All 
Specifications 
Process Data 
Signal Select the 
For all Data 
option Save the 
Comparison list 
as report only. 

Select data — 
All Cross Wiring 
2 Sides 
(optional) Select 
the For all Data 
option Save the 
Comparison list 
as report only. 

Select data — 
All 1 Side Select 
the For all Data 
option 

The Panel and 
Cable Levels can 
be generated 
separately from 
the PSR files of 
the Panel & Cable 
to save the 
computer 
resources during 
the Group mode 
comparison. 

  If run on <unit> 
basis, save in 
different folders 

Panel Levels 
(see session E) 

Cable Levels 
(see session E) 

 

 You can reduce the amount of data to be merged by selecting fewer item types, depending 
on the comparison information you require. 
 

Analyzing Comparison Reports 
After the comparison reports are saved as psr files (or any other type of file), you can print them 
out and start analyzing the data. If a field's value was changed, a U mode is assigned to this 
record and the changed column is highlighted with a light blue background. 
The following example is for instrument type comparison. 

 
In the second row, the highlighted changes were made in the target table. In the source table, 
these fields do not contain data. 
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In the third row, the target table does not contain an entry while the source table does. That is why 
there are two rows. Sometimes the field is too short to display the entire record, which causes the 
text to auto- scroll. Note that this can also make the field appear as two rows. You can then stretch 
the column to make it longer. 
To analyze the data, you need to print out the reports and mark changes you want to make on the 
printouts. In the case of the supporting tables, this is a simple task since these tables usually 
include two columns. All of the supporting tables are merged in one process since they are 
required for the main item types. Therefore, you do not need to worry about them so much. 
Concentrate on the main item types: 
 Loops and tags  
 Instrument Type (although this is a supporting table)  
 Cables  
 Panels  
 Analyze the changes in process data and specifications  
 Connections (1 Side)  
 Cross Wires  
 Jumpers  
 Control system tags:  

 Loop blocks  
 Hook-up drawings  

Mark the reports (use color markers if possible), mainly for wiring changes. 
 

Merging Supporting Tables 
When merging supporting tables, note the following: 
 Instrument Index module: When selecting tag numbers, the appropriate items from the 

relevant supporting tables are be selected. Specific supporting tables can be also merged 
using the comparison list options.  

 Wiring module: Use the comparison list feature to merge specific Wiring module supporting 
tables. However, if a cable or a panel was selected by you or by the Merger Utility, previous 
selections are ignored and the entire table is merged. To merge data successfully, you must 
include the entire set of reference data. This rule applies to both the Instrument Index and 
Wiring modules. Failure to select all the reference data may result in a chain reaction which 
causes large amounts of data not to be merged. The Merger Utility makes sure that this 
situation does not occur by selecting entire supporting tables to be merged. 

 

Guidelines for Selecting Item Types and Defining Merger 
Settings 

The following tables provide some specific guidelines to help you define the settings for merging 
various SmartPlant Instrumentation items. Remember to define these settings before merging the 
items. If you run merger several times to merge different tables, make sure you clear the previous 
selections. 
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Selected Option Settings  Merged Data  Comments  

Instrument Type  General: Update existing data 
Comparison Options: 
Insert/Update Include all 
reference tables 

All references as per 
instrument type profile: 
wiring supporting tables, 
defaults for cable, panel 
and connection types, 
I/O types, location, 
hook-ups and hook-up 
types, specification 
forms 

 

Equipment General: Update existing data Equipment type and 
equipment custom fields  

 

Line  General: Update existing data 
Comparison Options: 
Insert/Update Include all 
reference tables  

Line type process data 
insulation, lines, and line 
custom fields 

 

Loop General: Update existing data 
Identical source and tag  
Comparison Options: 
Insert/Update Include all 
reference tables 

Loop reference tables, 
loops, loop custom fields, 
specification forms 

New loops will 
automatically be 
added if new tags are 
added from the 
source. 

Tag Numbers – No 
Wiring 

General: Update existing data 
Identical source and tag  
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections, Selection by 
Tag No Wiring, Selection by 
Panel/Cable Without 
Connections 

Wiring supporting tables 
Associated instrument 
types 
Associated index and 
loop tables 
Loop drawing 
information 
Blocks/cells and types 
Process data, 
specifications and 
revisions Associated 
custom fields 
Associated hook-up data 
 

Merges all associated 
reference tables. No 
wiring will be merged 
or changed for 
selected tag numbers. 
Selecting With 
Connections will not 
affect/add any wiring 
data. 

Tag Numbers – 
Instrument Wiring 
(Field Devices 
only) 

General: Update existing data 
Identical source and tag 
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by Tag 
Instrument Wiring Selection 
by Panel/Cable Without 
Connections 

Wiring supporting tables 
Associated instrument 
types 
Associated index and 
loop tables 
Loop drawing 
information 
CAD drawing block types 
and blocks 
Process data 
specifications and 
revisions 
Associated custom fields 
Associated hook-up data 

Control System tags 
will not be merged 

 If the 
With Connections 
option is selected, 
additional panels, 
cables, and 
connections will not 
be added (junction 
boxes and marshaling 
racks) unless these 
are selected from 
Panel/Cable lists. 
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Selected Option Settings  Merged Data  Comments  
Field device cables, 
panels, and their 
connections on the 
instrument side 

Tag Numbers – All 
Wiring 

General: Update existing data 
Identical source and tag 
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by Tag 
Instrument Wiring Selection 
by Panel/Cable Without 
Connections 

Wiring supporting tables 
Associated instrument 
types 
Associated index and 
loop tables 
Loop drawing 
information 
Blocks/cells and types 
Process data 
specifications and 
revisions 
Associated custom fields 
Associated hook-up data 
Field device cables, 
panels, and their 
connections on the 
instrument side 
All associated panels 
and cables that the 
signals go through 

Will only connect the 
wires associated with 
the selected tag 
numbers. 

 If the With 
Connections option 
is selected, additional 
panels, cables, and 
connections will be 
added for all the 
selected panels. 

Cable or Panel 
(Plant or Default) 

General: Update existing data
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by 
Panel/Cable Without 
Connections 

Panel/cable structures 
without connections 
Panel/cable supporting 
tables 

Connections can be 
merged if selected 
from the Merger 
Comparison List - 
Wire Terminal dialog 
box. This will include 
additional information 
as required. If you 
select connections 
(by cables) with 
signals, field device 
cables will be 
selected to be merged 
but they will not be 
connected. The 
Selection by Tag 
setting has no effect 
in this case. 

Cable (with 
connections) 

 Working 
in this mode 
makes the Merger 
Utility select more 
panels, cables, 
and connections 

General: Update existing data
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by 
Panel/Cable With 
Connections 

Complete cable 
structures 
(cable/set/wires) and 
supporting tables 
All the panels / strips / 
terminals that are 
required to connect their 
wires 

You can cancel the 
selection of cable 
connections on the 
Merger Comparison 
List - Wire Terminal 
dialog box. Additional 
panels, cables, and all 
their connections will 
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Selected Option Settings  Merged Data  Comments  
than selected. This 
is due to signal 
relations. If you are 
not sure, choose 
the Without 
connections 
option. 

Instrument Index – tag 
numbers and their loop 
and supporting table 
records 
Specifications and 
process data 
Loop and Hook-Ups 
module associated data 
(for tag numbers) 
Wire connections 
All associated custom 
field data 

be added and 
processed if 
connections with 
signals are involved. 
The Selection by 
Tag setting has no 
effect in this case. 

Panel (with 
connections) 

 Working 
in this mode 
makes Merger 
select more 
panels, cables, 
and connections 
than selected. This 
is due to signal 
relations. If you are 
not sure, choose 
the Without 
connections 
option. 

General: Update existing data
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by 
Panel/Cable With 
Connections 

Complete panel 
structures 
(panel/strip/terminals) 
and supporting tables 
All the cables connected 
to the selected panel / 
strip, including the cable 
supporting tables 
Instrument Index – tag 
numbers and their loop 
and supporting table 
records 
Specifications and 
process data 
Loop and Hook-Ups 
module associated data 
(for tag numbers) 
Wire connections, 
including jumpers and 
cross wires connected to 
the selected panels / 
strips 
All associated custom 
field data 

You can cancel the 
selection of cable 
connections on the 
Merger Comparison 
List - Wire Terminal 
dialog box. You can 
cancel the selection of 
jumpers and cross 
wires in appropriate 
dialog boxes. 
Additional panels, 
cables, and all their 
connections will be 
added and processed 
if connections with 
signals are involved. 
The Selection by 
Tag setting has no 
effect in this case. 

Control System 
Tag 

 If With 
connections is 
selected, the entire 
wiring chain of all 
cables is selected 
(not 
recommended) 

General: Update existing data
Comparison Options: 
Insert/Update Include all 
reference tables Wiring 
Selections Selection by 
Panel/Cable Without 
Connections Selection by 
Tag No Wiring OR All Wiring 
(not recommended) 

Appropriate data will be 
selected to be merged 
depending on the setting 
you select in the 
Selection by Tag 
section: No Wiring and 
Instrument Wiring will 
select the data required 
for tag assignment. If a 
field device exists, it will 
be merged too. The All 
Wiring option will select 
the entire signal data. 
Instrument Index – tag 

You will not need this 
option in most cases. 
However, if you do, 
the software will 
merge basic 
engineering, wiring, 
and other associated 
data. 
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Selected Option Settings  Merged Data  Comments  
numbers and their loop 
and supporting table 
records 
Specifications and 
process data 
CAD drawing blocks 
All associated custom 
field data 
Associated hook-up data 

Blocks N/A CAD drawing block 
types, CAD drawing 
blocks 

 

Association 
Tag/Blocks 

N/A For information only. Not 
selectable to be merged. 

Tag and block 
associations are 
merged when 
merging tag numbers 

Item List Comparison Options: 
Insert/Update Include all 
reference tables 

Hook-up items 
Hook-up libraries 

Selecting the Include 
all reference tables 
option in the 
Comparison 
Options tab folder will 
merge the 
hook-types, 
hook-ups, and 
hook-up items 

Hook-Ups No special settings Hook-up types 
Hook-ups 
Item libraries and items 

 

Tag and Hook-Up 
Association 

N/A For information only. Not 
selectable to be merged. 

Tag and hook-up 
association is merged 
when merging tag 
numbers. 

 
 Do not change the wiring selection options before starting the actual merge process. The 

software processes the selected rows and carries out the merge process in accordance with 
the settings.  

 When selecting the With connections option in the Wiring Selections tab folder, records 
that appear only in the target are marked as deleted and are selected automatically by the 
Merger Utility. These selections, in most cases, will be wrong and you will have to clear the 
Select check box in the appropriate comparison list dialog box, for example, after clicking the 
1 Side button in the Merger Comparison List window.  

 Exercise caution when using the Delete option in Merge Options dialog box, Comparison 
Actions tab folder. This option instructs the Merger Utility to actually carry out delete 
operations. It is possible that the software will not delete items that are associated with other 
items. Double check the selected records after merging. Delete data directly in SmartPlant 
Instrumentation if results are not satisfactory. In most cases, you do not need to select the 
Delete option.  
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 When selecting item types to be merged, especially Wiring and Instrument Index data, it is 
important not to select different item types within the same merge session. This is due to the 
fact that the Merger Utility processes your selections differently when it comes to tag numbers, 
cables, panels, and connections based on the pre-selected settings.  

 The final selection of tables and item types to be merged is determined when you click Save to 
close the Merger Comparison List window. You can browse the selected records of different 
item types. Click Close to close the window without saving your changes.  

 

Merging Jumpers and Cross Wires 
Jumpers and cross wires are processed differently from ordinary cables since the Merger Utility 
has to connect both sides of the wires when adding them. To access the cross wires or jumpers, 
select a panel and in the Merger Comparison List window, on the Reports menu, click Cross 
Wire or Jumper. The dialog box displays the wires that are connected to the selected panels. 
Under Records to select, click the appropriate check boxes for the records that need to be 
inserted, depending on whether you selected With connections or Without connections. 
You can select or clear records as required. It is important to have all the jumpers and cross wires 
existing in the Wiring module for further processing. 

 When you select a panel using the With connections option, the Merger Utility 
automatically selects the jumpers and cross wires. 
 

Merging Specification Forms that Include Custom Title 
Blocks 

When you associate custom title blocks with specification forms, two methods of association are 
available: 

 A separate special title block definition for each spec form  
 A common standard title block definition used for all the forms in the domain  

When merging data in update mode, you must analyze your source and target databases to 
determine which option they are using for specification form custom title blocks. If the options are 
identical in both, or if the target uses the standard option, you can merge the data without any 
problems. 

 If the source database uses the standard title block assignment method, and the target 
uses the special title block assignment method, you are likely to lose data after merging. In this 
case, your System Administrator must change the Custom title block assignment method 
option in the source domain from Standard to Special.  
 

Customizing the Comparison List Display 
The Merger Utility enables you to customize the comparison list data display. You can filter and or 
sort the data according to your needs. You can select the columns you want to view, in which case 
the other columns will not be displayed. It is also possible to display only the data lines that you 
selected for the merge process (selected check boxes in the Select column). Another way of 
choosing the rows to display is to select the By mode option. In this case, you can display deleted, 
inserted, and or updated rows. 
 



 Merger Utility 
 

 

SmartPlant Instrumentation Import and Merger Utilities User's Guide 171 
 

Post Merging Actions 
After the merge process has been completed (in one or several sessions), it is recommended to 
test the results. In some cases, there might be a need to re-propagate signals to certain tag 
numbers in the Wiring module (some manual adjustments may be required in the database). This 
is required for tag numbers that were created in one database in the field, but in the other 
database they originated in a DCS or PLC. 
For a large quantity of data, it is recommended running the comparison lists again to verify that all 
new items were inserted and there are no missing connections or cross wires. 
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